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Safety Guidelines

This manual contains notices which you should observe to ensure your own personal safety, as
well as to protect the product and connected equipment. These notices are highlighted in the
manual by a warning triangle and are marked as follows according to the level of danger:

Danger

' Danger indicates an imminently hazardous situation which, if not avoided, will result in death or

serious injury.

Warning

' Warning indicates a potentially hazardous situation which, if not avoided, could result in death or

serious injury.

Caution

' Caution used with the safety alert symbol indicates a potentially hazardous situation which, if not

Caution

avoided, may result in minor or moderate injury.

Caution used without the safety alert symbol indicates a potentially hazardous situation which, if

not avoided, may result in property damage.

Notice

Notice indicates a potential situation which, if not avoided, may result in an undesirable result or

state.

Qualified Personnel

Only qualified personnel should be allowed to install and work on this equipment. Qualified per-
sons are defined as persons who are authorized to commission, to ground, and to tag circuits,
equipment, and systems in accordance with established safety practices and standards.

Correct Usage
Note the following:
Warning

This device and its components may only be used for the applications described in the catalog
or the technical descriptions, and only in connection with devices or components from other

manufacturers which have been approved or recommended by Siemens.

This product can only function correctly and safely if it is transported, stored, set up, and
installed correctly, and operated and maintained as recommended.

Trademarks

SIMATIC®, SIMATIC HMI® and SIMATIC NET® are registered trademarks of SIEMENS AG.

Some of other designations used in these documents are also registered trademarks; the owner’s rights may be
violated if they are used by third parties for their own purposes.

Copyright Siemens AG 2004 All rights reserved

The reproduction, transmission or use of this document or its contents is not
permitted without express written authority. Offenders will be liable for damages.
All rights, including rights created by patent grant or registration of a utility model
or design, are reserved.
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Bereich Automation and Drives
Geschaeftsgebiet Industrial Automation Systems
Postfach 4848, D- 90327 Nuernberg

Disclaimer of Liability

We have checked the contents of this manual for agreement with the hardware and
software described. Since deviations cannot be precluded entirely, we cannot gua-
rantee full agreement. However, the data in this manual are reviewed regularly and
any necessary corrections included in subsequent editions. Suggestions for impro-
vement are welcomed.
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Purpose of the manual

The SIMATIC Text Display (TD) User Manual is a combination user and reference manual that
describes the operation of the TD devices (TD 200 and TD 200C) with an S7-200 CPU.

Required Basic Knowledge

This manual is designed for engineers, programmers, and maintenance personnel who have a
general knowledge of programmable logic controllers and operator interfaces.

Scope of This Manual

This manual describes the installation, configuration and operation of both the TD 200 version 3.0
and the TD 200C version 1.0. This manual also describes the TD 200 wizard of

STEP 7-Micro/WIN (used to configure the S7-200 CPU for either TD device) and the Keypad
Designer application (used to configure the keypad of the TD 200C).

To utilize the new features of these TD devices, you must use STEP 7-Micro/WIN version 4.0 or
greater.

Agency Approvals
These SIMATIC TD devices meet the standards and regulations of the following agencies.
1 Underwriters Laboratories, Inc.(UL): UL 60950
g Canadian Standards Association: CSA C22.2 No. 60950 standard

Refer to Appendix A for additional compliance information.

Certification
These SIMATIC TD devices have the following certification:
1 Underwriters Laboratories (UL) Standards UL 60950 and CSA C22.2 No. 60950

1 Factory Mutual Research: Standard Class Number 3611, Class |, Division 2, Group A, B, C,
D, and Class |, Zone 2, Group IIC.

Temperature class T5 is adhered to when the ambient temperature during operation does
not exceed 60°C.

CE Labeling

These SIMATIC TD devices fulfill the requirements and protection guidelines of the following EU
directives:

1 EC Directive 73/23/EEC “Low-voltage directive”
1 EC Directive 89/336/EEC “EMC directive”

C-Tick

These TD devices are compliant with requirements of the AS/NZS 3548 (Australian) standard.
Recycling and Disposal

Please contact a company certified in the disposal of electronic scrap for environmentally safe
recycling and disposal of your device.
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How to Use This Manual

If this is your first experience using an operator interface, read the entire manual. If you are an
experienced user, refer to the Table of Contents or Index to find specific information.

Location of this Document in the Information Environment

Product
Family Documentation Order Number
S7-200 SIMATIC Text Display (TD) User Manual Not applicable
S7-200 Programmable Controller System Manual 6ES7 298-8FA24-8BHO

Finding Your Way

If you are a first-time (novice) user of TD devices, you should read the entire SIMATIC Text
Display (TD) User Manual. If you are an experienced user, refer to the table of contents or index to
find specific information.

The SIMATIC Text Display User Manual is organized according to the following topics:

a

a

Chapter 1 (Product Overview) provides an overview of the TD devices: TD 200 and
TD 200C.

Chapter 2 (Installing Your TD Device) provides provides installation instructions and
guidelines.

Chapter 3 (Using the Keypad Designer to Create a Custom Faceplate for the TD 200C)
provides information about the Keypad Designer and the steps required for configuring the
keypad and faceplate for the TD 200C.

Chapter 4 (Using the TD 200 Wizard to Configure the S7-200 CPU for the TD Device)
provides information about using the TD 200 wizard of STEP 7-Micro/WIN to configure the
S7-200 CPU for either the TD 200 or the TD 200C.

Chapter 5 (Operating Your TD Device) provides information about the basic operation of the
TD devices and also describes new features and capabilities, such as user screens.

Appendix A (Technical Specifications and Reference Information) provides the technical
information for the TD devices and also provides references for the character sets
supported.

Appendix B (Connecting Multiple Devices on a Network) provides information about using a
TD device in a network with other TD devices and S7-200 CPUs.

Appendix C (Troubleshooting) provides information to help you diagnose problems with the
TD device.
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Additional Support

Local Siemens Sales Office or Distributor

For assistance in answering any technical questions, for training on the S7-200 products, or for
ordering S7-200 products, contact your Siemens distributor or sales office. Because your sales
representatives are technically trained and have the most specific knowledge about your
operations, process and industry, as well as about the individual Siemens products that you are
using, they can provide the fastest and most efficient answers to any problems that you might
encounter.

Service & Support on the Internet
In addition to our documentation, we offer our Know-How online on the internet at:

http://www.siemens.com/automation/service&support

where you will find the following:

a

u
u

Access the S7-200 Internet site to find additional S7-200 product information:
www.siemens.com/S7-200

This site includes frequently asked questions (FAQs), Programming Tips (application
examples and sample programs), information about newly released products, and product
updates or downloads

Read the newsletter, which constantly provides you with up-to-date information on your
products

Use the Search feature of the Service & Support area to find specific documentation

Share information and exchange experiences with a forum of other users and experts from
all over the world

Find your local Siemens representative for Automation & Drives

Use the “Services” link to find information on field service, repairs, spare parts and more

Technical Services

The highly trained staff of the S7-200 Technical Services center is also available to help you solve
any problems that you might encounter. You can call on them 24 hours a day, 7 days a week.
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A&D Technical Support

Worldwide, available 24 hours a day:

Technical Support

Worldwide (Nuremberg)
Technical Support

24 hours a day, 365 days a year

Phone:  +49 (180) 5050-222
Fax: +49 (180) 5050-223
E-Mail:
adsupport@siemens.com
GMT: +1:00

Europe / Africa (Nuremberg)
Authorization

Local time: Mon.-Fri.
8:00 AM to 5:00 PM

Phone:  +49 (180) 5050-222
Fax: +49 (180) 5050-223
E-Mail:
adsupport@siemens.com
GMT: +1:00

United States (Johnson City)

Technical Support and
Authorization

Local time: Mon.-Fri.
8:00 AM to 5:00 PM

Phone:  +1 (423) 262 2522

+1 (800) 333-7421 (USA only)
Fax: +1 (423) 262 2289
E-Mail:

simatic.hotline@sea.siemens.com
GMT: -5:00

Asia / Australia (Beijing)

Technical Support and
Authorization

Local time: Mon.-Fri.
8:00 AM to 5:00 PM

Phone: +86 1064757575
Fax: +86 1064 74 74 74
E-Mail:
adsupport.asia@siemens.com
GMT: +8:00

The languages of the SIMATIC hotlines and the authorization hotline are generally German and English.

Vi
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Product Overview

The S7-200 TD devices (TD 200 and TD 200C) provide a low-cost human-machine interface
(HMI), allowing an operator or user to interact with your application.

The TD devices allow you to configure a set of hierarchical user menus that allow you to provide
additional structure for the interaction with your application. You can also configure the TD device
to display alarms or messages that are enabled by specific bits in the S7-200 CPU.

Tip

@ The new TD devices provide additional functionality, such as the hierarchical user-defined
menus, yet remain fully compatible with projects that were created with earlier versions of the
TD 200 (prior to TD 200 V3.0, which supported only the bit-enabled messages from the
S7-200 CPU).

You can use a new TD 200 or TD 200C with an existing TD configuration without having to
modify the control program in the S7-200 CPU.

In This Chapter

Introducing the S7-200 Text Display (TD) Devices . ..........c.c.ciiiiiiniiiinnennn.. 2
Features of the TD DeviCes . .... ...t e 3

Support for Multiple Language Sets ........... ... 3
Comparingthe TD 200 andthe TD 200C . ... ...ttt e e 4
Using the TD Device to Access Screensand Alarms ........... ... ... 5

Dividing Information into Screens and Bit-Enabled Alarms ....................... 5
Installation and Configuration Tasks ........... ... 7

Creating a Custom Faceplate for Your TD200C . ... ... .. i 9
Printing the Custom Faceplate forthe TD200C ....... ... .ot 10
Printer Requirements . . ... ... . 10
Ordering Additional Faceplate Overlay Material .............. .. ... ... ....... 10
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Introducing the S7-200 Text Display (TD) Devices

Your S7-200 TD device is a 2-line (with 20 characters per line) text display device that can be
connected to the S7-200 CPU. The TD device allows you to view, monitor, and change the
process variables pertaining to your application.

The S7-200 product family provides two TD
devices:

O TD 200C: The faceplate of the TD 200C TD 200C

offers complete flexibility of the keypad
layout and faceplate design.

You can create a custom keypad with up to
20 buttons (keys) of any size, with varying

shapes, colors, or fonts that can be layered TD 200
onto any background image.

(5] (77
gk ybekise M T
?unctions. The T)IID 200 aFI)so allows ,you to \\\\mmmm\\\\\\\ )

define up to eight custom functions (using
the SHIFT key).

Figure 1-1  Text Display (TD) Devices

The TD device receives power either from the S7-200 CPU through the TD/CPU cable (supplied
with each TD device) or from a separate power supply.

Both TD devices (TD 200 and TD 200C) contain the following elements:
[0 Textdisplay area: Backlit liquid crystal display (LCD) with a resolution of 33 x 181 pixels
1 Communication port: 9-pin D-connector

1 Power connector: Connector for using an optional external power supply (power for the TD
device is typically supplied by the S7-200 CPU through the TD/CPU cable)

STEP 7-Micro/WIN provides tools to help you configure the TD devices. Using the following tools,
you can easily program your S7-200 to display text messages and other data:

1 TD 200 wizard helps you configure messages for both TD devices.

1 Keypad Designer helps you to configure the custom keypad for the TD 200C. The Keypad
Designer includes samples and templates in the following directories:

- Sample bitmaps for buttons and backgrounds:
C:/Program Files/Siemens/TD Keypad Designer/Images

- Sample projects:
C:/Program Files/Siemens/TD Keypad Designer/Projects

- Sample template (for printing multiple copies of the faceplate):
C:/Program Files/Siemens/TD Keypad Designer/Templates

Each TD device functions as a network master when it is connected over a network that contains
one or more S7-200 CPUs. The TD device is also designed to operate with other masters in a
network. Multiple TD devices can be used with one or more S7-200 CPUs connected to the same
network. More than one TD device can connect to the same S7-200 CPU.
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Features of the TD Devices

You can use your TD device to perform the following tasks:

1 Designing a hierarchy of user menus and screens that allow an operator to interact with the
application or process

You create these user menus and screens with the TD 200 wizard of STEP 7-Micro/WIN
1 Displaying alarms (bit-enabled messages) that are generated by the S7-200 CPU
You define these alarms with the TD 200 wizard of STEP 7-Micro/WIN
1 Modifying designated program variables
The TD device allows you to define a variable as either a text string or a numeric string:
- Text string: All characters in a variable are editable

- Numeric string: Only the numeric characters are editable (the cursor skips over all
non-numeric characters)

1 Forcing or unforcing 1/O points: You can force individual I/O points in the S7-200 CPU to be
on or off

1 Setting the time and date (if the S7-200 CPU supports a real-time clock)
1 Viewing the CPU status (including version information)
The TD 200C provides additional functionality for interacting with the S7-200 CPU:
[ You can change the operating mode (RUN or STOP) of the S7-200 CPU
O You can load the user program in the S7-200 CPU to a memory cartridge
1 You can access and edit the data stored in the memory of the S7-200 CPU

Support for Multiple Language Sets

The TD devices provide a default TD character set which supports bar graph characters. In
addition to this character set, both TD devices also support the following Windows character sets
for displaying messages:

1 Arabic

Baltic

Chinese (Simplified Chinese)
Cyrillic

Greek

Hebrew

Latin 1 (with Boldface)

Latin 2 (with Boldface)

[ Turkish (Latin 5)

I R Iy I I A

Both TD devices provide menus and prompts in six languages: English, German, French,
Spanish, Italian, and Simplified Chinese.
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Comparing the TD 200 and the TD 200C

Table 1-1

Feature

Comparing the features of the TD Devices

TD 200 V3.0

TD 200C

Text display area

Keypad options

Configurable buttons

System buttons
(pre-configured)

User-defined menus and
user screens

Alarms
(from the S7-200 CPU)

Alarm indicator (icon)

Variables embedded in a
message

Icons (graphics)
embedded in a message

Pre-defined functions
(interacting with the
S7-200 CPU)

Password protection

Multiple languages for
alarms and screens

Character sets supported
(for displaying different
languages)

Languages for system
menus and error
messages

Feedback (when pressing
a button)

2 lines, up to 40 characters (up to 20
characters per line)

Standard keypad

4
(up to 8 when using SHIFT)

ENTER, ESC (Escape), SHIFT, UP
and DOWN arrows

Maximum of 64 screens

Up to 8 user menus, with up to 8
screens per user menu

Up to 80 alarm messages

Yes
Up to 6 variables per message

No

Force 1/0

Release the password

Set the time and date

CPU status

Switch languages (if configured)

Yes
Yes

10 character sets:

Latin 1/Bold, Latin 2/Bold, Chinese
(Simplified), Cyrillic, Arabic, Baltic,
Greek, Hebrew, Turkish, and Standard
TD (includes Bar Graph)

6 languages:
English, French, German, ltalian,
Spanish, and Chinese

Tactile dome over the buttons on the
keypad

2 lines, up to 40 characters (up to 20
characters per line)

User-designed custom keypad
Standard keypad

Custom keypad: Up to 20
(user-configurable)

Standard keypad: 4
(up to 8 when using SHIFT)

Configurable

ENTER, ESC (Escape), SHIFT, UP,
DOWN, LEFT, and RIGHT arrows

Maximum of 64 screens

Up to 8 user menus, with up to 8
screens per user menu

Up to 80 alarm messages

Yes
Up to 6 variables per message

Yes

Force 1/0

Release the password

Set the time and date

CPU Status

Switch languages (if configured)
Change the CPU operating mode
Edit the CPU memory

Program a memory cartridge

Yes
Yes

10 character sets:

Latin 1/Bold, Latin 2/Bold, Chinese
(Simplified), Cyrillic, Arabic, Baltic,
Greek, Hebrew, Turkish, and Standard
TD (includes Bar Graph)

6 languages:
English, French, German, Italian,
Spanish, and Chinese

Visual indicator in the text display area
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Using the TD Device to Access Screens and Alarms

When you configure the TD device with the TD 200 wizard of STEP 7-Micro/WIN, you create the
screens and alarms for the TD device. You use the buttons on the keypad of the TD device to
navigate through the screens and menus. The TD 200 uses the standard TD keypad. (See
Figure 1-2.) The TD 200C allows you to create your own custom-designed buttons with
specialized functions.

Standard Faceplate (TD 200) Standard Faceplate (TD 200C)

Text display area Arrow buttons Text display area Arrow buttons

|1
T
\
|

1
|
1 I

E]
]
E]
E
Sl i
]
E]
=

I
I
— L

N
—
2

Z

=
| B

N
HE
—]
2

L7777+7777J — Liiii#iiii Li‘,ij
/ / |
Configurable buttons ENTER Configurable buttons ENTER
(and SHIFT) and ESC (and SHIFT) and ESC

Figure 1-2 Standard Keypad Configuration for the TD Devices

Dividing Information into Screens and Bit-Enabled Alarms

As shown in Figure 1-3, you can configure the TD device to display screens (which are initiated by
operator action) and bit-enabled alarms (which are generated by the S7-200 CPU).

[ Screens: You can create screens that allow the operator (using the TD device) to initiate the
interaction with the S7-200 CPU. You can configure a user menu (up to 8 entries or groups)
that provides a hierarchy for the screens. You can create up to 8 screens for each menu
item or group.

1 Alarms: You can create alarm messages that allow the user program in the S7-200 CPU to
initiate interaction with the operator by displaying a message on the TD device.

During the configuration of the TD device, you also designate which type of message (screens or
alarms) will be the default display mode for the TD device. After power-up, the TD device goes to
the default display mode. Also, the TD device returns to the default display mode after a period of
inactivity (if no buttons have been pressed for one minute).

Storing the Screens and Alarms in the Parameter Block

The S7-200 CPU stores the ASCII text, embedded variables, and format information for the
alarms and screens in a parameter block located in V memory. You use the TD 200 wizard to
configure the starting address for the parameter block in V memory, and the TD 200 wizard
allocates the memory required to store the information for the TD device.

If you configure more than one parameter block for the S7-200 CPU (with each parameter block
having a different range of addresses in V memory), you can connect several TD devices to that
one S7-200 CPU. You configure the V memory address for the specific parameter block for each
of the TD devices. (The Diagnostic Menu of the TD device provides a TD Setup command for
specifying the starting address of the parameter block.)
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Displaying the Screens and Alarms on the TD Device

When the operator uses the buttons on the TD device to select a screen, the TD device reads the
alarms or screens in the parameter block (stored in V memory of the S7-200 CPU) and displays
the appropriate screen or alarm.

When you configure an alarm, you also configure an alarm bit for enabling a specific alarm. The
logic of your user program sets this alarm bit to display the alarm on the TD device. (When you
create the text for the alarm, you also designate the alarm bit. If you configured an alarm to require
acknowledgement by an operator, that alarm also has an acknowledge bit.) The TD device
continuously polls the alarm bits to determine which alarms have been enabled.

To display an alarm on the TD device, your user program in the S7-200 CPU must first set the
alarm bit for the specific alarm. When your user program sets one of the alarm bits, the TD device
then reads the alarm bits in the parameter block in the S7-200 CPU and displays the
corresponding alarm.

|

Change
Pressure

Maximum:
123.4 psi

Minimum:
123.4 psi

b

TD Device

Alarms are sorted by the sequential priority that
you created with the TD 200 wizard:

m  The first alarm that you configured is the
Pressure High highest priority
Check Speed

Callibrate Size

®  The last alarm that you configured is the
lowest priority

Refer to Chapters 4 and 5 for information about
alarms

Figure 1-3  Screens and Alarms
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Installation and Configuration Tasks

As shown in Figure 1-4, you use the TD 200 wizard of STEP 7-Micro/WIN to configure both the
TD 200 and the TD 200C. You can create a custom faceplate for the TD 200C. The Keypad
Designer creates a keypad configuration file for the TD 200 wizard.

Figure 1-5 provides an overview of the tasks for installing the TD device. Refer to Chapter 2.

PR e @

Ty

Keypad Designer

file (*.td2)

STEP 7-Micro/WIN
TD 200 Wizard

Create the screens and the alarms for your
operator interface

m  Configure the parameter block for the
TD device (V memory in the S7-200 CPU)

Parameter Block

When you download your user program to the
S7-200 CPU stores the parameter block in
the V memory address you selected

S§7-200 CPU

Save the keypad configuration

TD 200C

= | METAL MAKER AUTOMATE] =

Laser Printer
Print the faceplate for the TD 200C

Figure 1-4 Configuration Tasks for the TD Devices
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TD 200C
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Remove the
Housing

(Optional)
Modify the
Label Insert

Insert the 1 =
Spacers and
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TD 200 ! T

To S7-200 CPU

Connect to the

S7-200 CPU o| @ Czz)o

External Power
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Spacers and
Mount the
TD 200C

§
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To S7-200 CPU
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External Power
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To connect your TD device to a network, use the Diagnostic Menu of
the TD device to set up the network addresses, baud rate and other

parameters
Refer to Chapter 5

View Messages

Figure 1-5 Installing Your TD Device
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Creating a Custom Faceplate for Your TD 200C

With the TD 200C, you can design a custom faceplate that incorporates up to 20 buttons (keys) of
any size, with varying shapes, colors, or fonts that can be layered onto any background image.
You use the Keypad Designer to create the custom-designed layout for the keypad.

As shown in Figure 1-6, you use several applications to create a custom faceplate:

a

u
u
u

Keypad Designer: Creates the layout and the configuration for the keypad

Third-party graphics application: Designs the graphical appearance of the faceplate
STEP 7-Micro/WIN (TD 200 wizard): Configures the parameter block for the TD 200C
Word-processing application (optional): Prints multiple copies of the faceplate

Siemens provides a document file for Microsoft Word (TD200C_Faceplate.doc) that helps
you to align the panel images for the perforations on the A4 blank faceplate material. To
open this document, browse to the Templates subdirectory under the Keypad Designer
application. For example:

C:/Program Files/Siemens/TD Keypad Designer/Templates/TD200C_Faceplate.doc

Keypad Designer

®  Add an image for the keypad

m  Print the faceplate for the

m  Create the keypad configuration
file (*.td2)

Graphics
m  Create the layout of the buttons Application
= Configure the functionality for (Third-Party)

each button

panel

TD 200C Word-Processing

Application
(Optional)

STEP 7-Micro/WIN
TD 200 Wizard

Configure the
TD 200C

Print the faceplate onto the blank
label material

Figure 1-6  Using the Keypad Designer and Other Applications to Create a Custom Faceplate
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Printing the Custom Faceplate for the TD 200C

10

The TD 200C ships with one blank overlay (envelope-size) for printing the faceplate. The
faceplate overlay is constructed from durable, polyester material which has been designed
especially for use on HMI faceplates.

(O You can print a single faceplate directly from the Keypad Designer on the envelope-sized
blank faceplate overlay.

1 To print multiple faceplates, you can use the Microsoft Word template (provided online) that
ensures your faceplate design is properly sized. You can print up to 3 faceplates onto the
perforated A4-size blank overlay sheets.

Refer to Chapter 3 for specific information about printing the custom faceplate for the TD 200C.

Tip
The faceplate material is specially treated on one side to accommodate printing with a laser

printer. The treated surface is up (or toward you) when you are holding the material with the cut
corner in the top right of the sheet.

Ensure that the material is correctly inserted into the laser printer so that the faceplate prints the
reversed image onto the treated surface of the material. You must print a reversed-image
version of the faceplate onto the overlay material.

Before printing your custom faceplate onto the blank overlay sheet, first test your design by
printing the faceplate onto regular paper. You can then temporarily use the paper overlay to test
the functionality of the design with your TD 200C.

Printer Requirements

To print your custom-designed image onto the blank faceplate material, you must use a laser
printer that supports the following features:

(1 Paper size: The laser printer must be able to print on both the A4 (210 mm X 297 mm) and
envelope formats.

(1 Color: The laser printer must support color printing.

(1O Transparencies: The laser printer must support the printing of transparencies (or other
non-paper stock).

Ordering Additional Faceplate Overlay Material

You can order additional blank overlays in perforated A4-size sheets (10 sheets/package). The
overlay material is especially designed for printing on a laser printer. The blank overlay sheets
also allow you to utilize the services of professional printing vendors that specialize in laser
printing in order to create large quantities of high-quality faceplates.

Contact your local Siemens representative or distributor to purchase additional quantities of the
overlay material (order number: 6ES7 272-1AF00-7AAOQ).



Installing Your TD Device

You can install you TD device for easy access, whether on a panel, on a door of an enclosure, or
on a wall. Installed properly, the TD device meets the following standards for protection:

1 IP 65 (mounted on front of the panel)
1 [P 20 (mounted on casing)
O NEMA4
Refer to Appendix A for technical specification and for information about agency approvals and
other certifications.
Tip
You can use a new TD 200 or TD 200C with an existing TD 200 configuration without having to
modify the control program in the S7-200 CPU.

In This Chapter

Components Shipped withthe TD Devices . ...t 12
Mounting the TD Deviceina PaneloronaSurface .............. ... ... ... . o ... 12
Preparing the Mounting Surface .......... ... ... 12
Preparing the TD Device forMounting .......... ... . . i, 12
Positioning the Spacers forthe TD Device . ...........c.o .. 13
Mountingthe TD DeVviCe . ... ..o e 13
Customizing the Labels for the Keys of Your TD 200 .............cciiiiiiniininnn, 14
Modifying the Label Insert of the TD200 ......... ... 14
Creating a Custom Label Insertforthe TD200 ........... ... i, 14
Installing a Custom Faceplate forthe TD200C . ...t 15
Connectingthe TD/CPU Cable . ....... ... i e 16
Supplying Powerforthe TD DeviCe . .. ... ..ot 16
Establishing a Connection for Your TD200C . .. ...ttt 17
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Components Shipped with the TD Devices
Both TD devices (TD 200 and TD 200C) ship with the following components:

1 Gasket: Protective cushion with gasket for installing the TD device in inclement
environments

1 TD/CPU cable: 9-pin, straight-through cable that provides both communication and power
to the TD device

1 Spacers: Self-adhesive spacers for mounting the TD device in a panel

The TD 200 ships with a pull-out user label that allows you to label the function keys for your
application.

The TD 200C ships with a blank faceplate overlay that you can customize, and also includes a
printed overlay for the standard TD keypad. The faceplate overlay is constructed from durable,
polyester material which has been designed specifically for use for HMI faceplates.

Tip

@ To print your custom-designed image onto the blank faceplate material, you must use a laser
printer that supports the printing of transparencies on both A4 and envelope formats and also
supports color printing.

Mounting the TD Device in a Panel or on a Surface

Tip
@ If you are using a customized label insert for your TD 200, you must first install the new label
insert before you mount the TD 200.

Preparing the Mounting Surface

To prepare the surface where the TD device is to
be mounted or installed:
O Cuta 138 mm x 68 mm hole in the mounting 68 mm
surface (DIN 43700). See Figure 2-1. $

O Referto Table A-1 for the outside |<' 138 mm ’—|

dimensions of the TD device.

Figure 2-1  Dimensions for Cutting a Hole in the
Mounting Surface

Preparing the TD Device for Mounting

Refer to Figure 2-2 and use the following
procedure to separate the front cover from the
housing of the TD device:

Mounting Screws

1. Use a flat-head screwdriver or a T8 Torx
screwdriver to remove the three screws from
the rear of the TD device.

2. Remove the front cover of the TD device

from the housing. Figure 2-2  Removing the Mounting Screws

12
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Positioning the Spacers for the TD Device

The self-adhesive spacers (included with the TD device) maintain the pressure on the TD device
circuit board when the TD device is assembled. The number of spacers required is dependant
upon the thickness of the mounting surface.

Refer to Figure 2-3 and use the following Spacers
procedure to position the spacers: Gasket
1. Determine the number of spacers TN s
required, based on the thickness of / \ 1
the panel: \\ l Backplate
- Forupto 1.5 mm, use one \Z’/(\ 1 )
spacer. N = 1 )
- For1.5mmto4.0 mm,usetwo Gasket / T
spacers. Mounting Screws
2. Place the spacers over the screw Front Cover

e Cabinet Door or Control Panel
holes on the inside of the backplate.

Figure 2-3  Positioning Spacers on the TD Device

Mounting the TD Device

Refer to Figure 2-3 and use the following procedure to complete the mounting of your TD device:

1.

o M 0N

Remove the gasket from the protective cushion.

Place the supplied gasket on the frontplate of the TD device.
Install the spacers (if required).

Fit the frontplate into the cutout you made in the mounting surface.

Secure the backplate onto the frontplate of the TD device using the screws you removed
from the backplate. Carefully tighten the screws until snug.

Tip

@ To ensure compliance with IP 65 and NEMA 4:
®  The minimum panel thickness must be at least 1.5 mm.
®  The mounting screws on the TD device must be tightened to a torque of 0.7 N-m.
m  The gasket must be replaced whenever the TD device is removed and reinstalled.
To procure new gaskets, contact your Siemens distributor or sales representative.

This equipment is suitable for use in Class I, Division 2, Groups A, B, C, D; Class |, Zone 2,
Group IIC; or non-hazardous locations.

Warning
' E WARNING - EXPLOSION HAZARD!
L ]

DO NOT DISCONNECT WHILE CIRCUIT IS LIVE UNLESS LOCATION IS KNOWN TO BE
NON-HAZARDOUS

Warning
' E WARNING - EXPLOSION HAZARD!
L ]

Substitution of components may impair suitability for Class |, Division 2 or Zone 2.

13
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Customizing the Labels for the Keys of Your TD 200

The TD 200 allows you to define the functions for four of the nine keys (or buttons) on the
standard faceplate. You can remove the label insert of the TD 200 and designate the functions
assigned to those user-defined keys. You can also replace the standard TD 200 insert with your
own custom insert for the user-defined keys.

You must remove (at least partially) the TD housing in order to access the label insert from
underneath the front cover of the TD device.

Modifying the Label Insert of the TD 200

1. Remove the three screws on the back of the TD device and remove the front cover from the
housing.

2. Remove the label insert by pulling the
label insert tab out of the label slot with
a pair of pointed tweezers.

3. Turn the label insert over and create
your own label design. (The reverse
side of the label insert is blank.)

4. Insert the label by placing the corner of
the label into the label slot.

5. Reinstall the front cover into the back
housing.
6. Replace and tighten the three screws

on the back of the TD device to ensure
that the cover and housing are secure.

Tab of label insert

Use tweezers to grasp the tab of the label insert

Figure 2-4  Removing the Label Insert

Creating a Custom Label Insert for the TD 200

Figure 2-5 provides the dimensions for creating your own custom label insert.

11.9 mm 33.3 mm 55.8 mm 78.4 mm 100.9 mm
20 mm 42.3 mm 64.9 mm 87.4 mm
Y 29.3 mm
29.
r 9.3 mm - - - i — 28.7mm
€
g 16.8mm — . . o o _ 151 mm
i -r - 1 = T 142
— .2mm
& 1.9mm Window on the faceplate that allows
you to add text for your TD 200
—— | — — — — — — — 0.6 mm
0 mm \
0 mm
20 mm
78.4 mm
11.9 mm
0mm Material thickness 0.18 mm 101.6 mm

Figure 2-5 Dimensions for a Custom Label Insert

14
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Chapter 2

The TD 200C ships with a blank faceplate (envelope
size) for creating a custom-designed faceplate.

The TD 200C does not ship with a faceplate attached.
The front of the TD 200C is an adhesive surface
(shipped with a protective paper) that allows you to
attach your custom faceplate.

Refer to Chapter 3 for information about designing and
printing a custom faceplate.

The upper diagram of Figure 2-6 shows the dimensions
for the faceplate of the TD 200C. Blank faceplate
material is available in two sizes:

1 Envelope size for printing a single faceplate

1 A4 size (210 mm x 297 mm) for printing up to 3
copies of the faceplate

You must cut the faceplate from the envelope-sized
material, but the A4 material is perforated to allow you
to remove the faceplates without cutting.

Use the following procedure to install your custom
faceplate on the TD 200C:

1. As shown in Figure 2-6, remove the strip of
protective paper on the left side of the TD 200C
to expose a strip of the adhesive.

2. Carefully align your custom faceplate on the
entire TD 200C, and then seal the faceplate to
the exposed adhesive by pressing down on the
left side of the faceplate.

3. Carefully lift back the unadhered faceplate and
remove the rest of the protective paper from the
TD 200C.

4. Carefully position the faceplate onto the
TD 200C. Firmly press the faceplate onto the
adhesive as shown in Figure 2-6, taking care to
remove any air bubbles that may have been
trapped underneath.

The TD 200C comes configured as a standard TD 200
(with LEFT and RIGHT arrows, see Figure 1-2). After
creating and installing the custom faceplate on your

TD 200C, you must also download the TD configuration
that you created with both the Keypad Designer and
the TD 200 wizard.

1 Chapter 3 describes the Keypad Designer.
1 Chapter 4 describes the TD 200 wizard.

Installing a Custom Faceplate for the TD 200C

Dimensions for the Custom Faceplate

—f

65.7 mm

v

Custom Faceplate

4

Figure 2-6

Installing a Custom Faceplate

15
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Connecting the TD/CPU Cable

Caution
Operating the TD 200 with an ungrounded voltage source can damage the TD 200 device.

The TD 200 may only be connected to grounded voltage sources. Non-grounded operation can
cause the TD 200 device to become damaged.

Always ensure that the voltage source for the TD 200 is properly grounded.

Both TD devices (TD 200 and TD 200C) can use the TD/CPU cable for communicating with the
S7-200 CPU.

1 You can connect the TD device directly to the S7-200 CPU, creating a one-to-one network
configuration. In this configuration, one TD device connects to one S7-200 CPU through the
TD/CPU cable.

[ You can connect multiple TD devices to multiple S7-200 CPUs over a network. The
TD device defaults to address 1 and attempts to communicate to a CPU at address 2.

For more information about connecting to multiple CPUs, see Appendix B. For information
about changing the default addresses in the TD device, see Chapter 5.

If you require a longer cable (>2.5 m) to connect the TD device to the S7-200 CPU, use
PROFIBUS components for the network connection. Refer to the SINEC IK10 Catalog.

Supplying Power for the TD Device

16

¥

The S7-200 CPU uses the TD/CPU cable to provide power to the TD device. Use this type of
power supply when the distance between the TD device and the S7-200 CPU is less than 2.5 m
(the length of the TD/CPU cable).

Tip
If the distance between the TD device and the S7-200 CPU is greater than 2.5 m, use an

external 24 VDC power supply. The TD device ships with an power connector that allows you to
connect an optional external power supply to the TD device.

If you require a longer cable (greater than 2.5 m) to connect the TD device to the S7-200 CPU,
use PROFIBUS components for the network connection. Refer to the SINEC |IK10 Catalog.

Refer to Appendix B for information about using the TD device on a network.

As shown in Figure 2-7, the TD device provides two options for providing power:

1 The TD/CPU cable allows the S7-200
CPU to provide power to the TD device Connector for an external power supply

over the communications port.
Communications port

For information about the TD/CPU cable
and the communications port, refer to
Appendix B.

external power supply.

J You can connectthe TD device to an
ool ©

[v]o]
The TD device requires 120 mA at ===
24 VDC to operate. An optional power \
connector is provided with the TD device. oV

Figure 2-7  Connecting Power to the TD Device

+24 VDC
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Establishing a Connection for Your TD 200C

As described in Chapter 4, you use the TD 200 wizard of STEP 7-Micro/WIN to configure the
screens, alarms, languages, and custom keypad layout for the TD 200C. The S7-200 CPU stores
this information in a parameter block (V memory).

The TD 200C ships wjth a default configuration ‘F TTax;ji:pla;a?a; j‘ ‘F  Arrow buttons j‘
and is set to communicate at a rate of 9600 baud. R T J
In order to read the parameter block, The TD 200C \
must communicate with the S7-200 CPU. T

| | S - [&] |
You must configure your TD 200C to communicate \ \
at the same baud rate as your S7-200 CPU. ‘E EI‘
Until the TD 200C successfully connects to the — T 0 = |
$7-200 CPU and reads the parameter block, the \Izl Iz' IE' H \
TD 200C remains configured for the standard TD \ le=—= %
keypad. (See Figure 2-8.) \ |:|H ESC \

] Bl

To change the baud rate of your TD 200C, you use Z J
the ESC and ENTER buttons to navigate to the r— == ——ar————7
Diagnostic Menu and change the TD Setup | Configurable buttons | | ENTER |
parameters. (See Chapter 5.) Because the ‘L (and SHIFT) J‘ L and ESC J‘
TD 200C ships with no faceplate attached,itmay _—— — — — — — " — -
be difficult to consistently press ESC or ENTER. Figure 2-8  Standard TD Keypad (TD 200C)

The TD 200C ships with an overlay for the standard TD keypad. In addition, the Keypad Designer
provides a sample faceplate for the standard TD keypad in the following directory:

C:/Program Files/Siemens/TD Keypad Designer/Templates

For temporary use, you can print this faceplate onto paper and lay the paper on top of the
TD 200C (without removing the covering from the adhesive).

Refer to Chapter 3 for information about opening the Keypad Designer and about printing a
faceplate.

17
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Using the Keypad Designer to Create
a Custom Faceplate for Your TD 200C

With the TD 200C, you can design a custom keypad that incorporates up to 20 buttons (keys) of

any size, with varying shapes, colors, or fonts that can be layered onto any background image.

The Keypad Designer application allows you to create a custom-designed layout for the keypad of
the TD 200C and includes samples and templates in the following directories:

1 Sample bitmaps for buttons and backgrounds:

C:/Program Files/Siemens/TD Keypad Designer/Images

1 Sample projects:

C:/Program Files/Siemens/TD Keypad Designer/Projects

1 Sample template (for printing multiple copies of the faceplate):

C:/Program Files/Siemens/TD Keypad Designer/Templates

This chapter guides you through the tasks required for creating the layout for the keypad, creating
the configuration file for the keypad, and printing the faceplate for the TD 200C.

You use the configuration file when you are configuring the TD 200C with the TD 200 wizard of

STEP 7-Micro/WIN. Refer to Chapter 4 for information about the TD 200 wizard.

In This Chapter

Using the Keypad Designer with Other Applications .. ......... ... .. ... ...

Starting the Keypad Designer .................
Adding Buttonstothe Keypad .................
InsertingaButton ................ ... ...,
Modifying the Shape of a Button ...........
Defining the Properties of the Button .. ..........

Exporting the Keypad Layout to a Graphics Application .............................

Adding a Panel Image to the Faceplate .........

Importinga Panellmage ..................
Saving the Keypad to a TD Configuration File . ...
Reversing the Panellmage ...................
Printing the Faceplate ........................

Printing a Single Faceplate from the Keypad Designer ..........................

Printing the Faceplate from a Word-Processing Application ......................

Installing the Printed Faceplate onto the TD 200C

20
22
23
23
23
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26
27
27
28
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30
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Using the Keypad Designer with Other Applications

20

You use the Keypad Designer to create the custom-designed layout for the keypad that
incorporates up to 20 buttons (keys) of any size, with varying shapes, colors, or fonts that can be
layered onto any background image. As shown in Figure 3-1, you use several applications:

1 Keypad Designer: Creates the layout and the configuration for the keypad
Third-party graphics application: Designs the graphical appearance of the faceplate
STEP 7-Micro/WIN (TD 200 wizard): Configures the parameter block for the TD 200C

Word-processing application (optional): Prints multiple copies of the faceplate

O do

Siemens provides a document file for Microsoft Word (TD200C_Faceplate.doc) that helps
you to align the panel images for the perforations on the A4 blank faceplate material. To
open this document, browse to the Templates subdirectory under the Keypad Designer
application. For example:

C:/Program Files/Siemens/TD Keypad Designer/Templates/TD200C_Faceplate.doc

Keypad Designer

Graphics
m  Create the layout of the buttons Application
m Configure the functionality for (Third-Party)

each button

®  Add an image for the keypad
panel

m  Print the faceplate for the
TD 200C

Word-Processing
Application
(Optional)

m  Create the keypad configuration
file (*.td2)

STEP 7-Micro/WIN
TD 200 Wizard
Configure the

parameter block for
the TD 200C

Print the faceplate onto the
blank label material

Figure 3-1 Using the Keypad Designer to Create the Custom Faceplate for Your TD 200C
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As shown in Figure 3-2, you perform the following tasks when

designing a custom keypad:

O You use the Keypad Designer to define the layout and the functions for the buttons.

1 You export the button template to a third-party graphics

application. You then create the

panel image by designing the graphical representations for the buttons and the background

for the faceplate.

1 After you import the panel image into the Keypad Designer, you print the faceplate for the

TD 200C.

1O You use the Keypad Designer to create the configuration file (*.td2) for the the TD 200C.

Keypad Designer

E’ Create the layout for the keypad:
®  Add the buttons to the keypad grid

m  Adjust the size and location of the
buttons

Third-Party
Graphics Application

E’ Configure the functionality for the
buttons

Create the panel image for the
keypad:

m  Export the button template to a
third-party graphics application

®  |mport the completed panel image

to the Keypad Designer

E’ Print the completed faceplate:
= Single copies can be printed

[2f Design the graphics for the

faceplate:

m  Design the background for
the panel image

®  Design the button images
Add text for the buttons

Save the file as a bitmap
(*.bmp)

Word-Processing Application
(Optional)

from the Keypad Designer

m  Use a word-processing
application (Export the panel
image to a file)

m’ Save the keypad configuration
file (*.td2)

STEP 7-Micro/WI
TD 200 Wizard

[F select the keypad configuration file
(*.td2) when configuring the TD 200C
with TD 200 Wizard

[¥ Print the faceplate onto the

blank faceplate material:

m  Use the template for
Microsoft Word (optional)

= Set up the printer for the
correct paper size

Print the faceplate

Laser Printer

Figure 3-2  Tasks for Creating a Custom Faceplate
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Starting the Keypad Designer

You use the Keypad Designer application to create a custom-designed layout for the keypad of
the TD 200C.

When you install STEP 7-Micro/WIN, you also install the Keypad Designer application. However,
the Keypad Designer does not require STEP 7-Micro/WIN.

You can start the Keypad Designer either from within STEP 7-Micro/WIN or as a stand-alone
application:

1 To start as a stand-alone application: Select the Start > SIMATIC > TD Keypad Designer
menu command

1 To start from STEP 7-Micro/WIN: Click the Keypad Designer icon in the Tools window

The Keypad Designer application opens — EEESEEEEIIEmsmm _ e
with a blank keypad template, as shown in 2=#/ S—
Figure 3-3. :

To open an existing project, select the
File > Open menu command and browse
to the project.

Table 3-1 describes the files that are used
by the Keypad Designer.

¢ Cck for Help and Support

Figure 3-3  Keypad Template

You can change the language of the
Keypad Designer by selecting the Tools > | General _ ]

Options menu Command AS ShOWn |n Allowes you to configure general software oplions,
Figure 3-4, you select the language from
the Options dialog. Generzl

—Languag

&' Click for Help and Support Cancel
Figure 3-4  Options Dialog

Table 3-1 Files Used by the Keypad Designer

File Type / Command Extension Description

TD file *.td2 Create the Keypad project file that stores the configuration data
Open, Save, Save As for the custom-designed keypad. (used by the TD 200 wizard)
Button Template *.bmp Export the layout of the buttons on the keypad to a graphics
Export application by selecting a file.

Panel Image *.bmp Import the finished bitmap of the faceplate from the graphics
Import application by selecting a file.

Panel Image *.bmp Export the finished faceplate to a word-processing application
Export (Optional) for printing multiple copies of the faceplate.

22
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Adding Buttons to the Keypad

¥

The TD 200C allows you relative freedom when designing your keypad:

1 You can configure up to 20 buttons on the

keypad. Keypad Designer
1 You can vary the size and the location of
the buttons. (A" Create the layout for the keypad:
1 You can define the functionality for each m  Add the buttons to the keypad grid
button. m  Adjust the size and location of the
The Keypad Designer provides a grid that aligns buttons
the location of the buttons with the physical
keypad of the TD 200C. Figure 3-5  Adding the Button to the Keypad

Tip
Typically, your keypad design should always include buttons with the following functions: Enter,

Escape, Up Arrow, and Down Arrow. These functions allow you to access the pre-configured
menus and functions of the TD 200C.

Inserting a Button

To add a button to the keypad grid: DT e 7 S

Flo Edt Ven Tock beb

si=1- 2

Click the Draw Button icon.

2.  Move the cursor over the grid.

3. Move the cursor (and button) into
position on the keypad grid.

4. Hold down the left mouse button
and drag the cursor to adjust the
size and shape of the button.

5. Release the mouse button to insert ¢ ekt ssprt 2
the button onto the keypad. Figure 3-6  Adding a Button

After you have inserted the button onto the keypad grid, you can relocate the button by dragging it
to a new location on the grid. However, you cannot resize the button.

Modifying the Shape of a Button

The Keypad Designer provides two methods for modifying the shape of a button:

1 Changing the size or shape of a button by adding a second button on top of the first button.

1 Erasing a portion of the button

Extending the Shape of a Button

You cannot resize a button that has been inserted onto the keypad grid. You can, however, insert
a second button on top of the first button to create a new size for the button. To change only the
size of the button, the new button must completely cover the first button.

As shown in Figure 3-7, adding a second
button also allows you to create buttons of
non-rectangular shape (combining the
shapes of both buttons).

JLI

When you insert the second button,
ensure that the cursor is within the
boundaries of the first button.

Figure 3-7  Extending the Shape of a Button
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Erasing an Area of the Button

You can change the shape of the button ar
by clicking the Erase Button icon.

Invalid areas
-

As shown in Figure 3-8, the Keypad
Designer alerts you if the shape of the
button is invalid.

L

To delete the entire button, select the
button and press the Delete key.

. dL
ar ar

Figure 3-8  Erasing an Area of a Button

Defining the Properties of the Button

24
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After you create the button, you define the function that will be performed when an operator
presses the button.

You use the Properties dialog to configure the

functionality for the button: Keypad Designer

Select the button to be configured.
2. Select the Edit > Properties menu

m’ Configure the functionality for the

. . . buttons
command to display the Properties dialog.
You can also right-click the button and
select Properties from the context menu. Figure 3-9  Defining the Properties for the Button

3. Select the function for the button and click — EIENETRESTT

OK See Flgure 3'1 0 Set Button Properties

Use this dialog to select a name for this button,
and to specify the TD function this button should perform.

Table 3-2 describes the functions that you can
configure for the button. The default function isto ==

@

seta bit in the S7-200 CPU (Set PLC Bit). i S

. . . . Set Bi 51 bit in the: PLC. IF the Shift b
Some functions can also be used in combination ““QQDT%E??E?%LUE;;.?: hiifm?y'ée“"”"
with other buttons, such as SHIFT or the arrow e ke coole by s bt i e

. . . = fied in the TD 200 %izard.

buttons. The Properties dialog provides s P e
suggestions for appropriate buttons for combining  [Bernaron
the fUnCtIOnS Riight Arrow Many TD actions require the Lse of mulitple

Clear Yalue
Shov dlarm

funchon buttons. When configuiing the:
selected function, you may also consider

After you configure the functions for each button i sl kool i o e

Menu 1 Sereen 0

on the keypad, select the File > Save or the gl

Menu 3 Sereen 0

: ! : Menu 5 Screen 0
configuration file (*.td2). e
Menu 8 Sereen 0

File > Save As menu command to create the Henud Screen 0 r“
=l

& Click for Help and Support. Cancel

Figure 3-10 Button Properties Dialog

Tip

To help keep track of which buttons have been configured, consider renaming each button as

you configure it.
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Table 3-2 Button Properties
Category Function Description
Navigation or Enter Selects a menu item or confirms a value.
Selection . .
Escape Exits from a menu or cancels a selection.
Up Arrow Scrolls (upwards) through menu items or increments a value that
can be edited.
Down Arrow Scrolls (downwards) through menu items or decrements a value that
can be edited.
Left Arrow Moves the cursor to the left.
Right Arrow Moves the cursor to the right.
Entering data Set PLC Bit Sets a memory bit in the S7-200 CPU. You can also use this button
to set two different bits by defining the Shift button. You use the
TD 200 wizard to assign the specific bit address.
Shift Allows you to use one Set PLC Bit button to control two different bits
in the S7-200 CPU.
Clear Value Sets the value being entered to zero (0).
Edit V-Memory Edits a V. memory location in the S7-200 CPU. You must specify the
address for the V. memory at run time.
User Screens Menu Mode Displays a user-configured menu. You must configure a static menu
and Alarms with the TD 200 wizard.
(User menu or Show Alarm Displays the current alarm message.

Alarms menu)

See Chapters 4
and 5

Setting up the
TD 200C

(Operator menu)
See Chapter 5

Diagnostics
(Diagnostic Menu)
See Chapter 5

Password
See Chapter 5

Show Screens
Screen Menu 1
Screen Menu 2
Screen Menu 3
Screen Menu 4
Screen Menu 5
Screen Menu 6
Screen Menu 7
Screen Menu 8
CPU Status

Select Language
Set

Set PLC Time and
Date

Change PLC
Mode

Edit Memory
Force 1/0

Program Memory
Cartridge

TD 200C Setup
View Messages

Release
Password

Displays the user menu (menu of user screens).
Displays the first user screen in the first user menu.
Displays the first user screen in the second user menu.
Displays the first user screen in the third user menu.
Displays the first user screen in the fourth user menu.
Displays the first user screen in the fifth user menu.
Displays the first user screen in the sixth user menu.
Displays the first user screen in the seventh user menu.
Displays the first user screen in the eighth user menu.

Displays the View CPU Status screen.
Reads and displays the status of the S7-200

Displays the Set Language screen, allowing you to switch between
the languages that you configured for the TD 200C.

Displays the Set Time and Date screen, allowing you to enter the
time and date.

Displays the Change CPU Mode screen, allowing you to change the
operating mode of the S7-200.

Displays the Edit CPU Memory screen.
Displays the Force 1/O screen.

Displays the Make MC screen, allowing you to copy the user
program to the memory cartridge.

Displays the TD 200 Setup screen.
Displays the View Messages screen.

Allows you to immediately restore the password-protection for the
TD 200C.
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Exporting the Keypad Layout to a Graphics Application

Atfter you have configured the buttons on the keypad, you can create the graphical representation

for the faceplate. You use any third-party graphics application to add colors, lines and other
artwork to the panel design.

The Keypad Designer exports the layout of the buttons as a bitmap file (*.bmp) that you edit with
the graphics application.

As shown in Figure 3-12, the button template

provides a bitmap image of the layout of the Keypad Designer I
keypad that you can use with your graphical

application to position, size and align the

graphical elements of your faceplate design. (4" Export the button template (layout
These elements can include logotype, text, or for the keypad) to a third-party

other images. graphics application

The Keypad Designer allows you to export the

layout of the buttons into your graphics

application. Use the File > Export >Button Third-Party

Template to File menu command to create a
bitmap file (*.bmp) that you insert into the
graphics application.

Graphics Application

[2¥* Design the graphics for the
After you customize the layout (adding

back di | butt logotype) faceplate:

ackground image, colors, buttons or logotype), .

you save the file as a bitmap (*.omp). This bitmap " E:ﬁé?TH:ZZ:ackground forthe
becomes the panel image for the Keypad ) )
Designer. ®  Design the button images

m  Add text for the buttons

Figure 3-11 Creating the Panel Image

Tip
@ When designing the colors for your panel image, remember that any white area will be printed
as transparent (clear).

alcim

Keypad Layout
(in the Keypad Designer)

Button Template
(exported to a graphics application)

Fe o Il DT laf Iof 111
[nE (miinl L Imeinel o

P ek, chck el Togacs o the Pk Mer.

Figure 3-12  Exporting the Button Template to a Graphics Application
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Adding a Panel Image to the Faceplate

Using your own graphics application, you create

the following graphical elements for the faceplate Keypad Designer I
of the TD 200C:
1 Buttonimages m’ Import the completed panel image

1 Background image or color scheme to the Keypad Designer

O Text (for the buttons or the background)

1 Logotypes (and other images or text)

You are not required to use square buttons. Third-Party
However, you must ensure that your button Graphics Application
design covers the area of the button as defined in

the button template. [ Save the completed panel image

After you have used your graphics application to as a bitmap (*.bmp)
modify the panel image for the faceplate, save
the design as a bitmap file (*.bomp).

Figure 3-13 Creating the Panel Image

Importing a Panel Image

When you have completed the graphical design
of panel image for the faceplate, you import the
panel image back into the Keypad Designer.

After you open your keypad project (*.td2), use
the File > Import >Panel Image from File menu
command to select the bitmap file that you
created with your graphics application.

) Bick for Help and Suppart

Figure 3-14 Keypad with a Panel Image

Tip
@ When you design your faceplate, you can create the bitmap with any resolution. However, the
size of the background image for the TD 200C must exactly match the following dimensions:

m  Width: 137 mm (*/_ 0.15 mm) (5.42 inches)
m  Height: 65.7 mm (*/_ 0.15 mm) (2.58 inches)

If your faceplate design does not match these dimensions, the Keypad Designer alerts you
before importing the panel image. If you import a panel image with incorrect dimensions, the

Keypad Designer resizes your panel image, which could distort the appearance of your
faceplate design.
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Saving the Keypad to a TD Configuration File

¥

When you save the keypad, you create a TD configuration file (*.td2). This file contains the
information about the buttons on the keypad:

d Number of buttons

[ Location and sizes of the buttons SO R T I

Names of the buttons
- ¥ save the keypad configuration
1 Functions assigned to the buttons file (*.td2)

Use the File > Save or File > Save As menu
command to save the configuration of the

keypad.
STEP 7-Micro/W|
The TD 200 Wizard uses this information for TD 200 Wizard
configuring the TD 200C. See Chapter 4 for more
information. 4 select the keypad configuration file
(*.td2) when configuring the TD 200C
with TD 200 Wizard
Figure 3-15 Saving the TD Configuration File
Tip

The Keypad Designer allows you to save invalid or incomplete configurations. This allows you
to save interim versions of your work. However, always ensure that the final configuration of the
keypad is valid and complete before using the configuration file (*.td2) with the TD 200 wizard.

Reversing the Panel Image

28

The Reverse Panel Image option only affects the way that the faceplate prints. It does not change
the layout of the keypad.

1 Reversing the panel image (see
Figure 3-16) orients the side of the
faceplate with the ink from the printing
process towards the TD 200C. The
operator then touches only the plastic
membrane and not the ink when pressing a
button. Always reverse the panel image
when printing on the blank faceplate
material.

1 Notreversing the panel image (see
Figure 3-17) prints the faceplate so that the
elements can be read correctly. Use the
non-reversed image when you print a
paper copy of the faceplate for review.

To turn the Reverse Panel Image option on or off,
select the File > Export > Reverse Panel Image
menu command. A check mark notifies you that
this function is selected.

Figure 3-17 Non-Reversed Panel Image
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Printing the Faceplate

To print your custom-designed image onto the blank faceplate material, you must use a laser
printer that supports printing transparency material in both the A4 and envelope formats and also

supports color printing.

(O You can print a single faceplate directly from the Keypad Designer on the envelope-sized
blank faceplate overlay (shipped with the TD 200C).

1 To print multiple faceplates, you can use the Microsoft Word template that ensures your
faceplate design is properly sized. You can print up to 3 faceplates onto the perforated
Ad4-size blank overlay sheets.

Tip

The faceplate material is specially treated on one side to accommodate printing with a laser
printer. The treated surface is up (or toward you) when you are holding the material with the cut
corner in the top right of the sheet.

Ensure that the material is correctly inserted into the laser printer so that the faceplate prints the
reversed image onto the treated surface of the material. You must print a reversed-image
version of the faceplate onto the overlay material.

Before printing your custom faceplate onto the blank overlay sheet, first test your design by
printing the faceplate onto regular paper. You can then temporarily use the paper overlay to test
the functionality of the design with your TD 200C.

Using the blank overlay sheets also allows you to
create large quantities of high-quality faceplates Keypad Designer
by utilizing the professional printing services of

shops that specialize in laser printing. [ Printa single faceplate from the

You can order additional blank overlays in Keypad Designer
perforated A4-size sheets (10 sheets/package).

The overlay material is especially designed for ma Print multiple faceplates (from a
printing with laser printers. word-processor application):

m  Export the panel image

m  Paste or insert the panel image into
your word-processing application

The blank faceplate material is available in two
sizes:

1 Envelope size for printing a single
faceplate: The Keypad Designer prints
registration lines for trimming the faceplate
to the correct dimensions. (Use a metal Word-Processing Application
straight edge and a knife or razor blade to (Optional)
ensure accurate and straight cuts.) The
TD 200C ships with a single blank

faceplate. [2¥ Print the faceplate onto the blank

O Adsize (210 097 't inti faceplate material:

size mm X mm) for printing up '

to 3 copies of the faceplate: You can use " \Lljvziéh(i tﬁ;nnﬂf;te [ptlicieber
the Microsoft Word template to print the P
faceplate onto perforated areas of the
material. You do not have to cut the
faceplates from the material. Order these ®  Print the faceplate
A4 sheets from your Siemens distributor.

m  Set up the printer for the correct
paper size

Figure 3-18 Printing the Faceplate
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¥

Tip

Before attempting to print a custom faceplate, ensure that both the printer and the

word-processing application are set to the correct paper size:

m  Single-copy sheet: Set both the printer and word-processing application to print on
Envelope.

m  Multiple-copy A4 sheet: Set both the printer and the word-processing application to print on
Ad4-size paper.

Your computer and your laser printer may have other settings that cause the printer to scale the

faceplate to an incorrect size. Always first print a test copy on paper before printing your
faceplate onto the blank material.

Printing a Single Faceplate from the Keypad Designer

¥

You can print individual faceplates directly from the Cut Lines
Keypad Designer:

1. Ensure that the laser printer is set to print
envelopes.

2. Insert the envelope-size faceplate material into
the tray.

3. Select the File > Print menu command
4. Select the laser printer and click OK.
5. Using the cut lines and a paper cutter, cut the

faceplate from the material.
Figure 3-19 Printing a Single Faceplate

Tip

For best results use a razor-blade cutting knife with a metal straight edge to cut the faceplate
from the material. You can also use a high-quality paper cutter. Be especially careful when using
scissors or similar tools. Scissors are more likely to stretch or tear the material, causing irregular
edges for the faceplate.

Printing the Faceplate from a Word-Processing Application

¥

You use a word-processing application (such as Microsoft Word) to print multiple copies of the
faceplate onto A4-size blank faceplate material. After you export the panel image of the faceplate
into a document, you adjust the location of the panel images and print the document.

Tip

Siemens provides a document file for Microsoft Word (TD200C_Faceplate.doc) that helps you to
align the panel images for the perforations on the A4 material. To open this document, browse to
the Templates subdirectory under the Keypad Designer application. For example:

C:/Program Files/Siemens/TD Keypad Designer/Templates/TD200C_Faceplate.doc
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Before printing the faceplate onto the blank faceplate
material, you must ensure that the document and the
printer settings are both set to print on A4 paper. Also,
ensure that the laser printer itself is configured to print
A4 paper.

After you print the faceplate document, you use the
perforations to remove the faceplates from the sheet.

To export the panel image to your word-processing
application:

1.

Perforated Areas

'~~~ A4 Faceplate
. N Material
Open your word-processing application (for atena
example, Microsoft Word) and open the template
file: TD200C_Faceplate.doc Figure 3-20 Printing Multiple Faceplates

Open the Keypad Designer.

In the Keypad Designer, select the File > Export > Panel Image to File menu command to
create a bitmap file that you insert into the word-processing application.

Insert the panel image into the document (TD200C_Faceplate.doc) by using the
word-processing application to insert the bitmap file (*.omp) that you created with the
Keypad Designer.

Atfter inserting the panel image into the document, save the document (using the File >
Save As menu command of the word-processing application).

With the panel images saved in your document, you can print the document to your laser printer.

Tip
@ Before printing the panel image onto the blank faceplate material, first test your design by
printing the faceplate onto regular A4 paper.
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Installing the Printed Faceplate onto the TD 200C

Use the following procedure to install your faceplate on
the TD 200C:

1.

As shown in Figure 3-21, remove the strip of
protective paper on the left side of the TD 200C
to expose a strip of the adhesive.

Carefully align your custom faceplate on the
entire TD 200C, and then seal the faceplate to
the exposed adhesive by pressing down on the
left side of the faceplate.

Carefully lift back the unadhered faceplate and
remove the rest of the protective paper from the
TD 200C.

Carefully position the faceplate onto the

TD 200C. Firmly press the faceplate onto the
adhesive, taking care to remove any air bubbles
that may have been trapped underneath.

Refer to Chapter 2 for additional information about
installing the TD 200C, including the dimensions for the
faceplate.

32
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Figure 3-21 Adhering the Faceplate onto
the TD 200C



Using the TD 200 Wizard to Configure
the S7-200 CPU for the TD Device

You do not configure or program the TD device. The TD 200 wizard creates a parameter block

that stores the configuration, screens and alarms for the TD device. The S7-200 CPU stores the

parameter block in V memory. At power-up, the TD device reads the parameter block from the
S7-200 CPU.

You use the TD 200 wizard of STEP 7-Micro/WIN to perform the following tasks:

1 Configuring the parameters for the TD device
1 Creating the screens and alarms to be displayed on the TD device
1 Creating the language sets for the TD device

[ Assigning the V memory address for the parameter block

Tip
@ To connect your TD device to a network, you use the Diagnostic Menu of the TD device to set
up the network addresses, baud rate and other parameters. Refer to Chapter 5.

In This Chapter

Overview of the Configuration Tasks .. ... ... i e
Configuringthe TD DeVICe ... ...ttt e e e e e e e
Task OVeIVIEW ...
Starting the TD 200 Wizard for Your TDDevice . ...t ...
Selecting the Type of TD Device to Configure ........... ... ... . i,
Enabling the TD Device to Modify Data in the S7-200CPU ......................
Selecting a Password forthe TD Device ........ ...,
Selecting the Update Rate forthe TD Device .......... ... ... ...,
Selecting the Language and the CharacterSet . .......... ... ... ... ... ... ......
Loading a Custom Keypad (TD 200C ONly) .. ... e
Configuring the Buttonsonthe Keypad ........... ... .. ...
Configuring the Screens forthe TD Device ....... ... . i,
Creatingthe UserMenu . ..... ... .. i e
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Embedding a Variable into the TextofaScreen ........ ... ... ... ... ... ... ......
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Overview of the Configuration Tasks

The S7-200 CPU stores the configuration data for the TD device, including the screens and
alarms, into a parameter block (located in V. memory). The TD 200 wizard creates the parameter
block. When you download your project (user program and data block) to the S7-200 CPU, you
also download the parameter block as part of the data block.

You do not configure or program the TD device. At power-up, the TD device reads the parameter
block from the S7-200 CPU.

As shown in Figure 4-1, you use the TD 200 wizard of STEP 7-Micro/WIN to create the parameter
block for both TD devices (TD 200 and TD 200C). Figure 4-2 shows the sequence of the tasks
required for configuring the parameters of the TD device.

TD 200C

Keypad Designer

Save the keypad
configuration file (*.td2)

[T

STEP 7-Micro/WIN

TD 200 Wizard

m  Create the screens and the alarms for
your operator interface

m  Configure the parameter block for the
TD device (V memory in the

S7-200 CPU)

Parameter Block

When you download your user program, the
S7-200 CPU stores the parameter block in
the V memory address you selected

Figure 4-1 Using the TD 200 Wizard to Configure the TD Device
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Screens

[ select the type of TD device

[ Enable the CPU functions

4 select the update rate
[ select the language and character set

[ configure the buttons

Alarms

[ Create the user menu

Add the screens

message

[ Define the screen
Define the text
Add any variable data

Add any icons
(TD 200C only) ®  Add any variable data

alarm

¥ select the display options:
Define the menu items m  Define the length for the

m  Define how to announce the

m  Define the text

[ Define the alarm message

[F Translate the alarms

and the screens

[ Define the languages sets:

m  Select the language for the prompts and
menus

m  Select the character set

[ Define the address of the parameter block
(V memory)

Figure 4-2  Configuration Tasks of the TD 200 Wizard
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Configuring the TD Device

36

STEP 7-Micro/WIN provides a wizard that makes it easy to configure the parameter block and the
messages in the data memory area of the S7-200 CPU.

Task Overview

As shown in Figure 4-3, the TD 200 wizard performs the same basic tasks for configuring either
TD device (TD 200 or TD 200C). However, the specific selections reflect the differences between
the TD 200 and the TD 200C.

[F select the TD device

m’ Select functions to be enabled:
m  Password protection

m’ Select functions to be enabled:
m  Password protection

m  Set Time and date m  Set Time and date
m  Force I/O m  Force l/O
m Change CPU to STOP or RUN
mode

m’ Select the update rate for the

m  Copy the user program to a
TD 200C by i

memory cartridge
m  Edit the CPU memory

[F select the language and
character set for the prompts and
menus of the TD 200 [ select the update rate for the

TD 200C

m’ Configure the action for the
buttons on the keypad m’ Select the language and
character set for the prompts and
menus of the TD 200C

g Configure the buttons on the

keypad:

= |Load the configuration file
(*.td2) for the custom keypad

Configure the action for the
buttons on the keypad

Figure 4-3 Tasks Required for Configuring the Parameters of the TD Device
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Starting the TD 200 Wizard for Your TD Device

You use the TD 200 wizard to configure the parameters for both the TD 200 and the TD 200C.
You can also use the TD 200 wizard to modify an existing TD configuration.

To open the TD 200 wizard: 1D 200 Wizard x|
Introduction
Welcome to the TD 200 wizard —
1. Start STEP 7-Micro/WIN. =
2. Select the Tools > TD 200 :_, .
. (=] This wizard vl help you configure 2 TD 200 test display. The TD 200 can display user messages and
Wizard menu command. e | e L
The TD 200 wizard displays the
Introduction dialog, as shown in
Figure 4-4.
If the TD 200 wizard finds an existing
TD configuration, the Introduction
dlalog prOVIdeS a IISt Of eXIStIng TD .& Touze the wizard, the project must be compiled in Symbolic Addiessing mode, Click the nest
configurations and allows you to select En e
a TD configuration to modify.
Use the Next button to proceed © Ciick for Help and Support ] e
through the dialogs of the wizard.
Figure 4-4  TD 200 Wizard
Selecting the Type of TD Device to Configure

As shown in Figure 4-5, the TD 200 1D 200 Wizard x|
leard prompts you to SeIGCt the type Seﬁglgp':;drzla:r;trh:::;.el and version of your TD device: —
of TD device to be configured. =t

tO dISplay the dlalogS f0r Conflgurlng TD pou have. To determine the made| and version of your T, pou map powerup the unit. The initial

screen will display the model and wersion. The madel and version may alsa be ksted on the back of nour
ogr TD. If there is no version listed on the back of the unit, fhen select Yersion 2.1 and earfier’, below.
the parameters for your specific

TD device.

The TD 200 leard uses thls SeleCtlon B |1y arder ko shawe you the specific features supported by your TD!, please select the model and version of
Configure

Selact TD 200 Model and Version
1D 200Version 21 and ealier TD 200C Yersion 1
€ TD 200Version 30,

|
£ 1D 200C Veersion 1.0

The TD 200C supports defining & custom keypads. Custom TD keypads are created with the.
Keypad Designer, then imported for use in the wizard configuration,

@ Ciick for Help and Support @ [ neb | Camel

Figure 4-5  Selecting the TD Device
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Enabling the TD Device to Modify Data in the S7-200 CPU

The TD 200 and the TD 200C provide different capabilities for modifying data in the S7-200 CPU,
which are reflected by the CPU functions that you can enable with the TD 200 wizard. Refer to
Chapter 5 for information about these CPU functions.

TD 200

By selecting the functions, you
configure the TD 200 to display the
commands on the standard menus.

TD 200 Wizard

Configure

The TD 200 supports the following
functions:

1 Setting the Time-of-Day clock:
Allows you to set the time and
date for the S7-200 CPU

1 Forcing I/O: Allows you to force
1/0 points in the S7-200 CPU to
be on or off

Standard Menus and Updale Rate

Use this page to enable operator access o specdic TD merus, and o specily the update rate for
commuricalions with the PLE.

The TD provides password protection for certan menus. and ediing of PLE data.

¥ Ensble Password protection,

passwoed (0000-9595) {0000

The TD can be configured bo allow the operator to access different PLC functions. Each of these
menus may be separately ensbled. and sach vl require the password if password protection is
enabled

¥ Enable the Time of Day [TOD] menw

Iv Enable the Force menu

The updale rate detemines how often the TD palls the PLE for alams and PLC data changes. How
ofters should the TD pall the PLE for updates?

[t st a5 posele =l

@ Ciick for Help and Support

I Mexts I

<Frew Cangel

Figure 4-6

TD 200C

Enabling the CPU Functions for the TD 200

By selecting the functions, you configure the TD 200C to displays the commands on the standard

menus.

The TD 200C supports the following functions:

1 Setting the Time-of-Day clock: Allows you to set the time and date for the S7-200 CPU
1 Forcing I/O: Allows you to force 1/O points in the S7-200 CPU to be on or off

1 Creating a memory cartridge:

TD 200 Wizard x|
Loads the fOIIOWIng elements to Slﬁ;ﬁ;:s :.:;uu: ;:‘azlg::;:mn::ess to speciic TD merws, and o specily the update rate for —
a memory Cartrldge- commurications with the PLE. J'v
&8 The TD provides password protection for certan menus. and ediing of PLE data.
- User program =
¥ Ensble Password protection,
- Canfigure password (0000:4535) [0000
ata bloc
- gonzfl(%l ré‘;',f, n of the T Ao i o Sk o P RS SR
7- ena
¥ Enatle the Time of Day (TOD] menw
i i IV Enble the Foice menu
[} Changlng the Operatlng mode: IV Enable the Program kemory Catridge meni
¥ Enable the Change PLC Operating Mode menu.
Allows you to set the S7-200 I Ensble the Edit PLE Memory menu.
CPU to STOP or RUN
The updale rate detemines how often the TD palls the PLE for alams and PLC data changes. How
1 Editing the CPU memory: Allows b ot e
you to change the values of the [ Fast 2z posetle |
data stored in the $7-200 CPU
© Ciick for Help and Support Per [ Web | | camel |

Figure 4-7
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Selecting a Password for the TD Device

¥

Selecting a password for the TD device helps you to protect the security of your process or
application. By enabling a four-digit password (from 0000 to 9999), you can control access to the
S7-200 CPU by requiring that an operator enter the password before editing variables from the
TD device.

Tip
The TD password affects only the ability of an operator to use the TD device for certain
functions.

If your S7-200 CPU is configured to require a password, the operator must enter the CPU
password. The TD password is used in addition to the CPU password.

Selecting the Update Rate for the TD Device

You can select how often the TD device performs a read operation to update the information from
the S7-200 CPU. You can select from “As fast as possible” to “Every 15 seconds” (in one-second
increments).

Selecting the Language and the Character Set

¥

Tip
When you create multiple language sets, the TD 200 wizard copies the alarms and screens

from the primary language set to the other language set. You then edit the screens and alarms
to translate the text displayed for the new language set.

If you need to modify the screens or messages (such as to add a new variable or to add a new
alarm), you must edit the primary language. The TD 200 wizard copies these changes to the
other language sets.

The TD 200 wizard only allows you to change the text in the other language sets.

The TD 200 wizard allows you to select the language for the menus and prompts of the

TD device. This selection does not affect the language setting for the screens or alarms that you
enter. You select a character set that supports the language of the text that you enter for the
screens and alarms. (If the character set does not match the Windows character set, the TD 200
wizard may not display the characters correctly. The TD device displays these characters
correctly.)

[ Select the language for the 1D 200 Wizard -
preconflgured menus and Lnf':gz‘asul;;;;?‘ﬂ specify the language to use for standard menws and plompts, and the character set to use for —
prompts displayed by the any user-delmed messages =
TD device. _

“rou can configurs the TD to display menus and prompts in & specific national language.
The TD device supports
English, French, German,
Italian, Simplified Chinese, and
Spanish

which natianal language should prompls and standard menus use?

T -

The TD can be configured bo suppo different charactes sets for user messages. Press F1 for more
information on howe this might be wseiul

Wwhhich character set would you like to use for user-defined messages

[} Select the character set for P zmra’n;:g 200 application that requires bar araph

displaying your text.

Refer to Appendix A for
descriptions of the character
sets supported by the — T L e e e S
TD device. € Cick for Help and Support v [ Neb | | Cancal

Figure 4-8  Localizing the TD Device

These settings define a language set for the TD device. The TD 200 wizard also provides a series
of dialogs for copying the alarms and screens to create additional language sets. For each
language set, you select the language and the character set.
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Loading a Custom Keypad (TD 200C Only)

The TD 200C allows you to create a custom keypad. As described in Chapter 3,you can insert up
to 20 buttons onto the keypad. The Keypad Designer saves this configuration to a file (*.td2).

To load the keypad configuration file 1D 200 Wizard
(*.td2) into the TD 200 wizard: Configure Keypad Butions

Use this page to confiqure the Sel Bit buttens defined for the TD keypad —

1. Select the option for using a
custom keypad created with the
Keypad Designer. (Find this
check box in the Options area of

The keypad defines buttons for controlling 8 V-Memary bits, Using the SHIFT button, sach Set Bit buttan
may control bvo PLE bits.

Suggested symbolic names for the V-4 emory bits controlied by each button are isted below. You may
«configure each button to either set the bit or 2ot as a momentan contact.

the Configure Keypad Buttons o Pt I S
dialog. See Figure 4-9.) 2T S Bk

2. Browse to the keypad Tl o
configuration file (*.td2) that you — =
created with the Keypad E_ISHPTEd s 1t B

1 Opfiors
¥ Display feedback on the TD 200C display when a Set Bit buttan is pressed.
[ Use a custom keypad crested with the Keypad Designer.

Designer.

The TD 200 wizard loads the keypad

configuration file and updates the € Click for Help and Support e ] e
table of buttons and the button
symbols. Figure 4-9  Configuring the Functions for the Buttons

The TD 200 wizard lists only those buttons that you had defined with the Set Bit functionality when
you created the buttons with the Keypad Designer.

Configuring the Buttons on the Keypad

As shown in Figure 4-9, the Configure Keypad Buttons dialog allows you to select a symbol name
and an action for each of the configurable buttons on the TD device.

1 The standard TD keypad provides 4 configurable buttons and a SHIFT button that can be
configured for up to 8 bits in the S7-200 CPU.

1 The TD 200C can be configured for up to 20 configurable buttons.

Tip

@ The Configure Keypad Buttons dialog of the TD 200 wizard displays only those buttons that can
set bits in the S7-200 CPU. The TD 200 wizard does not list the buttons with other functionality,
such as ESC or SHIFT.

The symbols that you assign to the buttons on the keypad allow the logic of your user program in
the S7-200 CPU to interact with the TD device. (The TD 200 wizard suggests a symbol for these
buttons. You can accept the recommendation or enter a new symbol for the button.)

For each button, you configure the type of action:

1 Setbit: When you press the button on the TD device, the S7-200 CPU sets this bit on. The
bit stays on until the logic of your user program in the S7-200 CPU resets the bit.

1 Momentary contact: When you press the button on the TD device, the S7-200 CPU sets
this bit on for as long as you press the button on the TD device, then turns the bit off when
you stop pressing the button.
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Configuring the Screens for the TD Device

The TD device supports a set of user-defined screens and a user menu. Screens allow the
operator (using the TD device) to initiate the interaction with the S7-200 CPU.

1 User menu: Provides a hierarchy for switching between groups of screens. You configure
up to 8 entries on the user menu.

[ Screens: You create up to 8 screens for each entry (or group) on the user menu.

The TD device displays the screens and the items

on the user menu in the order that you configure Screens

them.

[ create the user menu

If you configure both alarms and screens, you also
m  Define the menu items

designate the default display mode for the
TD device. m  Add the screens (up to 8)

The operator uses the buttons on the keypad to .
navigate through the user menu or the screens that ~ [4” Define the screen
you configured. m  Define the text

Figure 4-11 shows the buttons that an operator " Addvariable data

could use to navigate from a user menu to the m  Add icons
screens associated with that item in the menu.
Figure 4-10 Configuring the Screens

The UP Arrow scrolls up through The UP Arrow scrolls up through
A the list and wraps to the last item A the list and wraps to the last

screen
User menu item 1 H tEr]':TsE?es;iplays You can configure up to 8 screens
User menu item 2 for each user menu item

> | Soreen 1: Upto 2 lnes,

User menu item 4 - — — — — ———— Can be interactive
User menu item 5 ESC ret ‘ Screen 2: Up to 2 lines,
User menu item 6 reums o pge Can be interactive

- the user menu
User menu item 7 Screen 3: Up to 2 lines,
User menu item 8 Can be interactive

Screen 4: Up to 2 lines,

You can configure up to 8 items . .
Can be interactive

for the user menu

v The DOWN Arrow scrolls down through v The DOWN Arrow scrolls down
the list and wraps to the first item ]Ehr?ugh the list and wraps to the
irst screen

Figure 4-11  Navigating through a Hierarchy of User-Defined Screens
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Atfter you have configured the TD device, you can configure the screens and the user menu. Click
the screen icon to start creating the user menu for the screens. See Figure 4-12.

For the user menu, you perform the following tasks:

(1 Create the groups (names) to be [EEIXZE

displayed on the user menu

1 Determine the sequence of the
groups listed on the user menu

For the screens, you perform the
following tasks:

1 Add the screens to each group
(on the user menu)

1 Create the text message (and
add variables) for each screen

1 Add icons to the text message
(TD 200C only)

1 Determine the sequence of the
screens for each group

Creating the User Menu

i
Complete
J—
=D 10 Configuration Completel
Configure
Click the "Alarms' button to learn how bittriggered slaims might be useful for this TD 200C
a configuration. Click the 'User Meru' button ko lean about displaving information screens under operatos

conrol.
User Menu I you are done for naw and wish to complete the wizatd eonfiguration, elick Mest.

Alarms

@ Click for Help and Support ®er [ et | Cones

Figure 4-12 Selecting the Screen Configuration Tasks

The process for creating the screens and user menu is not sequential: You can choose to enter
the screens for each individual group before creating the next group, or you can enter all of the
groups for the user menu before creating any of the screens.

To configure the user menu, you enter the names for each group of screens. See Figure 4-13. The
TD 200 wizard displays a green ENTER icon (and blue arrow) to show which group is selected.

To create the screens associated with
a group on the user menu:

1.  Move the cursor to the box that
designates the group on the
user menu.

2. Click the Add Screen button.

3. Create the message for the
screen.

4. Click the Add Screen button to
create the other screens in this
group.

Use the Move Choice Up and Move
Choice Down buttons to change the
sequence of the groups listed on the
user menu.
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TD 200 Wizard

Define a User Menu
Use this page to to defing the choices and screens for your uses menu

The TD 200C suppotts & user menu with 8 chaleas Each of these choiees may lead to B sereens. Enter
your menu choices in the spaces below. Chck the bubtons 1o the nght to define screens that vl be
displayed for each merw choice.

e [ e

User Meru Ju S bR |
fm s | e, ]
AddScieen
ey Choite Bawr
podd Sereen
Add Sereen
—
Bd Sereen

[ fddScieen

'@ Click for Help and Support P | Hew Cancel

Figure 4-13 Defining the User Menu
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Creating the Text for a Screen

Your screen message can contain the
following elements:

1 Text: Enter your text in the

green area that represents the
text display area of the
TD device

Icons (optional): Click the icons
in the toolbar to insert the icon
into the text message

Icons are available only for the
TD 200C.

Variable data (optional): Click
the Insert PLC Data button to
embed a variable into the text
message

You can designate the screen to be
the default display.

TD 200 Wizard

Screen for Menu Choice “one’

!_Isa this page to define the screen. & screen may include PLC data refesences and graphical
icons.

~Secreen 01 defined for this chaice]

K« »|D|@] 2 @![@ R Ins=rt PLC Data | H@l%ﬁ%ﬂ&li

wF2 F4

e

[ This screen should be the default display when there has been no operator interaction

0K Cancel

@ Click for Help and Support

Figure 4-14 Creating the Message for a Screen

Embedding a Variable into the Text of a Screen

You can embed a variable data field into the text of the screen. To open the Insert PLC Data
dialog, move the cursor to the location for the variable in your text and click the Insert PLC Data
button. As shown in Figure 4-15, you enter the following information:

1 V memory address and size:

- VW or VD: Memory address for variable data (the range of addresses is determined
by the model of your S7-200 CPU)

- VB: Memory address for a String (cannot exceed 20 characters)

Format: signed or unsigned

Resolution (number of digits to
the right of the decimal): Upto 7

The TD device rounds a real
number to the specified decimal
place. For example, if the real
number value is 123.456 and
you select 2 digits to the right of
the decimal, the TD 200
displays this value as: 123.46

Tip

¥

TD 200 Wizard

Insert PLC Data

Use thiz dialog to configure a PLC data address for display. The data may be |
a'-memory BYTE. WORD, or DWORD address.

[rata Address D ata Formeat Digits to the right of the decimal
[ Signed =l =

™ Useris allowed to edit this data
I The user must enter the pass
I This data should automatical b

‘& Click for Help and Support

Figure 4-15 Inserting PLC Data

Refer to the SIMATIC S7-200 Programmable Controller System Manual for information about

the String data type or for the memory addresses supported by the S7-200 CPU.
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You can also allow the operator to modify the data stored at this memory location in the
S7-200 CPU.

[ You can require the operator enter the TD password before editing the variable. (You must
have enabled password-protection for the TD device.)

1 You can configure the cursor to jump to the variable field.

1 You can define a symbolic name for the variable. You use the symbolic name to access this
data with your user program.

Clicking OK inserts the variable into the text of the screen. The TD 200 wizard inserts a block of
4 characters to show the presence of the variable. The value to be displayed for the variable is
right-justified at that location (anchored to the right-most character).

Data values are always right justified to the right-most character of an embedded variable. As a
data value grows in magnitude, it utilizes more spaces to the left of the anchor point and can
overwrite the text characters. Always provide sufficient space between the end of your text and
the anchor point to allow for the expected range of the data value.

Tip

@ The actual number of characters used to display a value varies with the size of the value. To
help calculate the number of characters required for displaying the value of the variable, see the
examples listed in Table 4-1.

The TD device displays all values as decimal numbers. Positive signed values are displayed
without a sign, and negative signed values are displayed with a leading minus sign. Unsigned
values are displayed without a sign. A leading zero is used for all fractional numbers (for example,
0.5). Real numbers are displayed with the number of decimal places you specify. The value is
rounded to the specified decimal place.

Table 4-1 Calculating the Number of Characters Required to Display a Value

Size Type Resolution Maximum Number of Example
(Digits) Characters
Byte (VB) String Not applicable Upto 20 Hello, world
Numeric Not applicable Upto 20 800.333.7421
String
Word Unsigned 0 5 12345
(VW) 1to 4 6 1.2345, 1234.5
5 7 0.12345
6 8 0.012345
7 9 0.0012345
Signed 0 6 -12345
1t04 7 -1.2345, -1234.5
5 8 -0.12345
6 9 -0.012345
7 10 -0.0012345
Double-Word | Unsigned 0 10 1234567890
(VD) 1t07 1 123456789.1, 123.4567891
Signed 0 11 -1234567890
1t07 12 -123456789.1, -123.4567891
Real 0 Upto 20 -1234567
1t07 Upto 20 12345.6, 0.0123456
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Configuring the Alarms

Alarms allow the user program in the S7-200 CPU to initiate interaction with the operator by
displaying an alarm message on the TD device. When your user program sets an alarm bit, the
S7-200 CPU writes the text for the alarm to the TD device.

Figure 4-16 lists the key tasks for creating alarms.
You configure the following information for each Alarms
alarm:

) lect the displ tions:
1 Number of alarms (up to 80) to be configured m’ Select the display options
for the TD device m  Define the size of the alarms
(either 20 or 40 characters)
m  Define how to announce the

[ Priority for the alarms is determined by the alarm
sequence in which you configure the alarms:

1 Text message for the individual alarms

- The first alarm has the highest priority m’ Define the alarm message

- The last alarm has the lowest priority o alitiiies

m  |nsert a variable (optional)

(1 Acknowledgement (if required) ®  Insert an icon (optional)
The TD device stores up to 80 alarms and displays
the alarm messages according to priority. Figure 4-16 Configuring the Alarms
As shown in Figure 4-17, the operator uses the buttons on the keypad to scroll through the list of
alarms.

Acknowledges the alarm
that you have selected

Alarm (highest priority)

Scrolls up through the list of alarm
Ll A messages and wraps to the last item
Alarm
v Scrolls down through the list of alarm
Alarm messages and wraps to the first item
Alarm —
Alarm

Alarm (lowest priority)

gsc| Retunstothe . .
main menu You can configure up to 80 alarms for your the TD device:

The order of the alarms in your configuration determines the priority:

m  The first alarm in your configuration has the highest priority
m  The second alarm in your configuration has the second-highest priority
m  The last alarm in your configuration has the lowest priority

Figure 4-17  Alarm Messages
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Determining the Type of Operator-Interaction for an Alarm

The TD 200 wizard allows you to determine the type interaction required by the operator for an
alarm:

1 Acknowledgement is not required, and editing of variables is not allowed:

The TD device displays the alarm. The alarm can contain variables that are updated at the
update rate of the TD device, but ENTER has no function because the alarm does not
contain any editable variable. Pressing ESC returns to the main menu. An up or down arrow
displayed with the alarm signals that higher or lower alarms have been enabled. The
operator can use the UP or DOWN arrows to scroll through the other alarms.

The TD device does not reset the alarm bit for this type of alarm. To remove this alarm from
the TD device, you must include logic in your user program to reset the alarm bit.

Acknowledgement is not required, but Editing of variables is required:

The TD device displays the alarm and waits for the operator to edit the value of the
embedded variable. If you configured the alarm for automatic editing, the TD device places
the cursor to the right-most character of the variable. Pressing ESC returns to the main
menu. An up or down arrow displayed with the alarm signals that higher or lower alarms
have been enabled. The operator can use the UP or DOWN arrows to scroll through the
other alarms.

Atfter modifing the value for the embedded variable, the operator presses ENTER. The

TD device then moves the cursor to the next editable variable. Pressing ENTER for the last
editable variable of an alarm writes the new values for the variables to the S7-200 CPU.
The TD device resets the alarm bit.

Acknowledgement is required, but editing of variables is not allowed:

If you configured the alarm to require acknowledgement, the TD device alerts the operator
in the manner that you selected. If the alarm contains a variable, the TD device updates this
value at the rate of the TD device. An up or down arrow displayed with the alarm signals
that higher or lower alarms have been enabled, but the operator must first acknowledge this
alarm before scrolling to another alarm.

When the operator acknowledges the alarm (by pressing ENTER), the TD device sets the
acknowledge bit for the alarm and resets the alarm bit.

Acknowledgement is required, and Editing of variables is also required:

If you configured the alarm to require acknowledgement, the TD device alerts the operator
in the manner that you selected. If the alarm contains a variable, the TD device updates this
value at the rate of the TD device. If you configured the alarm for automatic editing, the

TD device places the cursor to the right-most character of the variable. An up or down arrow
displayed with the alarm signals that higher or lower alarms have been enabled, but the
operator must first acknowledge this alarm before scrolling to another alarm.

Atfter modifing the value for the embedded variable, the operator presses ENTER. The

TD device then moves the cursor to the next editable variable. Pressing ENTER for the last
editable variable of an alarm writes the new values for the variables to the S7-200 CPU.
The TD device sets the acknowledge bit for the alarm and resets the alarm bit.
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Setting the Default Display Mode and Alarm Parameters

The TD device supports alarms that are displayed under program control. After you have
configured the TD device, you can configure the alarms. When you configure the alarms, you also

select either screens (default) or alarms as the default display mode for the TD device.

Click the Alarms icon to start creating FETEED
the user menu for the screens. AS Alad':a?rrslrar;; to specify the text length of slaims. and 1o select how they should be displayed
shown in Figure 4-18, you select the

following information:

1 Default display mode: Select
either alarms or screens as teh
default display mode

alarms at a time.

alarm 2t 3 time.

[ Size of the alarms: Select either
20 characters or 40 characters
(For Chinese characters, select
either one row or two rows of

Select default display mode.

= User scieens

The TD 200C supports bwo lengths for slams. Select which length of alam pou wish to use,

¢~ Uze 20:character alamms. When 20 character slams are corfigured, the TD can display two

¢ Use 40-character alams. When 40 character slaims are configured, the TD can display one

€ Alams
text)
1 Announcement of the alarm:
Select either to display a
blinking icon or to automatically ¢ gick for Help and Support v [ Hew | Comel

display the alarm

Figure 4-18 Configuring the Alarm Options

Tip

The TD device supports up to 80 alarms. The priority for the alarms is determined sequentially,

from the first alarm (highest priority) to the last (lowest priority).

Entering the Text for an Alarm

Clicking Next displays the Alarms dialog. (See Figure 4-19.) You can select a symbolic name for
the alarm. The user program uses the symbolic name to enable (and display) the alarm. Click the

New Alarm button to create the alarm message. Your alarm message can contain the following

elements:

[0 Text: Enter your text in the green area that represents the text display area of the

TD device
1 Icons (optional, TD 200C only):

TD 200 Wizard

Click the icons in the toolbar to Alarms
insert the icon into the text Use this page to define alams for your TD configuration. Define higher priorty alarms fist Each | ot
alarm may contain PLC data.
message
—alarm 0 (1 defined)
1 Variable data (optional): Click = e | stpcoas. | bl @B

the Insert PLC Data button to

embed a variable into the text SIEMENS

message

To ensure that important alarms are
acknowledged by an operator, you
can configure the alarm to require
acknowledgement.

You select the symbolic name for the
acknowledgement bit for the alarm.

The user program uses this symbolic s e b

name to report that the alarm has elarm0_D NS
been acknowledged . I~ Alarm should require operator acknowledasment

To acknowledge an alarm with the | =] G | Piedous Al | Hewdlam |

TD device, the operator selects the

alarm and presses ENTER. &' Click for Help and Support Ok

Cancel

Figure 4-19 Creating the Text for an Alarm
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Embedding a Variable into the Text of an Alarm

You can embed a variable data field into the text of the alarm. To embed a variable, move the
cursor to the location for the variable in your text and click the Insert PLC Data button. As shown
in Figure 4-20, you enter the following information:

1 V memory address and size:

- VW or VD: Memory address for variable data (the range of addresses is determined
by the model of your S7-200 CPU)

- VB: Memory address for a String (cannot exceed 20 characters)

1 Format: signed or unsigned D 200 Wizard il |
1 Resolution (number of digits to Insert PLC Data —
i i . Use thiz dialog to configure 2 PLC data address for display. The datamay be | 200 :'l‘

the nght of the deCImal)' Up to7 a'-memory BYTE. WORD, or DWORD address.

The D deVice rour!(?s a rea_l [rata Address D ata Format Digits to the right of the decimal

number to the spemf!ed decimal [ Signed = p =

place. For example, if the real

number value is 123.456 and [T User iz allowed to edit this data

yOU Se|eCt 2 dlgItS to the rlght Of ™ The user must enter the pass 000 data;

the decimal, the D 200 I This data should autamatically b
displays this value as: 123.46

&2 Click for Help and Support ok | Cancel

Figure 4-20 Inserting a Variable into the Text of an Alarm

Tip
Refer to the SIMATIC S7-200 Programmable Controller System Manual for information about
the String data type or for the memory addresses supported by the S7-200 CPU.

You can also allow the operator to modify the data stored at this memory location in the
S7-200 CPU.

[ You can require the operator enter the TD password before editing the variable. (You must
have enabled password-protection for the TD device.)

1 You can configure the cursor to jump to the variable field.

1 You can define a symbolic name for the variable. You use the symbolic name to access this
data with your user program.

Clicking OK inserts the variable into the text of the alarm. The TD 200 wizard inserts a block of
4 characters to show the presence of the variable. The value to be displayed for the variable is
right-justified at that location (anchored to the right-most character).

Data values are always right justified to the right-most character of an embedded variable. As a
data value grows in magnitude, it utilizes more spaces to the left of the anchor point and can
overwrite the text characters. Always provide sufficient space between the end of your text and
the anchor point to allow for the expected range of the data value.

Tip

The actual number of characters used to display a value varies with the size of the value. To
help calculate the number of characters required for displaying the value of the variable, see the
examples listed in Table 4-2.
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The TD device displays all values as decimal numbers. Positive signed values are displayed
without a sign, and negative signed values are displayed with a leading minus sign. Unsigned
values are displayed without a sign. A leading zero is used for all fractional numbers (for example,
0.5). Real numbers are displayed with the number of decimal places you specify. The value is
rounded to the specified decimal place.

Table 4-2 Calculating the Number of Characters Required to Display a Value

Size Type Resolution Maximum Number of Example
(Digits) Characters
Byte (VB) String Not applicable Up to 20 Hello, world
Numeric Not applicable Upto 20 800.333.7421
String
Word Unsigned 0 5 12345
(VW) 1to 4 6 1.2345, 1234.5
5 7 0.12345
6 8 0.012345
7 9 0.0012345
Signed 0 6 -12345
1t04 7 -1.2345, -1234.5
5 8 -0.12345
6 9 -0.012345
7 10 -0.0012345
Double-Word | Unsigned 0 10 1234567890
(VD) 1t07 11 123456789.1, 123.4567891
Signed 0 11 -1234567890
1t07 12 -123456789.1, -123.4567891
Real 0 Upto 20 -1234567
1to7 Upto 20 12345.6, 0.0123456
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50

The TD 200 wizard allows you to configure multiple language sets for your TD device, including
not only the menus and prompts, but also for the alarms and screens. (The TD 200 wizard copies
the alarms and screens that you have configured into the language set, but you must manually
enter the translated text for each screen or alarm.)

For each language set, you select the following information:

1 Language for the prompts and

menus Language Sets
Character set :
- ¥ Define the languages sets:
O  Identifier m  Select the language for the prompts and
You also select which of the language e
sets is the primary language for the m  Select the character set
TD device.
Figure 4-21 Configuring the Languages for the TD Device
Tip

When you create multiple language sets, the TD 200 wizard copies the alarms and screens

from the primary language set to the other language set. You then edit the screens and alarms
to translate the text displayed for the new language set.

If you need to modify the screens or messages (such as to add a new variable or to add a new
alarm), you must edit the primary language. The TD 200 wizard copies these changes to the
other language sets.

The TD 200 wizard only allows you to change the text in the other language sets.

Atfter you have configured the alarms and screens for one language set, you can add a new
language set:

1. Click the icon to start configuring EETET]

the Ianguage Sets for the Set:s‘:atl:;ga;gmes:::ta language st to edit, add, or delete a language sat far this conliguration. —
TD device. _

2. Add a new language by
selecting New Language Set.

3. Select an existing language set
to be the source for the new
language set.

4. (Optional) Select the option for
primary language to configure
the new language as the default
language set for the TD device.

5. Click the Next button to display
the Localize Display dialog.

The following language sets are defined for this configuration. You may select ta edit the wser
messages far an exsting language set, or to add a language set ta this configuration. Tao edit an
enisting language set, select it from the list below and chick Mext. To add a new language sef. select
"New from the ist.

New Language Set

[elete Languans Get

Thiz new language set wil be nitialized 35 a copy of an exigling set, You will then need to ianslate
any user messages to the new language. "Which languags set would you ke to copy?

English -

‘When & configuration has multiple langusge sets, one must be the primary langauge set. You can
add/delele user messages and PLC data references ary in the primary langusge set

Language Sets

I™ Make thislanguage sel the primary language sel

) Click for Help and Support ®er [ et | Conem

Figure 4-22 Adding a Language
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The Localize dialog configures the menus and character set for the TD device:
1. Select the language for the 1D 200 Wizard x|

prompts and menus of the
TD device.

2. Select the character set for the
text.

3. Enter the name to be displayed
on the TD device for this
language set.

After you click the Next button, the
TD 200 wizard copies all of the
screens and alarms from the selected

language set to the new language set.

Localize Display

Use this page to specify the language to use for standard menus and prompls, and the character set to use far
any user-defined messages.

Language Sets

“Y'ou can configure the TD to display menus and prompts in a specific national language.

which national language should prompls and standard menus use?

EFZ -

The TD can be configured bo suppor different character sets for user messages. Press F1 for more
information on hove this miht be wseiul

‘Wwhhich character set would you like ta use for user-defined messages

Latin 1 Bold) = Standard character set for English and Western

Ewopean languages. Displays Bold Characters,

Howe do wou wank this language sat to appear in that menu

Language Set 0

The TD 200C displays a menu of svailable language sefs to sllow the operator to change languages.
?

@) Click for Help and Support

l Mext: I

Frew Cangel

Figure 4-23 Localizing the Display

Notes for Using the Simplified Chinese Character Set

¥

Tip

The Simplified Chinese character set requires a Chinese version of Windows or a Chinese
emulator to properly display Chinese characters in the TD 200 wizard. You must start the
Chinese emulator before you start the STEP 7-Micro/WIN software.

You can display up to 20 single-byte characters per line of your message. Because Simplified
Chinese uses double-byte characters, you can display up to 10 double-byte characters per line for

a message in Chinese.

Some Latin 1 characters are available from the Simplified Chinese character set. Depending on
your keyboard and/ or emulator, some of these Latin 1 characters may be formatted as single-byte
characters instead of the double-byte characters like the Simplified Chinese characters. If you use
a mixture of single-byte and double-byte characters in a message, remember that the space next

to a single-byte character can only be filled by either another single-byte character or an empty

space.

The TD 200 wizard displays 10 double-byte character places for the text of a screen or alarm. You
can fit any of the following combinations into a character place:

I:I
1 2 single-byte characters

a

1 double-byte character

1 single-byte character and 1 single-byte blank

You cannot fit one single-byte character plus one double-byte character in a character place.
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Assigning the V Memory Address for the Parameter Block

The TD 200 wizard creates the parameter block that you download to the S7-200 CPU with your
user program. The parameter block includes the configuration data for the TD device and any

screens and alarms that you created.

The TD 200 wizard calculates the
amount of memory required for the
parameter block and suggests a
starting address in V. memory.

The default location for the parameter
block is VBO.

Parameter Block Address

[ Define the address of the parameter block
(V memory)

Figure 4-24 Assigning the Address of the Parameter Block

Finishing the Configuration for the TD Device

After you complete the configuration for your TD device, the TD 200 wizard displays a summary

dialog. (See Figure 4-25.)

If you enter a name for the TD
configuration, STEP 7-Micro/WIN
creates an entry in the project tree for
the TD configuration.

STEP 7-Micro/WIN also creates the
following subroutines:

(1 TD_CTRL_x (where x is the
TD configuration number)

This subroutine ensures that all
updates for the TD device (such
as alarms or changing the
language setting) occur
immediately.

Your user program should use
SMO.0 to call this subroutine
every scan.

TD 200 Wizard

Project Components
This page lists the components that the wizard wil generate for use in your program. —

The TD 200 wizard wil now generate the projsct components fior your selected configuration. and make
that code avaiable for use by your program. ‘You requested confiuration consists of the following
prosect components:

Subrouing TOALM_T ]
Subroutine “TD_CTRL_D"

Global Symbol Tabie "TD_SYH_0"

Data page "TD_DATA_D" for the TD cardiguretion ot (VBOVE183)

User Meru

'.' The subrautine "TD_CTRL_0" should be called on ever program scan. and anly be used once in your
jprogram. The subroutine “TD_ALM_0" should be called to enable & speciic alam.
Alams

This wizard configuration vall be referenced in the project iee by name. ''ou may ed the
default name to better identify this wizard configuiation,

ITD 200 Cardiguration 0

& Click for Help and Suppart ®er [ Feh | Cones

Figure 4-25 Summary Dialog
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1 TD_ALM_x (where x is the TD configuration number)

Your user program uses this subroutine to call the alarm by the symbolic name (configured
by the TD wizard). This subroutine requires the S7-200 Symbol Table.



Operating Your TD Device

This chapter describes the following information about the operation of the TD devices, such as
using the keypad to navigate to the screens and bit-enabled alarm messages.

Included in this chapter is information about routine operator tasks, such as entering and releasing
the password, editing variables embedded in a message or screen, and checking the status
information of the S7-200 CPU. This chapter also describes the less-routine diagnostic functions
provided by the TD device for troubleshooting problems in the S7-200 CPU, such as forcing 1/O or
changing the operating mode.

In This Chapter

Using the TD Device to Access Screensand Alarms .. ......... .. i ... 54
Displaying Information onthe TD Device ........... ..o, 55
Using the TD Device to Edit Variables in the S7-200CPU ........................ 56

Accessing the Menus and SCreens ... i 57

Entering and Releasing a Password .. ........... i 58
Entering the Password . ... ... . 58
Releasing the Password . ....... ... i e 58

Viewing the Screens andthe Alarms . ... .. ... . i 59
Displaying the Alarms .. ... .. 60
Editing a Variable That Is Embedded in an Alarmora Screen .................... 62

Performing Typical or Routine Operator Tasks (OperatorMenu) ...................... 63
Viewing the Status of an S7-200 CPU . . ... .. ... . i 63
Setting Time and Date inthe S7-200CPU .......... ... . i 64
Changingthe Language Set . ....... ... . i e 65

Performing Specialized Operator Tasks (DiagnosticMenu) .. ......................... 65
Settingupthe TD DeviCe . ... ... e 66
Viewing the TD Messages Stored inthe S7-200CPU ............. ... . ... ..... 67
Forcing the Inputs and Outputs inthe S7-200CPU .......... ... ... ...t 67
Changing the Operating Mode of the S7-200 CPU (TD 200COnly) . ............... 68
Copying the User Program to a Memory Cartridge (TD 200COnly) ................ 68
Editing the CPU Memory (TD 200C Only) . ... ..ot 69
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Using the TD Device to Access Screens and Alarms

Both the TD 200 and the TD 200C allow you to structure information as either screens or
bit-enabled alarm messages, and both TD devices support menu-driven hierarchies. You use the
buttons of the keypad of the TD device to navigate through the screens and menus:

1 TD 200: Uses the standard TD keypad.

[ TD 200C: Allows you to change the configuration and use your own custom-designed
keypad. (If there is no custom configuration, the TD 200C defaults to the standard
TD keypad configuration.)

Tip
@ For more information about configuring the functionality of the buttons on the keypad:

m  Chapter 4 provides information about configuring the buttons for both the TD 200 and
TD 200C. The TD configuration is downloaded to the S7-200 CPU with your user program.

m  Chapter 3 provides information about creating a custom keypad layout for the TD 200C and
assigning specific functionality for each button. (You then integrate the custom keypad with
the screens and alarm messages as described in Chapter 4.)

H imire 5.1 the ctandard TN kevnad ¢~ — — — — — - - |
As shown in Figure 5-1, the standard TD keypad ‘f Textdisplay area | |  Arrow buttons ‘

provides the following buttons: B J

1 ENTER and Escape (ESC) buttons:

- ENTER selects a menu item or
confirms a value.
- ESC exits from a menu or cancels a

\

\

\

\

- =

selection. IZI Izl Izl .\

| L]

(1 Configurable buttons: \ |:|‘rm \
A L]

- Function keys (F1 to F4) perform the Zﬁ 7J‘7 —
task that you configured with the r—— "= ———"a = ———
TD 200 wizard. \ Configurable buttons || ENTER |

. \ (and SHIFT) || andESC |

- SHIFT allows the function keys (F5t0 .~ ~ JL_

F8) to perform the task that you

configured with the TD 200 wizard. Figure 51 Standard Keypad (TD 200)

d Arrow buttons:

r-— - — — L =
Text displ A butt:
- UP arrow scrolls (upwards) through L fx '? alaiai J L _ rrolvjfni _ J
menu items or increments a value that
can be edited. m\ Y o

— Bl

- DOWN arrow scrolls (downwards) } IZI }
through menu items or decrements a ‘E IEI‘
value that can be edited. | |

- LEFT and RIGHT arrows move the ‘rlili Ijilj 7‘
cursor left or right within the message
\

\

| P

(TD 200C only). For a TD 200, use | Y |:|‘ ﬁ |

SHIFT+DOWN to move right and e+ 1 LB

SHIFT+UP to move left. (You can also Z J

use ESC or ENTER to move left or ‘r - go%g]’ableibu;o; - ﬂ‘ ‘F 7ENTER7 ﬂ‘
right within a variable or message.) | (and SHIFT) | andESC |
- I

To select a menu item, use the UP and DOWN

arrows to scroll through the list of available items.

The TD device highlights the menu item. Figure 52 Standard TD Keypad (TD 200C)

1 Pressing ENTER selects the highlighted item.

1 Pressing ESC returns to the previous menu or screen.
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Displaying Information on the TD Device

The TD device provides both screens (user-defined menus with associated screens of
information) and bit-enabled alarm messages:

1 Menu: Amenu is a list of items that select a grouping of related screens.

1 Screen or alarm: A screen or an alarm displays up to two lines of text that provide
information for the operator. (Each line can contain up to 20 characters of text and data. A
screen contains up to 40 characters of text and data. An alarm can contain either 20 or 40
characters.)

The textual message of the screen or alarm can convey information for the operator and
can also allow the operator to interact with the S7-200 CPU by changing the embedded
value of a variable (such as a set point or limit).

You can configure the TD device to display screens (which are initiated by operator action) and
bit-enabled alarms (which are generated by the S7-200 CPU). You can also configure the

TD device to display an icon to alert the operator of some event or action required. (Refer to
Chapter 4 for information about configuring the TD device.)

Tip
@ Pressing ESC returns you to the previous menu. If there is no activity for one minute (no button
pressed), the TD device returns to the default display mode.

The operator uses the buttons on the keypad to navigate through the menu or a list of text.
Figure 5-3 shows the buttons that an operator could use to navigate from a user menu to the
screens associated with that item in the menu. Figure 5-4 shows how to navigate through the

alarms.
The UP Arrow: scrolls up
A through the list and wraps
to the last item The UP Arrow: scrolls up
A through the list and wraps to
User menu item 1 ENTER displays the last screen
User menu item 2 the screens | |
Screen
User menu item 4 Can be interactive
@ —— —— —— —— ——— —
User menu item 5 ESCretumnsto  ggo Screen 2
User menu item 6 the user menu Can be interactive
User menu item 7 Screen 3:
User menu item 8 Can be interactive
Screen 4:
The DOWN Arrow scrolls down O (59 (MRS
v through the list and wraps to
the first item The DOWN Arrow scrolls
v down through the list and
wraps to the first screen

Figure 5-3 Using the Keypad to Navigate between User Menus and Screens
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S§7-200 CPU

ENTER acknowledges the alarm and
resets the alarm bit in the S7-200 CPU

When an alarm bit turns on, the
S7-200 CPU writes the associated
alarm message to the TD device
The UP Arrow: scrolls up through
AI the list of alarms and wraps to the last

alarm

Alarm (highest priority) ‘
| | Alarm

The TD device lists the alarms '_ H_

according to priority Alarm

Alarm (lowest priority)

The DOWN Arrow scrolls down through
vl the list of alarms and wraps to the first

alarm

Figure 5-4 Displaying and Acknowledging Alarms

Using the TD Device to Edit Variables in the S7-200 CPU

A screen or alarm message can contain an embedded variable field that allows an operator to
respond by changing the value of the variable. The operator uses the keypad to edit variables:

1 Selecting the Screen: The operator uses the UP or DOWN arrows to display the screen that
contains the variable to be edited. (From a menu, the operator presses ENTER to access
the group of screens.)

1 Navigating to the variable: The operator presses ENTER to navigate to the first editable
variable.

1 Changing the value of the variable: Pressing the UP arrow increments (increases) the
value, and pressing the DOWN arrow decrements (decreases) the value. (Pressing and
holding the UP or DOWN arrow accelerates the operation.) Pressing both SHIFT+ENTER
resets the variable to 0. Pressing ESC aborts the edit.

1 Updating the data in the S7-200 CPU: Pressing ENTER writes the updated value for the
variable to the S7-200 CPU and moves the cursor to the next editable variable on the
screen.
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Accessing the Menus and Screens

When you configured the TD device (as described in Chapter 4), you created the screens and
alarms for the TD device. If you configured both alarms and screens, you also designated which
type of message (screens or the alarms) would be the default display mode for the TD device.
After power-up or after a period of inactivity, the TD device shows the default display mode.

In addition to the screens and alarms that you configured, the TD device provides standard
functions that the operator can access from system-level and pre-defined menus. From the default
display mode, the operator uses ESC to access the menu hierarchy. The operator then presses
ENTER to select the menu item for accessing the other menus or functions. Figure 5-5 shows the
hierarchy of menus for these functions. (The menus show all of the functions that are available.
For some of the functions to be listed on the menu, you must have enabled the function during
configuration. See chapter 4.)

Default Display Mode

Screens
(Default screen)

Press ESC to display the User
Menu (of the screens)

User Menu (of the Screens)

Screens 1

Screens 2

(Up to 8 entries)

Secondary Display

Alarms (Can be configured as
default screen)

Press ESC to display the

ESC Main Menu

Operator Menu

Press ESC to display the
Main Menu

Main Menu

CPU Status

Set Time and Date

Set Language

Press ESC to display the

ESC Main Menu

Diagnostic Menu

Display Alarms

Operator Menu

Diagnostic Menu

Release Password

TD Setup

View Messages

Force I/0

Change CPU Mode

Make Memory Cartridge

Edit CPU Memory

ESC

Press ESC to return to the
default display mode

Press ESC to display the

ESC Main Menu

Figure 5-5

Menu Hierarchy for the TD 200 and TD 200C
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Entering and Releasing a Password

58

You use the TD 200 wizard of STEP 7-Micro/WIN to configure the password for the TD device.
Refer to Chapter 4 for information about configuring the TD device. To ensure that an
unauthorized user does not have access to the TD device during an interval for the automatic
time-out, you can use the Release Password feature.

Certain operations (such as forcing I/O or making a memory cartridge) may also require that the
operator enter the 8-character CPU password for the S7-200 CPU. (You must have enabled the
S7-200 CPU for password-protection in order for the TD device to prompt the operator for the
CPU password.)

Entering the Password

If configured for a password, the TD device prompts the operator to enter the 4-digit password
before allowing the operator to access screens or menus. If the password uses fewer than 4
digits, the operator must press ENTER for the unused (remaining) characters.

Use the UP or DOWN arrow to select each digit of the password, pressing ENTER to move to the
next digit.

The TD device provides a time-out feature which automatically restores password protection after
a period of inactivity. If no buttons have been pressed after 2 minutes, the TD device then requires
a password again before allowing an operator to access menus or to edit variables.

Releasing the Password

In order to provide additional security for your application, the TD device provides a Release
Password command that immediately restores the password-protection. The TD device then
requires that the operator enter the password before allowing access. The Release Password
command prohibits another person from using the TD device without first entering a password (for
example, before a password entered by an operator times out).

You access the Release Password command from the main menu, as shown in Figure 5-6.

The Release Password is not applicable for the CPU
password: The TD device releases the CPU password
as soon as the operator exits the function that required
the password.

Show Alarms
Operator Menu
Diagnostic Menu
For example: If the operator entered the CPU password Release Password
in order to force an /O point in the S7-200 CPU, the
TD device releases the CPU password as soon as the
operator exits the Force menu.

Figure 5-6  Release Password Command

The Release Password command is available only if you defined a 4-digit password when you
configured the TD device.
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Viewing the Screens and the Alarms

As described in Chapter 4, you can configure screens and alarms for the TD device. If you
configure both alarms and screens, you also designate which set of messages (screens or
alarms) are the default display mode for the TD device. The default configuration selects the
screens to be the default display.

After power-up or after a period of inactivity (one minute), the TD device shows the text of the
default display mode. As shown in Figure 5-7, the operator can switch between the default display
mode and the secondary display mode.

Tip
@ For the TD 200C: If you do not configure buttons for ESC or ENTER, you cannot access the
main menu.

Screens: Up to 8 Screens Each for Up to 8 Groups

Press ESC to display the User

Menu (of the screens) ESC

User Menu

| . |
Sereen' - — I
User menu item 2

Use the UP or DOWN arrow

button to scroll through the
screens for this group (Up to 8 entries)

Screens
Press ESC to display the

ESC | Main Menu

Default Display Mode

Secondary Display

Main Menu

Bit-Enabled Alarms

ESC

Press ESC to display the
default display Alarm message

Use the UP or DOWN arrow

buttons to scroll through the list
Display Alarms SO — — — — — of alarm messages
Operator Menu

Diagnostic Menu
Release Password

Press ESC to display the
Main Menu

|

Figure 5-7 Navigating between the Default and Secondary Displays
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Displaying the Alarms

If you created both screens and alarms when you configured the TD device, the main menu of the
TD device includes a command that allows you to access the secondary (non-default) display.
The TD device always returns to the default display mode after a period of inactivity.

As shown in Figure 5-8, the main menu provides a

Display Alarms command for the default TD

cpnfiguration. If_ you comfigured glarms as the default Operator Menu
display, the main menu lists a Display Screens : :
Diagnostic Menu

command.
Release Password

Atfter displaying the alarms, you use the UP and DOWN
arrows to scroll through the sequential list of alarms.

Figure 5-8  Displaying the Alarms
Tip
The TD 200C allows you to configure a button specifically for displaying alarms.

The TD device displays the two highest priority alarms. The TD device displays an up or down
arrow with the alarm to alert the operator that other alarms have been enabled. (The up arrow
shows that higher-priority alarms have been enabled, and the down arrow shows that
lower-priority alarms have been enabled.)

Atfter reading a new alarm from the S7-200 CPU, the TD device sorts the alarms again to display
the highest priority alarms at the top of the list. The TD device determines the priority based on the
sequence of the alarms in the parameter block:

1 The first alarm that you created has the highest priority.

1 The second alarm that you created has the second-highest priority.

[ The last alarm that you created has the lowest priority.
Tip
You can scroll up and down through the list of enabled messages. However, the TD device
returns to the highest-priority alarm after a period of inactivity: If you have not pressed a button

for 10 seconds while the TD device has displayed the current alarm, then the TD device
automatically returns to the highest-priority alarm.

Acknowledging an Alarm

If an alarm requires acknowledgement, the TD device does not remove that alarm until you
acknowledge the alarm:

1. Use the UP or DOWN arrow to select the alarm.

2. Press ENTER to acknowledge the alarm.
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Types of Alarms

When you configured the alarms (see Chapter 4), you enabled the following interaction with the
operator:

1 Acknowledgement is not required, and editing of variables is not allowed:

The TD device displays the alarm. The alarm can contain variables that are updated at the
update rate of the TD device, but ENTER has no function because the alarm does not
contain any editable variable. Pressing ESC returns to the main menu. An up or down arrow
displayed with the alarm signals that higher or lower alarms have been enabled. The
operator can use the UP or DOWN arrows to scroll through the other alarms.

The TD device does not reset the alarm bit for this type of alarm. To remove this alarm from
the TD device, you must include logic in your user program to reset the alarm bit.

1 Acknowledgement is not required, but Editing of variables is required:

The TD device displays the alarm and waits for the operator to edit the value of the
embedded variable. If you configured the alarm for automatic editing, the TD device places
the cursor to the right-most character of the variable. Pressing ESC returns to the main
menu. An up or down arrow displayed with the alarm signals that higher or lower alarms
have been enabled. The operator can use the UP or DOWN arrows to scroll through the
other alarms.

After modifing the value for the embedded variable, the operator presses ENTER. The

TD device then moves the cursor to the next editable variable. Pressing ENTER for the last
editable variable of an alarm writes the new values for the variables to the S7-200 CPU.
The TD device resets the alarm bit.

1 Acknowledgement is required, but editing of variables is not allowed:

If you configured the alarm to require acknowledgement, the TD device alerts the operator
in the manner that you selected. If the alarm contains a variable, the TD device updates this
value at the rate of the TD device. An up or down arrow displayed with the alarm signals
that higher or lower alarms have been enabled, but the operator must first acknowledge this
alarm before scrolling to another alarm.

When the operator acknowledges the alarm (by pressing ENTER), the TD device sets the
acknowledge bit for the alarm and resets the alarm bit.

1 Acknowledgement is required, and Editing of variables is also required:

If you configured the alarm to require acknowledgement, the TD device alerts the operator
in the manner that you selected. If the alarm contains a variable, the TD device updates this
value at the rate of the TD device. If you configured the alarm for automatic editing, the

TD device places the cursor to the right-most character of the variable. An up or down arrow
displayed with the alarm signals that higher or lower alarms have been enabled, but the
operator must first acknowledge this alarm before scrolling to another alarm.

After modifing the value for the embedded variable, the operator presses ENTER. The

TD device then moves the cursor to the next editable variable. Pressing ENTER for the last
editable variable of an alarm writes the new values for the variables to the S7-200 CPU.
The TD device sets the acknowledge bit for the alarm and resets the alarm bit.
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Editing a Variable That Is Embedded in an Alarm or a Screen

If you configured a screen or an alarm to include a variable, you can enter a new value for the
variable:

0 Use ENTER to move the cursor to the the variable.

1 Use the UP or DOWN arrows to change the value of the variable.

1 Use the following buttons to move the cursor to different characters within the variable:
- TD 200C: LEFT and RIGHT arrows
- TD 200: SHIFT+UP arrow and SHIFT+DOWN arrow

1 ESC reads the value of the variable from the S7-200 CPU and redisplays the value.

1 ENTER writes the new value to the S7-200 CPU. (If the alarm contains other variables, the
cursor moves to the next variable.)

If the alarm was configured as a numeric string, the cursor skips over any non-numeric characters
in the message. See Chapter 4. After you have edited all of the variables in an alarm, the
TD device resets the alarm bit in the S7-200 CPU.

Warning
' E Due to restrictions in the format used to store real (floating-point) numbers in both the S7-200
L ]
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CPU and the TD device, the accuracy of the number is limited to six significant digits. Editing a
real number with more than six digits may not change the value of the variable, or may cause
other digits within the number to change:

m  Changing the least significant (right-most) digit of a real-number variable with more than six
digits may have no effect. For example, if you try to change the “9” in “1234.56789”, the
value of the variable does not change.

m  Changing the most significant (left-most) digit of a real-number variable with more than six
digits may cause other (less significant) digits in the variable to change.
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Performing Typical or Routine Operator Tasks (Operator Menu)

The Operator Menu allows you to perform the following tasks:

1 Determining the model and version of the S7-200 CPU (CPU Status)
1 Viewing the error messages generated by the S7-200 CPU (CPU Status)
[ Setting the time for the TD device (Set Time and Date)

1 Selecting a language set for the TD device (Set Language)

Viewing the Status of an S7-200 CPU

The CPU Status command allows you to display the following information:

1 Model and version of the S7-200 CPU

1 Error messages generated by the S7-200 CPU

After you select the CPU Status command, the

TD device displays the CPU model and version.

Press the UP or DOWN arrows to display the error

Show Alarms

Diagnostic Menu
Release Password

Operator Menu

messages that were generated by the S7-200 CPU.

The TD device displays an error message only if an
error exists in the S7-200 CPU. The CPU classifies

errors as either fatal errors or non-fatal errors.

Table 5-1 lists the error messages that can be
displayed by the TD device. Refer to the SIMATIC
S§7-200 Programmable Controller System Manual for

information about specific errors.

Set Language

CPU Status

Set Time and Date

Figure 5-9  Operator Menu
Table 5-1 Error Messages Relating to the Status of the S7-200 CPU
Type Message Description
Fatal Checksum Error Hardware failure (S7-200 CPU)
Compare Contact User program error: lllegal Compare contact
EEPROM Failure Hardware failure (S7-200 CPU)
MC Failure Memory cartridge failure
Watchdog Timeout Hardware failure (S7-200 CPU)
Unknown Error XXXX CPU failure (S7-200 CPU)
(where XXXX = the error number)1
Non-Fatal 1/O Error Mod X An expansion module encountered an 1/O error.

(where X = the number of the I/0
module)?

Runtime Error XXXX
(where XXXX = the error number)1

If there are multiple failures, the TD device displays this
message multiple times one time for each failed
module.

The S7-200 CPU encountered an error while executing
the user program, such as:

Indirect addressing
HSC setup and execution errors

Attempting to execute an illegal instruction (ENI,

DISI, or HDEF) inside an interrupt routine

Subroutine nesting errors
TODW data errors

Simultaneous Transmit (XMT) and Receive (RCV)

errors

1 Refer to the SIMATIC S7-200 Programmable Logic Controller System Manual for information about the specific

error.

2 The expansion modules are numbered 0 (zero) to 6. “MOD C” denotes a failure in the I/O of the S7-200

CPU module.
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Setting Time and Date in the S7-200 CPU

You can use the TD device to change the time-of-day settings in the S7-200 CPU. This allows an
operator to easily adjust for time changes.

The TD device does not maintain time and date settings. In order to display the time and date
values, the TD device reads the current time and date from the S7-200 CPU and displays these
values. The operator can then use this screen to edit these values and then write the new time
and date settings back to the S7-200 CPU.

Tip
@ The TD device does not validate the time, date or day of the week values that you enter. You
can inadvertently write an incorrect date or day of the week to the S7-200 CPU.

To allow an operator to change the time and date settings in the S7-200 CPU:

O You must have enabled (selected) the time-of-day (TOD) option when you configured the
TD device with the TD 200 wizard. Refer to Chapter 4.

1 The S7-200 CPU must support the TOD clock.

Tip
@ If you configured a password for the TD device, the operator must enter the password before
being allowed to set the time and date.

If the TD device was not configured to allow changes to
the time or if the S7-200 CPU does not support the Show Alarms

TOD clock, the Set Time and Date command does not

appear on the Operator Menu. Diagnostic Menu

Atfter you select the Set Time command, the TD device Release Password
reads the current date and time from the S7-200 CPU.

The Time and Date screen displays the following Y

information:
1 Date: day-month-year (for Chinese, the date is PUtatus db
displayed as year-month-day)
Set Language
g Time

1 Day of the week

Figure 5-10 Setting the Time and Date
Use the UP or DOWN arrow buttons to change the values in the fields.

Use the ENTER to move to the next field. (For a TD 200C, you can also use the RIGHT arrow. For
a TD 200, you can use the SHIFT+DOWN arrow.)

Use the ESC to move back to the previous field. (For a TD 200C, you can also use the LEFT
arrow. For a TD 200, you can use the SHIFT+UP arrow.)

Pressing ENTER when the cursor is located on the last field of the Time and Date screen writes
the new time and date values to the S7-200 CPU and returns to the Operator Menu.

Pressing ESC when the cursor is located on the first field of the Time and Date screen returns to
the Operator Menu.
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Changing the Language Set

You can use the TD device to change the language set in order to localize the TD device for
another country. You must have created different language sets for your alarms and screens when
you configured the TD device with the TD 200 wizard. Each language set that you configure

selects the language for the menus and prompts of the TD device, as well as the screens and
alarms. Refer to Chapter 4 for information about configuring language sets for the TD device.

As shown in Figure 5-11, selecting the Set Language command displays a menu of the languages
that you configured with the TD 200 wizard. Use the UP or DOWN arrows to select the language
to be displayed by the TD device.

Show Alarms

Diagnostic Menu
Release Password

Operator Menu

CPU Status
Set Time and Date

Set Language

Language 1
Language 2

(configured languages)

Figure 5-11

Selecting One of the Language Sets Configured for the TD Device

Performing Specialized Operator Tasks (Diagnostic Menu)

Some of the pre-configured tasks provided by the TD device provide assistance with setting up
the TD device or troubleshooting problems with the S7-200 CPU. These functions are typically
accessed infrequently. See Figure 5-12.

Show Alarms

Operator Menu

Diagnostic Menu
Release Password

TD Address

CPU Address

Parameter Block Address

Baud Rate

Highest Station

Gap Factor

Contrast

TD Setup

View Messages

Force I/0

Change CPU Mode (TD 200C)

Make MC (TD 200C)

Edit CPU Memory (TD 200C)

S7-200 password required
(if configured)

Force Input

Force Output

Unforce All I/O

Figure 5-12  Diagnostic Menu Hierarchy
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Setting up the TD Device

As shown in Figure 5-13, you use the TD Setup menu to configure various parameters for the
TD device, such as network addresses, address of the parameter block (stored in V memory of
the S7-200 CPU), baud rate, and other communication parameters.

a

Tip
At 9600 baud or 19.2 kbaud, the highest station address may need to be increased, even

Setting the network address for the TD device:

Use the UP or DOWN arrow to set the network TD Setup

address (default address = 1). View Messages

Setting the CPU address: Use the UP or DOWN Force 1/0O
arrow to select the network address for the Change CPU Mode
S7-200 CPU (default = 2). Make MC

Setting the address for the parameter block: Edit CPU Memory

Designates a V memory location where the
parameter block (or an offset to the location of the
parameter block) is stored in the S7-200 CPU.

Setting the address of the parameter block allows
you to connect multiple TD devices to a single TD Address
S7-200 CPU. CPU Address
Use the UP or DOWN arrow to select the starting Parameter Block Address
V memory address of the parameter block that B?“d Rate :
stores the configuration of the TD device. Highest Station
Gap Factor
The address of the parameter block must match Gl
the address that you configured in the

S7-200 CPU (address range: VBO to VB3200,
default = VBO). Figure 5-13 TD Setup Menu

Setting the baud rate for the TD device: choose the baud rate for the TD device. You can
choose either 9.6 kbaud (9600 baud), 19.2 kbaud, or 187.5 kbaud.

Use the UP or DOWN arrow to select the baud rate. The baud rate must match the baud
rate of the S7-200 CPU and any other device on the same network.

Setting the Highest Station: Changes the highest station address for the TD device. This
setting tells the TD device which network addresses to check when looking for other
network master devices. The default highest station address is 31. This means that the
TD device checks addresses 0 through 31 when looking for other network masters. This
setting should only be changed when there are more than 32 master devices on the
network.

Use the UP and DOWN arrows to select the highest address on the network (default = 31)

Setting the Gap Factor: Changes the Gap Factor for the TD device. This setting tells the

TD device how often to check for other network master devices. The default setting of 10
causes the TD device to check once every 10 messages. A setting of 1 would cause the
TD device to check for other masters after every message.

Use the UP and DOWN arrows to select the gap factor between stations (default = 10)

Set the contrast: You can optimize the display for different viewing angles and lighting
conditions by adjusting the contrast of the screen on the TD device. The default contrast
value is 40, with values ranging from 25 (lighter) to 55 (darker).

Use the UP and DOWN arrows to select the contrast setting for the display area of the
TD device (default setting = 40)

though the network does not contain more than 32 masters. Increasing the highest station
address allows more time for the masters to transmit messages.
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Viewing the TD Messages Stored in the S7-200 CPU

You can review all of the TD messages (screens and alarms) that you configured for the
TD device within the language set currently selected for the TD device.

The View Messages command allows you to verify that

all of the alarms and screens were correctly stored in
he S7-2 CPU TD Setup
the S7-200 : View Messages

The View Messages command does not allow you to Force I/O

edit any values that are displayed in the messages. Change STOP/RUN Mode
Make MC

Selecting the View Messages command displays all of Edit CPU Memory

the messages and process values stored in the
S7-200 CPU. Use the UP and DOWN arrows to scroll

through messages stored in the S7-200 CPU.
Figure 5-14 View Messages Command

Forcing the Inputs and Outputs in the S7-200 CPU

The Force 1/0 menu allows you to force inputs, force outputs, or unforce all inputs and outputs.
The Force 1/0 command is available only if you enabled the force-menu when you configured the
TD device with the TD wizard.

Caution

Turning off the power to the S7-200 CPU before the force information is written to the permanent
memory in the CPU can cause the S7-200 CPU to experience a failure the next time you turn
the S7-200 CPU on.

To clear the error condition, use the TD device to either unforce all of the I/O points or else
rewrite the force information to the S7-200 CPU. Cycling the power to the S7-200 CPU should
clear the error.

If the S7-200 CPU requires a password before allowing
the 1/O to be forced, the TD device prompts the TD Setup
operator to enter the 8-character CPU password. View Messages

The Force 1/0 command provides the following options: | | Iiiadi
Change CPU Mode
1 Force Input: Allows you to force individual inputs Make MC

on or off, or to turn off the Force function Edit CPU Memory

1 Force Output: Allows you to force individual
outputs on or off, or to turn off the Force function

1 Unforce All I/O: Allows you to turn off the Force
function for all of the forced 1/O points Force Inputs
Use the UP or DOWN arrow to select the specific 1/O Force Outputs
point. Pressing ENTER moves the cursor to the Force Unforce All /0O
options. (For a TD 200C, you can also use the RIGHT

arrow. For a TD 200, you can use the SHIFT+DOWN

arrow.)

Use the UP or DOWN arrow to select the type of force  Figure 5-15 Force I/O Command
condition for the selected 1/O point.

Tip
@ Unforcing the 1/O points does not place them in the OFF state. Unforcing only removes the
Force option. The points remain in their last state until you manually change them or they are
changed by the user program in the S7-200 CPU.
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Changing the Operating Mode of the S7-200 CPU (TD 200C Only)

The Change STOP/RUN Mode command is only available for the TD 200C and is only available if

you selected this function when you configured the TD 200C with the TD 200 wizard. See
Chapter 4.

You can use the TD 200C to change the operating mode of the S7-200 CPU from STOP to RUN
or from RUN to STOP. The operator may need to enter the TD password, if the TD 200C is
configured for password-protection.

In order to allow the TD 200C to change the operating
mode, the mode selector switch on the S7-200 must be ‘ D Setup ‘
set to either RUN or TERM. View Messages

The TD 200C cannot change the operating mode if the Force I/O

mode selector switch is set to STOP. Change STOP/RUN Mode

Make MC

Edit CPU Memory

Figure 5-16 Changing the Operating Mode

Copying the User Program to a Memory Cartridge (TD 200C Only)

The Make MC (memory cartridge) command is only available for the TD 200C and is only

available if you selected this function when you configured the TD 200C with the TD 200 wizard.
See Chapter 4.

You can use the TD 200C to copy the user program in the S7-200 CPU to a memory cartridge
(MC). The operator may need to enter both the TD password and the CPU password, if both the
TD 200C and the S7-200 CPU are configured for password-protection.

Before attempting to write the user program to the
memory cartridge, ensure that you have installed a

. . TD Sett
memory cartridge in the S7-200 CPU. | Viev?i/llg;sages |
After you select the Make MC command, the TD 200C Force /0 |
alerts you that this operation will erase any existing Change STOP/RUN Mode

data on the memory cartridge. Press the DOWN arrow
to continue. Edit CPU Memory

After reading the message, press ENTER to continue
or press ESC to abort the operation.

Figure 5-17 Making a Memory Cartridge
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Editing the CPU Memory (TD 200C Only)

The Edit CPU Memory command is only available for the TD 200C and is only available if you
selected this function when you configured the TD 200C with the TD 200 wizard. See Chapter 4.

You can use the TD 200C to edit the values stored in
the memory of the S7-200 CPU. The operator may
need to enter the TD password, if the TD 200C is

p dqf d-orotecii ‘TD Setup ‘
configured for password-protection. View Messages
After you select the Edit CPU Memory command Force I/O |
(Figure 5-18), the TD 200C displays the Edit CPU Change STOP/RUN Mode

Memory screen. Make MC
As shown in Figure 5-19, you press ESC to edit the Edit CPU Memory

data in the memory address. The TD 200C places a
cursor on the memory area.

Figure 5-18 Edit CPU Memory Command

1 To edit the memory address: Use the UP or DOWN arrows to change the memory address.
(Use the RIGHT or LEFT arrow keys to move between the fields of the memory address.)
Press ENTER to display the value of that memory address and to move the cursor to the
data type field.

1 To edit the data type: Use the UP or DOWN arrows to change the data type. Press ENTER
to display the value and to move the cursor to the value field.

1 To edit the value stored in the memory address: Use the UP or DOWN arrows to change
the data type.

Press ENTER to write the new values to the memory address in the S7-200 CPU. Pressing ESC
aborts the function.

ESC Press ESC to edit the Press ENTER to write the new
CPU memory value to the CPU memory
L

Edit the memory address Edit the data type Edit the value
Area Size Address Data type Value

‘ 00000 ‘ ‘ (INT) ‘ -12345
\ ,/

A VWO00000 (INT) 2 i) ‘ A The UP and DOWN arrows
/ “" change the data in the

-12345 ‘ selected field

Figure 5-19  Editing the Memory in the S7-200 CPU
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Table 5-2 lists the memory address and data types possible. For information about the memory
areas, sizes of the data, and data types supported by your S7-200 CPU, refer to the data sheet for
your CPU model or to the S7-200 Programmable Controller System Manual.

Use the UP and DOWN arrows to scroll through the list of valid entries for each field.

To change the numeric value displayed in the address and value fields:

O Usethe UP and DOWN arrows to adjust each digit in the value or address.

1 Usethe LEFT and RIGHT arrows to move between the digits of the value or address.
1 Press ENTER to write the new value to the S7-200 CPU.

Tip
Binary values cannot be edited.

Table 5-2 Possible Values for the CPU Memory Address and Data Type

Field

Description

Memory area

Memory size

Address

Data type

V  Variable memory area
M  Bit Memory area

SM Special Memory area

T Timers Current value only', INT only
C Counters Current value only®, INT only
| Inputs

Q Outputs

B (byte)

W (word)

D (double-word)
0 to 32000 (limited by the memory for your S7-200 CPU)

Refer to the S7-200 Programmable Controller System Manual for the range of memory
supported by the different S7-200 CPU models)

INT

REAL

HEX
BIN

Integer (valid for Byte, Word or Double-word)

Byte values are displayed as unsigned integers
Word and Double-word values are displayed as signed integers

Real or floating-point (valid for Double-word only)

The value displayed for a Real number is rounded to 6 or 7 significant digits. The
TD 200C displays the Real number in fixed-point format only (no scientific notation)

The TD 200C cannot display Real numbers larger than 18 digits and allows up to 7
decimal places. (For example: The TD 200C displays 0.00000005 as 0.0000001, and
displays real numbers less than 0.00000005 as “0.0”.)

The TD 200C writes the number displayed to the S7-200 CPU without rounding.
Hexadecimal (valid for Byte, Word, and Double-word)
Binary (valid for Byte and Word only)

Binary values are displayed in the same pattern (7..0) as discussed in the S7-200
Programmable Controller System Manual and displayed by the Status Chart of
STEP 7-Micro/WIN

Binary values cannot be edited

1 The TD 200C displays only the current value for timers and counters. To display preset values for timers or
counters, you must store these values in V memory. The TD 200C does not display the value of the timer or

counter bit.
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General Technical Specifications

Table A-1 Text Display Order Numbers

Order Number Description Dimensions (mm) (W x H x D) Weight
6ES7 272-0AA30-0YAO | TD 200 Operator Interface 76 x 148 x 28 0.19 kg
6ES7 272-1AA10-0YAO | TD 200C Operator Interface 76 x 148 x 28 0.20 kg

6ES7 272-1AF00-7AA0

Blank faceplate overlay material, A4 size (10 sheets/package)

Table A-2 General Specifications
General 6ES7 272-0AA30-0YAO 6ES7 272-1AA10-0YAO
Keyboard Membrane keypad with 9 keys Customizable faceplate
Tab inserts for customer-specific labeling Supports up to 20 keys
Display STN-Graphic Display with 181 x 33 (Columns x Rows), LED backlight

PG-PLC interface

Supply voltage (Uy)

Current consumption (ly)

Inrush current

Degree of protection

Safety
VDE regulation

Noise emission

RS 485 (PPI); 9.6 / 19.2/ 187.5 Kbits/s

24 VDC, 15 VDC///30 VDC, safety extra low voltage, supplied by the S7-200 CPU, mains
adapter or a 24 VDC external supply). The TD device has no integrated means of
protection against strong interference pulses in the microsecond range (surge impulse). If
the power being supplied has no appropriate means of protection, then a surge voltage
protector should be pre-connected.

typical 70 mA, (terminating resistors switched off)
Maximum 120 mA at Uy 24V (3.15A fuse in TD 200).

Maximum 0.6 A/ 15 ms

IP 65! (mounted on front of the panel)
IP 20 (mounted on casing)
NEMA 41

VDE 0805, EN 60950, IEC 60950

<45dB(A) to DIN 45635 (no fan)

1 To ensure compliance with IP 65 or NEMA 4:
The minimum panel thickness must be at least 1.5 mm.

The mounting screws on the TD device must be tightened to a torque of 0.7 N-m.
The gasket must be replaced whenever the TD device is removed and reinstalled.
To procure new gaskets, contact your Siemens distributor or sales representative.
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Table A-2 General Specifications, continued

General

6ES7 272-0AA30-0YAO 6ES7 272-1AA10-0YAO

Electromagnetic Compatibility (EMC)

Emitted interference
Limit class

Noise immunity on signal
lines

Noise immunity to discharge
of static electricity

Conducted interference on
DC power supply line

Noise immunity to high
frequency emission

Climatic conditions

Temperature
Operation
Storage/Transport
Relative humidity
Operation
Storage/Transport

B to EN 55022 = CISPR 22
+2kV according to IEC 61000-4-4 1000-4-4; Burst

+6kV  Contact discharge (according to IEC 61000-4-2; ESD)
+8kV  Air discharge (according to IEC 61000-4-2; ESD)

+2kV  according to IEC 61000-4-4; Burst
+1kV according to IEC 61000-4-5; us-impulse (Surge); (line against line)
+2kV  according to IEC 61000-4-5; us-impulse (Surge); (line against earth)

Power supplies with the same voltage can only be used with additional means of
protection, for example, a surge voltage protector available from the Dehn company, type
RZ/E 24 V-, order No. 917 204.

10 V/m with 80% amplitude modulation at 1 kHz, 9 kHz to 80 MHz
(according to IEC 61000-4-6)

10 V/m with 80% amplitude modulation at 1 kHz, 80 MHz to 1 GHz
(according to IEC 61000-4-3)

10 V/m pulse modulated 50% duty cycle at 900 MHz and 1.89 GHz
(according to IEC 61000-4-3)

Tested according to DIN IEC 60068-2-1, DIN IEC 60068-2-2
+0° C to +60°C (+32° F to +140 °F) (rate of temperature change max. 10 °C/h)
-20° C to +70 °C (-4° F to +158 °F) (rate of temperature change max. 20 °C/h

Tested according to DIN IEC 60068-2-3
5% to 85% at 30 °C (no condensation)
5% to 93% at 40 °C (no condensation)

Mechanical Environmental Conditions

Vibration
Operation
Transport (packaged)

Shock
Operation
Transport (packaged)

Special Features
Quality assurance
Servicing

Panel mounting

Tested according to DIN IEC 60068-2-6
10 Hz to 58 Hz, amplitude 0.075 mm 58 Hz to 150 Hz, acceleration 9.8 m/s2
5 Hz to 9 Hz, amplitude 3.5 mm 9 Hz to 500 Hz, acceleration 9.8 m/s2

Tested according to DIN IEC 60068-2-27/29
Semisinusoidal: 150 m/s2 (15g), 11 ms
Semisinusoidal: 250 m/s2 (25g), 6 ms

In accordance with ISO 9001

Maintenance-free (no battery)

Accessories for panel mounting are enclosed
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Certificates, Directives and Declarations

Notes on the CE Symbol
The following applies to the SIMATIC product described in this operating instruction: ce

EMC Directive

This product fulfils the requirements for the EC directive 89/336/EEC on “electromagnetic

compatibility” and the following fields of application apply according to this CE symbol. See
Table A-3.

Table A-3 EMC Directive

Requirement for
Field of Application

Emitted Interfetence Noise Immunity
Residential and commercial areas and EN 61000-6-3: 2001 EN 61000-6-1: 2001
small businesses
Industry EN 61000-6-4: 2001 EN 61000-6-2: 2001

ATEX Directive (Explosion Protection Guidelines)

This product fulfils the requirements for the EC directive 94/9/EEC on “ATEX”

(Devices and protection systems to be used as prescribed in potentially explosive
areas (Guidelines for Explosion Protection)” and was tested according to EN 50021
(Electrical apparatus tor potentially explosive atmospheres;Type of protection “n”).

&9 13 GEEXnAIIT3..T6

Declaration of Conformity

The EC declarations of conformity and the documentation relating to this are available to the
authorities concerned, according to the above EC directive, from:

Siemens AG

Bereich Automatisierungs- und Antriebstechnik
A&D AS RD ST

Fr. Zisler

Postfach 1963

D-92209 Amberg

Tel.: 09621 80 3283
Fax: 09621 80 3278

Observing the Setup Guidelines

The setup guidelines and notes on safety given in the manual must be observed on startup and
during operation.
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Approvals for USA, Canada and Australia

The characters stamped on a device are indicative of the requirements which that device meets:

Underwriters Laboratories: cULus Approval, Hazardous Location
C us

CULUS Listed 21BP I.T.E. for Hazardous Location HAZ. LOC.
Underwrites Laboroatories Inc., according to:

O UL 60950 (Information Technology)

O CSAC22.2 No. 60950 (Information Technology)
1 UL 1604 (Hazardous Location)

1 CSA-213 (Hazardous Location)

APPROVED for Use in:

g ClL1,Div2,GP.A,S,C,D, T5
a Cl.1,Zone 2, GP.IIC, TS

Please see the note below:

Note:
This plant has to be mounted according to the NEC (National Electric Code)
stipulations.

When used in environments according to class |, division 2 (see above), the

SIMATIC TD device must be mounted in a housing that corresponds to at
least IP54 according to EN 60529.

UL recognition mark -\ Y

FM approval to Factory Mutual Approval Standard Class Number 3611, Class |,

Division 2, Group A, B, C, D, and Class |, Zone 2, Group IIC.

Temperature class T5 is adhered to when the ambient temperature during

operation does not exceed 60°C. APPROVED

Note for Australia: Our product fulfills the requirements for Norm AS/NZS 3548. o

FM Approval Notes

N

N

FM approval, if present, is to Factory Mutual Approval Standard Class Number 3611, Class |,
Division 2, Group A, B, C, D, and Class |, Zone 2, Group IIC.

Temperature class T5 is adhered to when the ambient temperature during operation does not
exceed 60°C.

Warning
Personal injury or property damage can result if you do not follow FM hazardous location
guidelines.

In hazardous areas, personal injury or property damage can result if you close or disconnect an
electrical circuit during operation (for example, plug-in connections, fuses, switches).

Do not close or disconnect any live circuits unless explosion hazards can be definitely excluded.
Do not disconnect while the circuit is live unless the location is known to be non-hazardous.

Warning

WARNING - DO NOT DISCONNECT WHILE CIRCUIT IS LIVE
UNLESS LOCATION IS KNOWN TO BE NON-HAZARDOUS
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Standard TD Character Set

Table A-4 Standard TD Character Set
Char  Hex Dec | Char Hex  Dec |Char Hex Dec | Char Hex | Dec | Thar  Her | Dec
20 32 M 40 F7 z ho122 PoAF 167 ¥ D4 212
! 21 33 M 4E 78 ) 7B 123 i A8 168 1 D5 213
! 22 34 o | 4F 79 | o124 T A9 169 1 D 214
# 23 35 P |50 8O F I I &4 170 7 DF 213
$ 24 36 Q |51 81 = TE 126 - R A | I Dg | 216
% 25 37 R |52 82 «— F 127 YoooaC 172 I D9 217
B 26 38 S |53 83 BO | 128 1 'aDp 173 L D& | 218
! 27 39 T 54 84 a 81 129 3 AE 174 n DB 219
i 28 40 U |55 85 g2 | 130 ¥ AR 175 T | DC 220
), 29 41 ¥ |56 BB g3 131 - | BO 176 + DD 221
*o2a 42 W 57 87 a B4 132 T Bl 177 " | DE @ 222
+ 2B 43 % |58 B8 85 133 i | B2 178 ° DF | 223
' 2C 44 ¥ |59 89 ge | 134 7 B3 179 | o EO | 224
- 20 45 Z |54 40 g7 | 135 I B4 180 A El 225
. 2E | 46 [ 58 91 g8 | 136 ¥ BS 181 R E2 226
| 2F 47 ¥ | 5C 92 g3 | 137 hoBe 182 g |E3 | 227
o |30 48 ] 50 93 ga | 138 ¥ B7 183 L | E+ | 228
1 31 49 ~ | 5E | 94 g8 | 139 % B8 184 g E5 229
2 |32 &0 _ |5F 95 gz | 140 T B9 185 p E& | 230
3 33 9 60 | 95 a0 14 1l BA | 186 q EF 231
4 |3 52 a |61 a7 a BE 142 t BB 187 | +f |E& 232
5 |3 53 b 62 o9& 8F 143 » BC 188 | ' E9 |Z233
6 |36 54 c B3 99 & 90 144 A |BD | 189 i | EA | 234
7 |37 55 d | 64 oo | & |91 145 k| BE 190 * EB | 235
8 |38 56 g | 65 101 | s5 |92 146 Y BF 191 t EC | 236
9 |39 57 o B& 102 g 93 147 A 0 192 | M= ED | 237
38 5B q |67 103 a 94 148 | 193 n |EE | 238
i 3B 59 h &8 104 [ & 95 149 Yoz 194 g |EF | 239
< | 3C &0 I |69 105 95 150 T Z3 185 p FO | 240
= 3 61 i | BA 106 97 151 bolC4 | 195 q F1 241
> | 3E B2 k | 6B 107 98 152 r 5 197 B |F2 | 242
? 3F B3 | | 6C 108 4 99 153 Z 6 198 [ oo F3 | 243
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Table A-4 Standard TD Character Set, continued

Chat | Hex | Dec | Char Hex Dec [Char | Hex Dec | Char | Hexr | Dec | Char  Hex | Dec
@ 40 @ A4 m &b 109 0 94 1% A CF 199 @ (F4 0 2494
A4 41 65 n | 6E 110 98 | 155 8 200 0 F5 245
B 42 66 o | 6F 111 9C | 156 Ao 20 E Fo 246
C 43 67 p 70 112 oo 157 hoca 02| TTOFF 247
O 44 68 q 71 113 9E 158 b CB 203 | Mete FB | 248
E 45 &9 r 72 114 9F 159 7 CC 204 | B F9 249
F 46 70 s 73 115 a0 160 A CD 205 Fa | 250
G 47 71 L 74 116 | o | A1 161 # CE 206 | = FB | 251
H 48 72 u 75 17 | ™ Az 182 T CF 207 | & FC | 252
I 49 73 v | 7B 118 | . A3 163 : DO 208 | ss FD | 253
J 48 74 w77 119 -~ A% 14 L D1 209 & FE | 294
K 48 75 x 78 120 a5 165 A D2 ZID| » FF 255
L 4C 76 v 79 121 I AB 166 T D3 211

ALT Key Combinations for International and Special Characters

Certain international and special characters may not display correctly on the TD display if entered
with the TD 200 Configuration Wizard with the standard TD character set. For international and
special characters, use the ALT key and number combinations shown in Table A-5 to enter the
characters in the TD 200 Configuration Wizard.

Table A-5 ALT Key Combinations for International and Special Characters
Character ALT + Key Combination Character ALT + Key Combination

¥ Alt+0129 n Alt+0164

a Alt+0132 Q Alt+0234

S Alt+0145 ) Alt+0228

£ Alt+0146 II Alt+0227

a Alt+0134 ¥ Alt+0157

o) Alt+0148 F Alt+0195 (left arrow <)

A Alt+0143 4 Alt+0180 (right arrow —)

° Alt+0248 | Alt+0200 (single bar)
Alt+0224 [} Alt+0201 (double bar)

B Alt+0225 (]} Alt+0202 (triple bar)

€ Alt+0238 {1} Alt+0203 (four bars)

w Alt+0230 []]] Alt+0204 (five bars)

o Alt+0229 1 Alt+0194 (up arrow)

¢ Alt+0155
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Bar Graph Character Set

Table A-6 shows the bar graph characters that are supported by the standard TD character set.

Table A-6 Bar Graph Character Set for the TD 200

0x30 0=x31 0=32 0x33 =35
O=FB O=FC O=FD 0xFE OxFF 0=F3
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Arabic Character Set
Table A-7 Arabic Character Set for the TD 200 and TD 200C

Char  Hexr | Dec [ Char | Hex Dec [Char Hex Dec | Char Hex  Dec | Char | Hex | Dec
20 |32 M 4D  F7 z A 122 5 A7 67 [ & D4 | 212
! 21 a3 M 4E 78 { 7B 123 - ag 168 vo | DS 213
" 22 34 o 4F 79 | 7 124 a0 169 o DB 214
®# |23 35 P 50 a0 3 D125 & AA 170 = (DY | 215
% 24 35 0 51 g1 o 7E 126 £ fiYs 171 b (I}5] 216
% |25 37 R 52 gz 7F 127 - AC 172 B D9 217
B 26 a5 ] 53 83 £ g0 128 - Ak 173 £ D& 218
' 27 39 T 54 o4 [ g1 129 B | AE 174 £ DB 219
[ 28 40 u 55 g5 | g2 130 B aF 175 - [ 220
)] 29 |41 Y | 56 g6 F 83 131 “ B0 176 | & DD | 221
* 28 42 W 57 a7 a4 132 * B1 177 4 | DE 222
+ 2B 43 x 58 fats] 85 133 2 B2 178 J DF 223
2C | 44 ¥ 59 g9 T 86 134 ? B3 179 a | EO 224
- 20 45 z 54 =l ¥ g7 135 B4 180 J El 225
. 2E 46 [ 5B o1 - fata] 136 M BS 181 E EZ 226
! 2F 47 ! 5C 92 Yoo B9 137 1 BE 182 i) E3 227
] an 48 ] 50 o3 & fat=] 138 ' B7 183 0 E4 228
1 3 449 ~ | BE o4 4 B 139 _ ba 184 s | ES 229
2 32 o0 _ | 5F 95 E | BC 140 1 B9 185 q Eo 230
3 33 51 - &0 08 & a0 141 c BA 186 [ E7 231
4 34 52 a 61 a7 3 gE 142 * BE 187 & ES 232
=] 39 o3 b 62 o8 3 aF 143 W BC 188 & E9 233
a] 36 o4 C 63 Q9 S 90 144 % BD 189 g Ef 234
7 ar 55 d &4 100 ' o1 145 3 BE 190 =] EB 235
g 3/ 56 e 65 101 ’ g2 146 % | BF M o EC 236
9 39 a7 f [l 102 b 93 147 ” i 192 o ED 237
' 34 | 58 q 67 103 o4 148 = 1 193 i EE 238
H 3B o9 h [als] 104 . 95 149 T 2 194 ) EF 239
= ac &0 I 53 105 - 26 150 ) 3 195 = FO 240
= |30 6l i 64 106 [ — 97 151 i 4 196 "~ | Fi 241
= 3E 62 k. [315] 107 S 98 152 L o 197 . F2 292
? aF (3] | (=18 108 ™ ' 0og 153 4 Ch 198 ) F3 243
@ 40 &4 m 6D 109 3 98 154 I 7 199 d | F4 244
o 41 65 n 6E 110 > 9B 155 - a3 200 ) Fa 245
B 42 ala] [u] &F 111 | | 9C 156 & 9 201 _ F& 246
i 43 &7 p 70 112 =] 157 i Ch 202 =+~ F7 247
O |44 a8 q 71 113 S9E 158 S CB 203 F& 248
E 45 ()] r 72 114 u oF 159 f CC 204 0 Fa 249
F 456 70 s | 73 115 ag | 1e0 = D 205 " FA 250
3 47 71 k 74 116 : a1 161 z CE 206 d FB 2a1
H 48 7z u 75 117 i 0= 162 = _F 207 a FiC 252
I 49 | 73 v | 7B 118 £ A3 163 = DO 208 FO | 253
1 44 74 w77 119 = i 164 3 () | 209 FE 29049
K 4B 75 X 78 120 ¥ a5 165 3 Dz 210 s FF 255

L 4C | 76 v o 79 121 ' A5 166 | - D3 211
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Baltic Character Set

Table A-8 Baltic Character Set for the TD 200 and TD 200C

Char  Hex Dec | Char  Hexr Dec |Char Hexr Dec | Char | Hex  Dec | Char  Hex | Dec
20 az M 40 77 z 758 122 5 a7 167 ] (L] 212
| 21 33 M 4E 78 { 7B 123 1] fit] 168 s] 05 213
! 22 34 o 4F 79 | FiC 124 A9 169 S DE 214
# 23 35 P 50 a0 } 7D 125 R o0, 170 }e: o7 215
F 24 36 g 5l g1 ~ | 7E 126 « AB 171 | D3 216
Y | 25 a7 R a7 a2 7F 127 - A 172 t (] 217
B 26 38 S 53 g3 £ 80 128 - aD 173 S D& | 218
' 27 39 T =4 34 g1 129 | ® @ AE 174 0 DB 219
[ 28 40 ] a5 a5 s g2 130 £ AF 175 ] Lz 220
) 29 41 Yo 56 86 83 131 ° B0 176 2 DD | 221
R T W 57 a7 g4 132 * Bl 177 Z | DE 222
+ 2B 43 " 58 fata] 85 133 2 B2 178 I3 OF 223
2C 44 LR=E a9 T 8o 134 I B3 179 g EO 224
- 2D 45 Z 54 a0 ¥ 87 135 i B4 180 i El 225
. ZE 46 [ 5B a1 tatu] 136 K BS 181 a EZ 226
! 2F 47 ! SiC a2 Yo | B9 137 1 BE 182 c E3 227
0 a0 45 1 oD 93 fafa! 138 ' BY 183 & E4 228
1 31 49 ~ | 5E o4 < B 139 @ B8 184 & |ES 229
2 3z S0 _ SF a5 8 140 1 Bo 185 = E& 230
3 33 =1 . a1l 95 a0 141 T B4 186 =] EY 231
4 34 22 a 61 a7 - 8E 142 » | BB 187 c EB 232
5 35 53 b [ ag . gF 143 14 BC 188 £ ES 233
[a] a6 o4 C B3 99 Q0 144 1% BD 189 Z Ef 234
737 25 d 64 100 i a1 145 [ 3% BE 190 & EB 235
8 38 o6 e | A5 101 ! o2 146 [ & BF 191 a | EC 236
9 39 a7 F [ala] 102 * 93 147 A i 192 k ED 237
: ah 58 [u| &7 103 o4 148 I 1 193 1 EE 238
H 3B o9 h 68 104 - 95 149 A |2 194 | EF 239
= 3T &0 I &9 105 - 95 150 < C3 195 H FO 240
= ab =11 j (ats! 106 — 97 151 A, 4 196 n F1 241
= 3E 62 k a5 107 95 152 1 o 197 n Fz 292
? JF 63 I G g | ™ 99 153 E 6 198 o F3 243
@ 40 &4 m &h 109 a8, 154 E 7 199 a F4 294
i) 41 [T n BE 110 » 9B 155 s _a 200 ] F5 245
B 42 a1} o | &6F 111 Qi 156 E (9 201 G | F& 246
Z 43 &7 p L] 112 - ac 157 z _h 202 - F7 247
D 44 [al] q 71 113 9E 158 E B 203 ] F& 248
E 45 o9 r 72 114 aF 159 G o 204 } F2 249
F 46 70 s 73 115 a0 160 K CD 205 g Fa 250
@ 47 71 k 74 116 al 161 I _E 206 1 FB 251
H 45 P U 75 117 f febes 162 L _F 207 a FC 252
I 49 73 v o 76 118 £ A3 163 S oo 208 2 FD 253
] 484 | 74 w77 119 o a4 164 Mo D1 209 Z FE 254
k. 4B 75 x 78 120 A5 165 M Dz 210 ’ FF 255

L 4Z 76 rRL 121 i A6 166 & D3 211
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Simplified Chinese Character Set

The TD 200 supports the Simplified Chinese character set (GB2312-80) for the People’s Republic
of China. The TD 200 uses Microsoft Windows encoding for this character set. The Windows
encoding allows the TD 200 to display the same characters as shown in the STEP 7-Micro/WIN
TD 200 Wizard when you are using a Chinese emulator or a Chinese version of Microsoft
Windows.

Chinese characters are represented in STEP 7-Micro/WIN by a pair of numbers which represent
the row and column positions of the character in the GB2312-80 specification. The TD 200 also
uses a pair of numbers to represent the Chinese character.

Notes for Using the Simplified Chinese Character Set

%

Tip
The Simplified Chinese character set requires a Chinese version of Windows or a Chinese

emulator to properly display Chinese characters in the TD 200 wizard. You must start the
Chinese emulator before you start the STEP 7-Micro/WIN software.

You can display up to 20 single-byte characters per line of your message. Because the character
set for Simplified Chinese are double-byte characters, you can display up to 10 double-byte
characters per line for a message in Chinese.

Some Latin 1 characters are available from the Simplified Chinese character set. Depending on
your keyboard and/ or emulator, the Latin 1 characters may be available in single-byte format or
they may be double-byte characters like the Simplified Chinese characters. If you use a mixture of
single-byte and double-byte characters in a message, remember that the space nextto a
single-byte character can only be filled by either another single-byte character or an empty space.

The message editor displays 10 double-byte character places. You can fit any of the following
combinations into a character place:

1 1 double-byte character
1 2 single-byte characters
1 1 single-byte character and 1 single-byte blank

You cannot fit one single-byte character plus one double-byte character in a character place.
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Cyrillic Character Set

Table A-9 Cyrillic Character Set for the TD 200 and TD 200C

Char | Hex | Dec Char  Hexr | Dec | Char Hex | Dec Char  Hexr | Dec | Char | Hex Cet
20 32 M 4D 7 Z F=! 122 5 a7 167 o | D4 212
! 21 33 M 4E 78 i 7B 123 E futs 168 k4 D5 213
" 22 34 o 4F 79 | JiC 124 A9 169 L | Do 214
* 23 35 P 50 80 3 D 125 = A 170 4 D7 215
$ 24 36 Q51 81 ~ JE 126 « | AB 171 | W D8 | 216
Y | 25 37 R 52 g2 7F 127 - AC 172 Ll | 09 217
2 26 38 5 53 83 B 80 128 - AD 173 b DA 218
' 27 39 T 54 g4 r g1 129 ® | AE 174 Bl | DB 219
(28 40 55 85 ' g2 130 I AF 175 B DC 220
)] 29 41 WV o6 a6 r g3 131 2 B0 176 3 oD 221
* 28 42 W | 57 a7 g4 132 * Bl 177 K2 | DE 222
+ 2B 43 X 58 88 85 133 I B2 175 A DF 223
2C 44 i 59 a9 T (==} 134 i B3 179 a EO 224
2D 45 z 54 an ¥ a7 135 r B4 180 i El 225
. 2E | 46 [ 5B 9 £ 88 138 M | BS 181 B | EZ2 226
! il 47 | S 92 Yoo | B9 137 1 Bo 182 r E3 227
0 30 48 ] sD 93 b | BA 138 ' B7 183 A E4 228
1 13 49 -~ | 5E 94 q g8 139 & | B& 184 e | ES 229
2 32 ad _ | 9F 93 H | 8C 140 | N2 B9 185 ¥ | EB 230
3 33 al ' 60 96 K ao 141 E BA 186 3 E7 231
4 34 52 =] 61 a7 F 8E 142 . BB 187 H Ed 232
5 3¥F 53 b |62 98 LI 8F 143 i | BC 188 H  E9 233
B 36 24 C 63 29 fi a0 144 3 BD 189 K EA 234
7 37 a5 d 604 100 ' 91 145 5 BE 120 n EB 235
5] 34 a6 =] B3 101 ’ 92 145 T BF 191 ] EC 236
9 39 a7 f bo 102 ) 93 147 & 0 192 H ED 237
: 34 58 g 67 103 94 145 B 1 193 u] EE 235
K 3B 59 h | 68 104 * 95 149 B |2 194 n | EF 239
< 3c ad I 69 105 - 95 150 r 3 185 u] FO 240
= 3D 61 i 64 106 — | 97 151 A C4 195 C F1 241
= 3E [ k 6B 107 a5 152 E 5 197 T Fz g ¥4
¢ F A3 | | &C ms | ™ (99 153 | ¥ <6 198 v | F3 243
@ 40 o4 m &b 109 = | 95 154 3 7 199 b | F4 244
fal 41 65 n BE 110 » 9B 155 1 B 200 x Fa 245
B 42 G5 u] &6F 111 H Qi 156 I 8 201 u F& 246
C 43 67 u] 70 112 3 b 157 K 4 202 Y F7 247
D 44 G5 q 71 113 i 9E 158 n B 203 w F8 245
E 45 &9 ro7e 114 woo9F 159 | M CC 204 | w F9 249
F 46 70 5 73 115 a0 160 H D 205 L] F& 250
G 47 71 k 74 115 ¥ a1 161 o CE 206 sl | FB 251
H 48 7 u 75 117 W Az 162 n CF 207 b FC 252
I 49 73 W 7o 118 ] A3 163 P 0o 208 3 FD 253
] 44 74 w77 119 s ad 164 C 01 209 w | FE 254
K 4B 75 x 78 120 r A5 165 T (s 210 A FF 255

L 42 76 v | 79 121 i AE 16 [ ¥ D3 211
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Greek Character Set
Table A-10  Greek Character Set for the TD 200 and TD 200C

Char | Hex | Dec Char | Hex Dec | Char | Hex | Dec Char | Hex et Char | Hex [T
20 3z M | 4D 77 z 76 122 5 a7 167 T D4 212
! 21 a3 My 4E 78 4 7B 123 - ag 168 Y DS 213
! 22 34 O | 4F 79 | 7 124 a9 169 o Db 214
#* 23 as P a0 a0 + 7D 125 fo1s) 170 " D7 215
£ 24 36 3 |51 g1 ~ | 7E 126 « | AB 171 W Dg  Zl6
o 25 a7 R o2 g2 7F 127 - AC 172 QD9 217
2 26 35 5 o3 83 £ g0 128 - A0 173 I LA, 218
' 27 39 T o4 o4 g1 129 B | AE 174 i DB 219
( 28 40 ] 55 85 ) gz 130 — | AF 175 a D 220
) 29 41 ) ] 86 i g3 131 @ BO 176 E (B]N] 221
* 28 4z W 57 a7 - o4 132 s Bi 177 A DE 222
+ 2B 43 % 58 ag8 .. | 85 133 B2 178 [ DF | 223
2 44 b o9 gq 1 (=] =] 134 ! B3 179 i ED 224
- 2D 45 z o8 an £ g7 135 B4 180 a El 229
. ZE 46 [ B 91 tafu] 136 H BS 151 [ EZ 226
| 2F 47 ! SiC o2 Yo B9 137 1 BE 182 Y E3 227
0 30 48 ] SO 93 8a | 138 ' B7 183 o | E4 228
1 a3l 49 -~ | 5E Q4 < (=] =] 139 ‘E | BB 154 3 ES 229
2 3z a0 _ | 5F 95 8C 140 ‘H | B9 185 i Ef 230
3 33 al ' [alll] 96 ] ] 141 T B4 186 n E7 231
4 34 52 a &l o7 tE 142 * BE 187 A ES 232
5 35 53 b [ o8 oF 143 T BC 188 | EQ 233
a] 36 54 C B3 o0 a0 144 % BD 189 K EA 234
737 55 d | 64 100 ' a1 145 W | BE 120 » | EB 235
a a5 o6 = ] 101 ’ 92 146 v | BF 191 H EC 236
g 39 o7 f ala] 102 h 93 147 T 1] 192 W ED 237
. 38 58 u| &7 103 o4 1458 o, [y | 193 E EE 238
H 3B 59 h | 68 104 . a5 149 B 2 194 o EF 239
< aC 1] I ] 105 - 95 150 I 3 195 m™ FO 240
= 3D Gl i [t} 106 — |97 151 A 4 196 p F1 241
= 3E [0 k ala] 107 95 152 E o 197 [ Fz 242
? aF (6] | B 108 ™ a9 153 z Ch 1958 a F3 243
i 40 [ ] m | &D 109 = 154 H 7 199 T F4 244
i} 41 [ake] n &BE 110 b OB 155 & CH 200 u F5 245
B 42 BE u] aF 111 aC 156 I o 201 p  Fb 246
C 43 67 p 70 112 ab | 157 K Ca 202 ¥ | F7 247
D 44 [ata] q 71 113 9E 158 ) B 203 y Fa 243
E 45 ] r 72 114 9F 159 M | CC 204 w F9 249
F 46 JO 5 73 115 A0 160 ] [N 205 ) Fa 250
G 47 7l E 74 116 al 161 E CE | 206 0 FB 251
H 43 72 u 7o 117 2 A2 162 o CF 207 o FC 252
I 49 73 W Fi=] 118 £ A3 163 M1 (1] 208 u FO 253
] 448 74 w | 77 119 = o) 164 P () | 209 W FE 204
K 4B 75 x 78 120 X a5 165 Dz 210 FF 255

L 4 FL=] Y 73 121 H A5 166 z D3 211
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Hebrew Character Set

Table A-11 Hebrew Character Set for the TD 200 and TD 200C

Char | Hex | Dec [Char Hex Dec [Char Hex Dec | Char Hex | Dec | Char  Hex | Dec
20 32 M 4D 77 z 78 122 5 A7 167 wo D4 212
| 21 33 M 4E 78 { 7B 123 B feta] 168 * 05 213
" 22 34 o 4F 79 | . 124 a9 169 " D& 214
# 23 35 P |50 a0 |3 0125 = A4 | 170 * D7 | 215
% 24 36 0 51 = e TE 126 ] AE 171 D& 216
% | 25 37 R 52 gz 7F 127 - aAC | 172 Da | 217
2 26 G a] S 53 a3 £ g0 128 - A0 173 Ca, 218
' 27 32 T 54 a4 g1 129 ® AE 174 DE 219
[ 28 40 U 55 as S gz 130 - | AF 175 DT | 220
) 29 41 Y S6 s ]a] f 83 131 b EO 176 (B 221
* 28 42 W | 57 a7 " g4 132 s Ei 177 DE 222
+ 2B 43 X | 58 il .. |85 133 B2 178 DF | 223
f 2 44 Y 59 a9 T {a]w] 134 ! B3 179 # | ED 229
- 20 45 z 5h an ¥ =1 135 B4 180 A ) | 225
. 2E 45 [ =B a1 T g8 136 U BS 181 A | E2 226
| ZF 47 ! 5 oz %o 89 137 1 E& 182 T | E3 227
1] a0 43 ] S0 93 8a 138 ' EY 133 | E4 228
1 3l 49 “~ | BE Q4 £ tala] 139 . ES 184 1 ES 229
2z 32 50 _ 5F a5 g 140 1 ES 185 1 E& 230
3 a3 ol - &0 95 a0 141 + BA 186 n | EV 231
4 34 a7 a 61 a7 gE 142 » EB 187 2 | EB 232
5 35 53 b 52 ag oF 143 4 | BC 188 ' EQ 233
& 35 o4 C 63 Q9 a0 144 v | BD 139 B EA 234
7 a7 ] d 54 100 : 91 145 M BE 190 o EB 235
o] 38 ] e 55 101 ! oz 146 é EF 191 2 EC 236
g a9 o7 f (513 102 " 93 147 0 192 O ED 237
: 34 | 58 q | 67 103 94 145 . 2l 193 1 EE 238
i 3B o9 h (1] 104 . 95 149 2 194 ] EF 239
= aC (a1l I 53 105 - 95 150 - 3 195 ] FO 240
= 30 &l i 64 106 [ — 97 151 4 196 o | Fl 241
= 3E 62 k. [315] 107 " 95 152 5 197 iy F2 242
? aF (226 | (=18 108 ™ Qg 153 . ] 198 9 F3 243
@ | 40 &4 m 6D 109 98 | 154 7 199 o  F4 244
b} 41 ] n 6E 110 » 9B 155 . ] 200 Y Fa 245
B 42 [ala] [u] &F 111 aC 156 ’ 9 201 s F& 246
C 43 67 p |70 112 oD | 157 cA 202 i? | F? 247
D 44 [ata] J 71 113 9E 158 B 203 T Fa 248
E 45 ] r 72 114 aF 159 _C 204 B | F3 249
F 46 70 5 73 115 a0 160 D 205 n | FA 220
G 47 71 k 74 116 i a1 161 _E 206 FB 251
H 48 72 u |75 117 f A2 162 CF 207 FC | 252
I 49 73 W Fi:] 118 £ A3 163 | Do 208 FO 293
] 44 74 w77 119 !} At 164 ’ D1 209 FE 254
K | 4B 75 *x | 78 120 ¥ A5 165 D2 | 210 FF 255

L i Fi=] Y 79 121 i A6 166 (] 211
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Latin 1 Character Set
Table A-12  Latin 1 Character Set for the TD 200 and TD 200C

Char | Hex Dec Char | Hex Dac Char | Hex Dac Char | Hex Dec Char | Hex Dac
20 32 M 4D 77 z 78 122 g a7 167 o D4 212
! 21 a3 M 4E 78 { 7B 123 - ag 168 & D5 213
" 22 34 o 4F 79 | 7 124 a0 169 & DB 214
# 23 35 P 50 a0 } D 125 a a8 170 ® D7 215
% 24 35 0 51 g1 o 7E 126 [ ag 171 @ D 216
% 25 arv R 52 g2 7F 127 - AC 172 1 D9 217
B 26 a5 ] 53 83 £ g0 128 - Ak 173 ] DA 218
' 27 39 T 54 o4 g1 129 E  AE 174 ] DB 219
[ 28 |40 J |55 &5 , B2 130 | - aF 175 | 0O DC | 220
)] 29 41 Y 56 g6 f g3 131 o BO 176 ¥ DD 221
* 28 42 W 57 a7 a4 132 * B1 177 =] DE 222
+ 2B 43 x 58 fats] 85 133 2 B2 178 5 DF 223
2C 44 Y 59 g9 T 85 134 ? B3 179 3 ED 224
- 20 45 z 54 =11 ¥ g7 135 B4 180 ! El 225
. 2E 46 [ 5B o1 - fata] 136 M BS 181 E EZ 226
! 2F 47 ! 5C 92 Yoo B9 137 1 BE 182 a E3 227
] an 48 ] 50 o3 5 fat=] 138 ' B7 183 a E4 228
1 31 49 “~ | 5E o4 1 B 139 B BB 184 g ES 229
2 32 o0 _ | 5F 95 E | BC 140 1 B9 185 = E6 230
3 33 51 - &0 08 a0 141 o BA 186 [ E7 231
4 34 52 a 61 a7 Z gE 142 * BE 187 & ES 232
=] 39 o3 b 62 o8 aF 143 W BC 188 & E9 233
a] 36 o4 C 63 Q9 o0 144 % BD 189 g Ef 234
7 ar 55 d &4 100 ' o1 145 3 BE 190 =] EB 235
3 38 o6 e 65 101 ’ 92 146 i BF 191 i EC 236
9 39 a7 f [l 102 b 93 147 & i 192 i ED 237
. 38 S8 g 67 103 o4 148 & 1 193 i EE 238
H 3B o9 h [als] 104 . 95 149 & 2 194 ) EF 239
= ac &0 I 53 105 - 26 150 & 3 195 a FO 240
= 3D Gl i o0& 106 —  9¥ 151 & 4 196 fi Fi 241
= 3E 62 k. [315] 107 " o5 152 & o 197 ] F2 292
? aF (3] | (=18 108 ™ ' 0og 153 £ Ch 198 a F3 243
@ 40 &4 m &0 109 i 08 154 C 7 199 ] F4 244
o 41 65 n 6E 110 > 9B 155 E a3 200 d Fa 245
B 42 ala] [u] &F 111 | | 9C 156 E 9 201 a F& 246
i 43 &7 p 70 112 =] 157 E Ch 202 =+~ F7 247
D 44 ats] J 71 113 g SE 158 E B 203 o] F& 248
E 45 | &9 rol 72 114 | ¥ |9F 159 | I CC 204 | O F9 | 249
F 46 70 g 73 115 A0 160 I D 205 0 Fa 250
3 47 71 k 74 116 i a1 161 I CE 206 d FB 2a1
H 48 7z u 75 117 i 0= 162 I _F 207 a FiC 252
I 49 73 W Fi 118 £ a3 163 o Do 208 Y FD 253
1 44 74 w77 119 s ) 164 K () | 209 b FE 29049
K 4B 75 X 78 120 ¥ a5 165 O D2 210 W FF 255

L 4 76 Y 79 121 i a5 166 O D3 211
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Latin 2 Character Set

Table A-13  Latin 2 Character Set for the TD 200 and TD 200C

Char | Hex Dec | Char Hex | Dec |Char Hex Dec | Thar Hex  Dec | Thar | Hex | Dec
20 3z M 4D 77 z 7o 122 g a7 167 & D4 212
| 21 33 M 4E 78 { /B 123 B A 168 & D5 213
" 22 a4 o | 4F 70 | 7 124 A0 169 S D& 214
&£ 23 a5 p S0 a0 + ] 125 5 4.0, 170 " o7 215
2 24 36 Q 51 g1 ra JE 126 £ fi15] 171 R Da 216
Y | 25 37 R o2 82 7F 127 - | A 172 W] [Wl=] 217
2 26 38 S ] 83 £ g0 128 - a0 173 ] OA, 218
' 27 39 T o4 o4 g1 129 ® AE 174 ] LB 219
( 28 40 ] 55 85 , 82 130 Z aF 175 ] (] 220
) 29 41 Y 56 ] 83 131 ° BO 176 ¥ oo 221
* 20 42 W 57 a7 a4 132 * B1 177 T DE 222
+ 2B 43 * 58 at] 85 133 . Bz 178 i OF 223
2C 44 Y 50 g9 T a5 134 t B3 179 F EO 2249
- 20 45 z 54 a0 ¥ ar 135 i B 180 4 El 225
. 2E 46 [ 5B = {ats] 136 H BS 181 i EZ 226
! 2F 47 ! S 92 Yoo B9 137 1 B& 182 a E3 227
1] a0 45 ] Sh Q3 = fafa 138 ' B7 183 ] E4 228
1 a1 40 “~ | GE Q4 [ aB 139 . Ba 184 | ES 229
2 3z 50 _ BF o5 ] ac 140 q B9 185 c Ea 230
3 33 51 i &0 08 T at 141 H BA 186 c EV 231
4 a4 52 a =11 a7 Z aE 142 » | BB 187 £ Ef 232
5 35 53 b [=r ag z aF 143 L BiZ 188 é EQ 233
o] 36 54 C (=] o0 o0 144 - BD 169 g E&A 234
7 ar 55 d &4 100 : o1 145 ¥ BE 190 & EB 235
g 38 56 e | 65 101 ! o2 146 ¢ BF 191 & BEC | 236
9 39 57 BB 102 a3 147 R C0 192 i ED 237
: jafs 58 g a7 103 94 148 & C1 193 i EE 238
i 3B 50 h [ata] 104 * a5 149 A& _z 194 d | EF 239
= ac &0 I (=)0 105 - 06 150 A _3 195 d | FO 240
= ab 61 i B 106 — 97 151 A _4 196 r F1 241
= 3E 52 k. &EB 107 o5 152 L 5 197 f Fz 242
¥ aF 53 | (=1 108 ™ 00 153 L 6 1958 & F3 243
@ | 40 &4 m | &D 109 : =] 154 . 7 199 & F4 244
a 41 65 n | 6E 110 ¥ oB 155 < s 200 a | F5 245
B 42 66 o | 6F 111 s oz 156 E | C2 201 &  Fo 246
C 43 67 p 70 112 K oD 157 E o 202 + F7 247
D 44 (1] J 71l 113 Z SE 158 E _B 203 F Fa 248
E 45 ) r 72 114 Z oF 159 E _C 204 G Fa 249
F 46 70 5 73 115 a0 160 i D 205 a Fa, 250
3 47 71 k 74 116 - a1 161 i _E 206 0 FE 251
H 45 7z u 75 117 - b 162 o] _F 207 0 FiZ 252
I 40 73 W 7B 118 t a3 163 g (i 208 W FD 253
] 48 | 74 w77 119 = A4 164 H | D1 209 § FE 254
K 46 75 x | 78 120 | & | AS 165 H D2 210 ) FF 255

L 4 Fi=) Y 79 121 i oY= 166 < D3 211
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Turkish (Latin 5) Character Set
Table A-14  Turkish Character Set for the TD 200 and TD 200C

Thar | Hexr Dec | Char Hex Dec [Thar | Hex Dec | Char Hex  Dec | Char | Hex | Dec
20 32 M | 4D 77 z Th 122 g a7 167 & D4 212
! 21 33 M | 4E 78 4 7B 123 " A8 168 & D5 213
! 22 34 0 | 4F 79 | . 124 a9 169 & D& 214
# 23 as P a0 a0 } 7D 125 3 A4 170 @ D7 215
3 24 36 51 = e TE 126 i LB 171 = D 216
% 25 ¥ R 52 g8z 7F 127 - AC 172 U D2 217
2 26 a5 5 o3 83 £ g0 128 - a0 173 ] DA 218
' 27 39 T o4 o4 g1 129 ® | AE 174 ] LB 219
( 28 40 ] 55 85 ) g2 130 T AF 175 U (] 220
] 20 41 W ] 86 F 83 131 @ EO 176 i oD 221
* 28 42 W 57 a7 g4 132 t E1 177 = DE 222
+ 2B 43 % 58 ag8 .. 85 133 B2 178 B DF @ 223
2C 44 ¥ o9 gq 1 {=]a] 134 ! B3 179 3 ED 224
- 20 45 z o8 =11 £ a7 135 B4 180 a E1l 229
. 2E 46 [ ] o1 - tatu] 136 u BS 181 E EZ 226
| 2F 47 ! o 92 Yoo 89 137 1 E& 182 3 E3 227
] a0 45 ] ab 93 5 fafa 136 ' E7 183 a E4 228
1 a1 49 ~ | GE Q4 LS tala] 139 . af] 184 ] ES 229
b 3z 50 _&5F o5 (E B8C 140 1 B2 185 ® | EB 230
3 33 51 ’ (a1 Of =] 141 a EA 186 [ EY 231
4 34 52 a 6l a7 8E 142 » BB 187 e EB 232
5 39 o3 b 62 o8 gF 143 14 | BC 188 2 EQ 233
a] 36 o4 C ()6} Q9 Q0 144 1% | BD 189 £ E& 234
7 a7 55 d & 100 ' o1 145 ¥ BE 190 =] EB 235
g 38 ] e [ae] 101 ! oz 146 é EF 191 i EC 236
9 3@ 57 |66 102 a3 147 & 1 CO 192 i ED 237
: s bl g a7 103 94 148 & 1 193 i EE 238
i 3B 59 h [ala] 104 * a5 149 A& _Z 194 ) EF 239
< ac (a1 I ] 105 - 95 150 A 3 195 i FO 240
= 30 6l i [aT:) 106 | — 97 151 A 4 196 n Fi 241
= 3E 62 k &) 107 " 95 152 A o 197 il Fz 242
v aF ()6} [ & 108 ™ 99 153 E |6 195 a F3 243
@ 40 & m | &D 109 i a4, 154 G 7 199 i F4 244
o, 41 [ae] n &BE 110 :- 9B 155 E 3 200 i F5 245
B 42 [ala] u] &F 111 e | 9C 156 E (e 201 u] F& 246
C 43 67 p 70 112 b 157 E | Ca 202 +~ F7 247
(] 44 [ata] q 71l 113 9E 158 E ] 203 @ F& 248
E 45 ] r 72 114 ¥ 9F 159 I CC 204 U F9 249
F 45 70 s 73 115 A0 160 I o 205 u FA | 250
e 47 71l L 74 116 i Al 161 I _E 206 0 FB 2ol
H 45 72 u 7o 117 i febes 162 I _F 207 ] FC 202
I 49 73 W =] 118 £ A3 163 e Do 208 1 FOr 253
] 44 74 w | 77 119 H Ot 164 M D1 209 3 FE 254
k. 46 75 x 7a 120 ¥ A5 165 S D2 210 W FF 255

L 4C | 7B v 79 121 i AG 166 S D3 21
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Connecting Multiple Devices on a
Network

You can connect multiple TD 200s and S7-200 CPUs together on one communication network.
The TD 200 devices act as network masters and do not interfere with each other. You can

designate the S7-200 CPUs to be either masters or slaves on the network.

In This Chapter

Communicating with Multiple CPUs . .. ... .. e
Determining the Distances, Transmission Rate,and Cable .....................
Using Repeatersonthe Network . ......... ... ... . i,
Selectingthe Network Cable .......... ... ... . i
Biasing and Terminating the Network Cable . .............................
Buildinga TD/CPU Cable . ... ..o e
Making a Cable That Supplies Powertothe TD200 ......................
Making a Cable That Does Not Supply Powertothe TD200 ...............

CPU Grounding and Circuit Reference Point Guidelines for Using Isolated Circuits
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Communicating with Multiple CPUs

90

Figure B-1 shows a typical network with two TD 200s and two S7-200 CPUs. Each TD 200
communicates to one of the CPUs. The addresses of each device are noted below the device in
the figure. In this example:

1 TD 200 Number 1 is configured to communicate to the S7-200 CPU at address 2 (CPU 1)
1 TD 200 Number 2 is configured to communicate to the S7-200 CPU at address 3 (CPU 2)

Tip
You can connect multiple TD 200s to a single S7-200 CPU. You can store separate parameter
blocks for each TD 200 in different V memory locations in the CPU.

If you do not store separate parameter blocks for each TD 200 that is connected to the CPU,
any of these TD 200s can acknowledge the same messages and use function keys to initiate
operations in the CPU.

L 1@ L _
TD200(TD_Y) | OO0 © D CPU 224 (CPU_1)
(i e s e Y A | S .
Address 1 ©
Address 2
— )
TD200(TD2) | OO ¥

1000 L =

Address 4 l CPU 212 (CPU_2)

|(©)]
Address 3
To additional CPUs

Figure B-1 Typical Multiple CPU Network

Tip
The display time slows as more TD 200s are added to the network.

Network connectors are available from Siemens. Using these connectors allows you to isolate the
CPUs from one another (the 24 VDC), but still allows you to power the TD 200 from the CPU. See
the SIMATIC S7-200 Programmable Controller System System Manual for more information about
using network connectors.
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Determining the Distances, Transmission Rate, and Cable

As shown in Table B-1, the maximum length of a network segment is determined by two factors:
isolation (using an RS-485 repeater) and baud rate.

Isolation is required when you connect devices at different ground potentials. Different ground
potentials can exist when grounds are physically separated by a long distance. Even over short
distances, load currents of heavy machinery can cause a difference in ground potential.

Table B-1 Maximum Length for a Network Cable
Baud Rate Non-Isolated CPU Port! CPU Port with Repeater or EM 277
9.6 kbaud to 187.5 kbaud 50 m 1,000 m

T The maximum distance allowed without using an isolator or repeater is 50 m. You measure this distance from
the first node to the last node in the segment.

Using Repeaters on the Network

An RS-485 repeater provides bias and termination for the network segment. You can use a
repeater for the following purposes:

[ Toincrease the length of a network: Adding a repeater to your network allows you to extend
the network another 50 m. If you connect two repeaters with no other nodes in between (as
shown in Figure B-2), you can extend the network to the maximum cable length for the
baud rate. You can use up to 9 repeaters in series on a network, but the total length of the
network must not exceed 9600 m.

1 To add devices to a network: Each segment can have a maximum of 32 devices connected
up to 50 m at 9600 baud. Using a repeater allows you to add another segment (32 devices)
to the network.

1 To electrically isolate different network segments: Isolating the network improves the quality
of the transmission by separating the network segments which might be at different ground
potentials.

A repeater on your network counts as one of the nodes on a segment, even though it is not
assigned a network address.

Segment

Segment Segment

RS-485
] Repeater

RS-485
Repeater

50 m Up to 1000 m 50 m

Figure B-2 ~ Sample Network with Repeaters
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Selecting the Network Cable

S7-200 networks use the RS-485 standard on twisted pair cables. Table B-2 lists the
specifications for the network cable. You can connect up to 32 devices on a network segment.

Table B-2 General Specifications for Network Cable

Specifications Description

Cable type Shielded, twisted pair

Loop resistance <115 Q/km

Effective capacitance 30 pF/m

Nominal impedance Approximately 135 Q to 160 Q (frequency =3 MHz to 20 MHz)
Attenuation 0.9 dB/100 m (frequency=200 kHz)

Cross-sectional core area 0.3 mm2 to 0.5 mm?

Cable diameter 8 mm 0.5 mm

Biasing and Terminating the Network Cable

Siemens provides two types of network connectors that you can use to easily connect multiple
devices to a network: a standard network connector and a connector that includes a programming
port (which allows you to connect a programming station or an HMI device to the network without
disturbing any existing network connections). The programming port connector passes all signals
(including the power pins) from the S7-200 through to the programming port, which is especially
useful for connecting devices that draw power from the S7-200 (such as a TD 200).

Both connectors have two sets of terminal screws to allow you to attach the incoming and
outgoing network cables. Both connectors also have switches to bias and terminate the network
selectively. Figure B-3 shows typical biasing and termination for the cable connectors.

Cable must be terminated Switch position = On Switch position = Off Switch position = On
and biased at both ends. Terminated and biased No termination or bias Terminated and biased

Bare shielding: approximately 12 mm (1/2 in.) must contact the metal guides of all locations.

Switch position = On: Switch position = Off: B
Terminated and biased Pin # No termination or bias TxD/RxD + —— Pin #
? TXDRxD - —A ?
Cable shield —
TXD/RXD + 3 TXD/RXD + B 3
Network A
TXD/RxD - g | connector TXD/RxD - 8
5 5
Cable shield ——— 1 | Cable shield 1]

Figure B-3  Bias and Termination of the Network Cable
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Building a TD/CPU Cable

The TD/CPU cable is used for connecting a display device to an S7-200 CPU. If you do not have
a TD/CPU cable, refer to Figures B-4 and B-5 to create your own cable.

Making a Cable That Supplies Power to the TD 200

Caution

' Connecting the 24 VDC power output (pin 7 of communication port) of multiple S7-200 CPUs

* may cause erratic operation of the I/O, which could potentially cause personal injury and/or
property damage.
The 24 VDC power supply is also the sensor supply for the I/O. Interconnecting the output
power supplies of multiple CPUs could possibly overload the sensor supply, which could cause
the I/O to operate incorrectly.
When networking S7-200 CPUs, connect only the communication lines (pins 3, 5, and 8). You
must not connect the power output (pin 7).

Figure B-4 shows you the pin-out of TD/CPU cable with power supplied to the TD 200. Use this
option when you want the TD 200 to receive power from an S7-200 CPU.

TD 2 i 7-2 i
00 Side Shield S§7-200 Side

1 1
24 VDC Return 2 | @ ® | 2 24 VDC Return

Transmit/Receive Data + 3 | @ ® | 3 Transmit/Receive Data +

4 4

5 5

6 6

24VDC 7| @ ® |7 24VDC

Transmit/Receive Data - 8 | @ ® | 8 Transmit/Receive Data -

9 9

o/ /

Figure B-4  TD/CPU Cable with Power Connections

Making a Cable That Does Not Supply Power to the TD 200

Figure B-5 shows you the pin-out of a TD/CPU cable without power supplied to the TD 200. Use
this option when you want the TD 200 to receive power from an external power supply. The
maximum length for the cable is 1200 meters.

TD 200 Side S§7-200 Side
/E Shield :L

1 1
2 2

Transmit/Receive Data+ 3 | @ ® | 3 Transmit/Receive Data +
4 4
5 5
6 6
7 7

Transmit/Receive Data- 8 | ® ®| 8 Transmit/Receive Data -
9 W, \_ 9

Figure B-5  TD/CPU Cable without Power Connections
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CPU Grounding and Circuit Reference Point Guidelines for
Using Isolated Circuits
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The following items are CPU grounding and circuit guidelines for using isolated circuits:

1 You should identify the reference point (0 voltage reference) for each circuit in the
installation, and the points at which circuits with possibly different references can connect
together. Such connections can result in unwanted current flows that can cause logic errors
or can damage circuits. A common cause of different reference potentials is grounds that
are physically separated by long distances. When devices with widely separated grounds
are connected with a communication or sensor cable, unexpected currents can flow
through the circuit created by the cable and the ground. Even over short distances, load
currents of heavy machinery can cause differences in ground potential or can directly
induce unwanted currents by electromagnetic induction. Power supplies that are improperly
referenced with respect to each other can cause damaging currents to flow between their
associated circuits.

[ When you connect CPUs with different ground potentials to the same PPI network, you
should use an isolated RS-485 repeater.

O S7-200 products include isolation boundaries at certain points to help prevent unwanted
current flows in your installation. When you plan your installation, you should consider
where these isolation boundaries are provided, and where they are not provided. You
should also consider the isolation boundaries in associated power supplies and other
equipment, and where all associated power supplies have their reference points.

O You should choose your ground reference points and use the isolation boundaries provided
to interrupt unneeded circuit loops that could allow unwanted currents to flow. Remember to
consider temporary connections which may introduce a new circuit reference, such as the
connection of a programming device to the CPU.

1 When locating grounds, you must also consider safety grounding requirements and the
proper operation of protective interrupting devices.

1 In mostinstallations, you will have the best noise immunity if you connect the CPU sensor
supply M terminal to ground.

The following descriptions are an introduction to general isolation characteristics of the S7-200
family, but some features may be different on specific products. Consult your product
specifications in the appropriate manual for information about which circuits include isolation
boundaries and the ratings of the boundaries. Isolation boundaries rated less than 1,500 VAC are
designed as functional isolation only, and should not be depended on as safety boundaries.

1 Logic circuit reference is the same as DC sensor supply M.

1 Logic circuit reference is the same as the input power supply M on a CPU with DC power
supply.

CPU communication ports have the same reference as logic circuit.

O o

Analog inputs and outputs are not isolated from logic circuit. Analog inputs are full
differential to provide low voltage common mode rejection.

Logic circuit is isolated from ground to 500 VAC.

DC digital inputs and outputs are isolated from logic circuit to 500 VAC.
DC digital I/O groups are isolated from each other by 500 VAC.

Relay outputs are isolated from logic circuit to 1,500 VAC.

Relay output groups are isolated from each other by 1,500 VAC.

I R Iy I I A

AC power supply line and neutral are isolated from ground, the logic circuit, and all I/O to
1,500 VAC.



Troubleshooting

Refer to Table C-1 for a list of the problems that could occur with the TD 200 or TD 200C and
possible causes and solutions.

Table C-1 Error Messages

Problem

Possible Cause

Possible Solution

NO PARAMETER BLOCK

CPU NOT RESPONDING

HARDWARE ERROR

NETWORK ERROR

TD 200 cannot establish a network
connection or enter an existing
network

CPU BUSY

CPU IN STOP MODE
CHARACTER SET ERROR

Display backlight is on, but no
message is displayed

The TD 200 could not find a parameter
block in the programmable logic
controller.

The TD 200 found a parameter block in
the programmable logic controller, but it
contains errors

Address of the S7-200 CPU is incorrect
S7-200 CPU does not have power
Cable problems

Wrong baud rate configured

Multiple CPUs at the same address
May need network terminations

Network too long or too many devices
on network

TD 200 is inoperable

Multiple masters with the same
address.

Cable problems
Multiple CPUs at the same address

Some other master has locked the
S7-200 CPU by uploading or
downloading a program to that CPU

RUN/STOP switch is in STOP

You selected a character set which is
not supported

Program checksum failure

Configure a parameter block for the TD
200 in the S7-200.

Be sure the parameter block address in
the TD 200 matches the actual address
of the parameter block.

Be sure all fields are within range

Be sure all addresses are valid for the
S7-200 CPU

Correct the address error
Power up the CPU
Check the cable connections

Correct the baud rate configuration
Refer to Appendix B

Remove other CPUs and retry
Refer to Appendix B
Refer to Appendix B

The TD 200 could be defective
Replace with a new module

Remove other masters and retry

Check the cable connections
Remove the other CPUs and retry

Wait — The message disappears in a
few seconds

Put CPU in RUN mode

Use the TD 200 wizard to select a valid
character set

Defective hardware: Replace with a
new TD 200 or TD 200C
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Accessing screens and alarms, Button descriptions,

54
Acknowledging an alarm, 60
Types of alarms, 46, 61
Adhering a custom faceplate, 15, 32
Alarms
Accessing the menus, 57
Acknowledging, 60
Alarm variables, 47, 48
Button descriptions, 54
Configuring, 45-50
Default display mode, 3, 47, 59
Description, 5
Displaying, 60
Displaying alarms, 6
Displaying information, 55
Editing variables, 56, 62
Entering a password, 58
Parameter block, 5 52
Priority, 60
Releasing a password, 58
Types of alarms, 61
Approvals, USA and Canada, for, 75
Arabic character set, 79
ATEX guidelines, 74

Baltic character set, 80
Bar graph character set, 78
Baud rate, 66
Baud rates, network, 91
Biasing, network cable, 92
Button template, 26
Buttons
Accessing screens, alarms, and menus, 57
Default display mode, 59
Descriptions, 54
Displaying information, 55
Editing variables, 56, 62
Keypad Designer
Adding, 23
Button template, 26
Deleting, 24
Erasing, 24
Modifying, 23
Panel image, 27
Properties, 24—26
Reversing the panel image, 28

Cc

Cable

no power to TD 200, 93

to supply power to TD 200, 93
Cable, TD/CPU, creating a pin-out, 93
Cables

biasing, 92

network, 91, 92
terminating, 92
Cabling, 16
CE Symbol, 74
Certificates, Directives, Declarations, 74
Changing the language set, 65

Changing the operating mode of the S7-200 CPU,

68
Changing the time and date, 64
Character Set Error, troubleshooting, 95
Character sets
ALT key combinations, 77
Arabic, 79
Baltic, 80
Bar graph, 78
Chinese, 81
Cyrillic, 82
Greek, 83
Hebrew, 84
Latin 1,85
Latin 2, 86
Turkish (Latin 5), 87
Character sets supported, 3
Chinese character set, 81
Communication, multiple CPUs, 89
Components
Faceplate overlay (TD 200C), 12
Gasket, 12
Label insert (TD 200), 12
Spacers, 12
TD/CPU cable, 12
Configuration
Alarms, 45-50
Types of alarms, 46
Default display mode, 47
multiple CPUs, 89, 90
Multiple language sets, 50-52
Parameter block, 5 52
Screens, 41-45
Alarm variables, 47
Screen text, 43
Screen variables, 43, 48
User menu, 42
subroutines, 52
Task overview, 7-9, 34-36
TD parameters, 36—41
Button functionality, 40
Device, 37
Enabling CPU functions, 38
Keypad configuration file (*.td2), 40
Language set (primary), 39
Password, 39
Update rate, 39

Configuring the properties for the buttons, TD 200C

keypad, 24-26
Connecting the TD device, 16
Contrast of the display area, 66
CPU, multiple CPU communication, 90
CPU address, 66

97



SIMATIC Text Display (TD) User Manual

CPU Busy, troubleshooting, 95
CPU Grounding and Circuit Point Guidelines, 94
CPU not responding, troubleshooting, 95
Creating a TD/CPU cable, 93
Custom cable, 16
Custom faceplate
Dimensions, 15
Installation procedures, 15, 32
Keypad configuration file (*.td2), 21, 28, 40
Panel image, 27
Reversing the panel image, 28
Tasks for creating a custom faceplate, 21
Templates, 17
Customer support, v—vii
Cyrillic character set, 82

D

Date and Time for the TD device, 64
Declaration of Conformity, 74
Default display mode, 5 59
Diagnostic Menu, 65-70
Change Operating Mode, 68
Edit CPU memory, 69-71
Force I/O, 67
Make memory cartridge, 68
Setting up the TD device, 66
View messages, 67
Dimensions
Faceplate (TD 200C), 15
Label insert (TD 200), 14
TD device, 12
Display backlight, troubleshooting, 95
Displaying information, 55

E

Editing the CPU memory, 69-71
Editing variables, 56, 62
EMC Directive, 74
Entering a password, 58
Error messages, Status of the S7-200 CPU, 63
Explosion protection guidelines, 74
Exporting
Button Template, 26
Panel image, 27
External power supply, 16

F

Faceplate
Dimensions (custom faceplate), 15
Installing a custom faceplate, 15, 32
Keypad configuration file (*.td2), 21, 28, 40
Order number, 10
Overlay material, 10 29-32
Panel image, 27
Reversing the panel image, 28
Standard TD keypad, 5 54
Tasks for creating a custom faceplate, 21
Template file (A4), 9. 20
Templates, 17

Features, 3
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Comparing TD devices, 4
Order number
Faceplate overlay material, 10, 72
TD 200, 72
TD 200C, 72
Floating-point numbers, 62
FM Approval, 75
Forcing I/O, 67

G

Gap factor, 66
Gasket, 12, 13
Graphics application
Button template, 26
Panel image, 27
Greek character set, 83
Guidelines
CPU grounding and circuit reference point, 94
setup, 74

H

Hardware
Order number
Faceplate overlay material, 10, 72
TD 200, 72
TD 200C, 72
Setting up the TD device, 66
Specification, 72
Task overview, 7-9
Hardware Error, troubleshooting, 95
Hebrew character set, 84
Hierarchy of menus, 57
Highest station, 66
Hotline support, v

Importing, Panel image, 27
Installation
Components, 12
Connecting a TD 200C, 17
Custom cable, 16
Dimensions
Custom faceplate, 15
Label insert, 14
TD device, 12
Installing a custom faceplate, 15, 32
Mounting a TD device, 12—-14
Order number
Faceplate overlay material, 10, 72
TD 200, 72
TD 200C, 72
Power (TD/CPU cable), 16
Power supply, 16
Procedures and guidelines, 11-19
Spacers, 13
Task overview, 7-9
TD/CPU cable, 16
International characters, 77
Internet, v
Isolated circuits, guidelines, 94
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Isolation
characteristics of S7-200 , 94
network, 91

K

Keypad
Creating a custom keypad, 9 20
Order number for faceplate overlay material, 10
Panel image, 27
Reversing the panel image, 28
Standard TD, 5 54
Keypad configuration file (*.td2), 21, 22, 28, 40
Keypad Designer
Buttons
Adding, 23
Button template, 26
Deleting, 24
Erasing, 24
Modifying, 23—25
Moving, 23
Panel image, 27
Properties, 24—26
Reversing the panel image, 28
Configuration file (TD 200 wizard), 40
Dimensions (custom faceplate), 15
Faceplate template file, 9. 20
File types, 22
Installing a custom faceplate, 15, 32
Keypad configuration file (*.td2), 21, 28, 40
Options, 22
Order number for faceplate material, 10
Overview, 3, 20
Printer requirements, 10
Saving, 28
Starting the application, 22
Tasks for creating a custom faceplate, 21
TD 200 wizard, 34-36
Templates, 17
Tools (options), 22
Keys
Accessing screens, alarms, and menus, 57
Button descriptions, 54
Button template, 26
Displaying information, 55
Editing variables, 56, 62
Keypad Designer
Adding buttons, 23
Deleting buttons, 24
Erasing buttons, 24
Modifying buttons, 23
Properties, 24—26
Panel image, 27
Reversing the panel image, 28

L

Label insert (TD 200)
Dimensions, 14
Modifying, 14

Language set
Multiple, 50-52
Primary, 39

Switching langauges, 65
Laser printer requirements, 10
Latin 1 character set, 85
Latin 2 character set, 86

Making, cable to supply power to TD 200, 93
Making a cable, no power to TD 200, 93
Memory cartridge, 68
Menus
Accessing the menus, 57
Default display mode, 59
Diagnostic Menu, 65-70
Display Alarms, 60
Displaying information, 55
Editing variables, 56, 62
Hierarchy, 57
Operator Menu, 63—66
Messages
Accessing screens, alarms, and menus, 57
Displaying information, 55
Editing variables, 56, 62
Mounting a TD device, 12—-14
Spacers, 13
Multiple language sets, 50-52

N

Network
baud rate, 91
biasing cable, 92
cable, 91, 92
calculating distances, 91
isolation, 91
repeaters, 91
terminating cable, 92
transmission rate, 91
typical multiple CPU , 90
Network address, 66
Network Connectors, 90
Network Error, troubleshooting, 95
No Parameter Block, troubleshooting, 95

o)

Operation

Accessing screens, alarms, and menus, 57

Changing the language set, 65

Changing the operating mode of the S7-200

CPU, 68

Displaying information, 55

Editing the CPU memory, 69-71

Editing variables, 56, 62

Forcing I/O, 67

Making a memory cartridge, 68

Reviewing the configured messages, 67

Setting the time and date, 64

Setting up the TD device, 66

Types of alarms, 61

Viewing the status of the S7-200 CPU, 63
Operations

Button descriptions, 54
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Overview (screens and alarms), 6
Operator Menu, 63—66
Changing the language set, 65
Setting the Time and Date, 64
View Status of the S7-200 CPU
error messages, 63
Firmware version, 63
Order number
Faceplate overlay material, 10, 72
TD 200, 72
TD 200C, 72
Overlay, Reversing the panel image, 28
Overlay material, 10. 29-32
Order number, 10

P

Panel image, 27
Reversing for print, 28

Parameter block, 5, 7
Configuring the address in the TD device, 66
V memory address, 52

Password
Entering, 58
Releasing, 58

Pin-out, TD/CPU cable, 93

Power supply, 16

Primary language set, 39

Printer requirements, 10

Printing a custom faceplate, Creating a custom
faceplate, 21

Printing multiple faceplates, 10 29-32
Template file, 9, 20

Printing the faceplate, Reversing the panel image,

28
Priority of alarms, 60
Product overview, 1-10
Backwards compatible, 11
Character sets, 3
Comparison TD devices, 4
Components, 12
Creating a custom keypad, 9 20
Description, 2
Features, 3
Order number
Faceplate overlay material, 10, 72
TD 200, 72
TD 200C, 72
Printer requirements, 10
Standard TD keypads, 5, 54
Task overview, 7
PROFIBUS-DP network
cable specifications, 91
repeaters, 91
Properties of buttons (TD 200C), 24—26

R

Real numbers, 62

Releasing a password, 58

Repeaters, network, 91

Reversing the panel image, 28
Reviewing the configured messages, 67
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RS-485 standard, 92

S

S7-200, general isolation characteristics, 94
S7-200 CPU
Changing the operating mode, 68
Editing the CPU memory, 69-71
Error messages, 63
Firmware version, 63
Making a memory cartridge, 68
Model number, 63
Parameter block, 5
Supplying power to the TD device, 16
Screens
Accessing the menus, 57
Button descriptions, 54
Configuring, 41-45
Default display mode, 3, 47, 59
Displaying information, 55
Displaying screens, 6
Editing variables, 56, 62
Entering a password, 58
Overview, 5
Parameter block, 5 52
Releasing a password, 58
Screen variables, 43
Text message, 43
User menu, 42
Setting the time and date for the TD device, 64
Setup Guidelines, 74
Spacers, 13
Special characters, 77
Specifications, 72-74
Standard TD keypad, 17
Standard TD keypads, 5, 54
STEP 7-Micro/WIN
Keypad configuration file (*.td2), 21, 28, 40
Keypad Designer, 2
Starting the Keypad Designer, 22
Subroutines, 52
Task overview, 7-9
TD 200 wizard, 2
Alarm variables, 47, 48
Alarms, 45-50
Default display mode, 47
Parameter block, 52
Screen text, 43
Screen variables, 43
Screens, 41-45
User menu, 42
Supplying power to the TD device, 16
Support, v—vii
Switching the language set, 65

T

TD 200
Accessing screens, alarms, and menus, 57
Alarms, 5
Backwards compatible, 11
Changing the language set, 65
Character sets, 3
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Description, 2 Changing the operating mode of the S7-200
Dimensions CPU, 68

Label insert, 14 Character sets, 3

TD 200, 12 Comparing TD devices, 4
Displaying alarms, 6 Components, 12
Displaying information, 55 Configuration tasks, 34—-36
Displaying screens, 6 Contrast of the display, 66
Editing variables, 56, 62 Creating a custom keypad, 9 20
Entering a password, 58 Default display mode, 59
Features, 3, 4 Description, 2
Forcing I/O, 67 Dimensions, TD 200C, 12
Installation procedures, 11-19 Displaying alarms, 6
Modifying the label insert, 14 Displaying information, 55
Mounting instructions, 12—14 Displaying screens, 6
Multiple language sets, 50-52 Editing the CPU memory, 69-71
Order number, TD 200, 72 Editing variables, 56, 62
Parameter block, 5 Entering a password, 58
Product overview, 1-10 Establishing a connection, 17
Releasing a password, 58 Features, 3, 4
Reviewing the configured messages, 67 Forcing I/O, 67

Screens, 5 Installation procedures, 11-19

Set time and date, 64 Installing a custom faceplate, 15, 32
Setup, 66 Keypad configuration file (*.td2), 21, 28, 40
Spacers, 13 Making a memory cartridge, 68

Specification, 72-74
Standard TD keypad, 5 54
Supplying power, 16

Task overview, 7-9

Mounting instructions, 12—14
Multiple Language sets, 50-52

Order number

Faceplate overlay material, 10, 72

TD 200C, 72
Parameter block, 5
Printer requirements, 10
Product overview, 1-10
Releasing a password, 58
Reviewing the configured messages, 67
Screens, 5
Set time and date, 64

TD parameters, 36—41
Button functionality, 40
Device, 37
Enabling CPU functions, 38
Keypad configuration file (*.td2), 40
Language set (primary), 39
Password, 39
Update rate, 39

TD/CPU cable, 16 Setup, 66
Types of alarms, 46, 61 Spacers, 13
TD 200 wizard Specifications, 72

Alarm variables, 47, 48

Alarms, 45-50

Default display mode, 47

Multiple language sets, 50-52

Parameter block, 52

Screen text, 43

Screen variables, 43

Screens, 41-45

subroutines, 52

Task overview, 34—36

TD parameters, 36—41
Button functionality, 40
Device, 37
Enabling CPU functions, 38
Keypad configuration file (*.td2), 40
Language set (primary), 39
Password, 39
Update rate, 39

User menu, 42

Standard configuration, 17

Standard TD faceplate, 17

Standard TD keypad, 5 54

Supplying power, 16

Task overview, 7-9

Tasks for creating a custom faceplate, 21

TD parameters, 36—41
Button functionality, 40
Device, 37
Enabling CPU functions, 38
Keypad configuration file (*.td2), 40
Language set (primary), 39
Password, 39
Update rate, 39

TD/CPU cable, 16

Templates, 17

Types of alarms, 46, 61

TD/CPU cable, 12, 16
creating a pin-out, 93
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Technical support, v—vii

Template for printing multiple faceplates, 3, 20
Printer requirements, 10

Templates, Standard TD keypad, 17

Terminating, network cable, 92

Time and Date for the TD device, 64

Transmission rate, network, 91

Troubleshooting, TD 200, 95

Turkish (Latin 5) character set, 87

Types of alarms, 46, 61

U
Unforcing 1/O, 67

Vv

V memory address for the parameter block, 52
Variables, Editing values, 56, 62
View status of the S7-200 CPU
Error messages, 63
Firmware version, 63
Viewing the configured messages, 67
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Wizard
Configuring the alarm variables, 47, 48
Configuring the alarms, 45-50
Configuring the screen text, 43
Configuring the screen variables, 43
Configuring the screens, 41-45
Configuring the user menu, 42
Default display mode, 47
Parameter block, 52
Wizard (TD 200 configuration)
Multiple language sets, 50-52
Task overview, 34-36
TD parameters, 36—41
Button functionality, 40
Device, 37
Enabling CPU functions, 38
Keypad configuration file (*.td2), 40
Language set (primary), 39
Password, 39
Update rate, 39
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Your comments and recommendations will help us to improve the quality and usefulness of our
publications. Please take the first available opportunity to fill out this questionnaire and return it
to Siemens.

Please give each of the following questions your own personal mark within a range from 1 (very
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Do the contents meet your requirements?

Is the information you need easy to find?

Is the text easy to understand?

Does the level of technical detail meet your requirements?
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